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Περίληψη 

 
Καθώς οι ορυκτοί πόροι του πλανήτη μας εξαντλούνται αλλά και έχουν σημαντικές επιπτώσεις 
στο περιβάλλον και την υγεία των έμβιων οργανισμών που το κατοικούν, ο άνθρωπος στρέφεται 
στις ανανεώσιμες πηγές ενέργειας. Η υδροηλεκτρική ενέργεια τόσο λόγω της υψηλής 
δυνατότητας ελέγχου και αξιοποίηση της αλλά και της σχέσης της με τον άνθρωπο από την 
αρχαιότητα αποτελεί κατά συντριπτική πλειοψηφία την μεγαλύτερη πηγή ανανεώσιμης 
ενέργειας σήμερα. Παρά τα θετικά τους χαρακτηριστικά, οι ανανεώσιμες πηγές ενέργειας δεν 
παύουν να έχουν και αρνητικές επιπτώσεις στο περιβάλλον τις οποίες επιθυμούμε να 
περιορίσουμε. Ένα από τα κύρια αρνητικά της υδροηλεκτρικής ενέργειας είναι ο τραυματισμός 
της ιχθυοπανίδας. Στην παρούσα εργασία έγινε κατ’ αρχάς μια βιβλιογραφική αναζήτηση και 
καταγραφή των διαφόρων μηχανισμών τραυματισμού των ψαριών, μηχανικής και υδραυλικής 
φύσης. Ακόμα αναφέρονται οι πιθανοί τρόποι μείωσης των τραυματισμών και της 
θνησιμότητας, μέσω αλλαγών στης λειτουργία, στην εγκατάσταση και στον σχεδιασμό των 
υδροδυναμικών μηχανών. Στη συνέχεια, μελετήθηκαν οι τροχιές που ακολουθούν διάφορα 
μοντέλα ψαριού στο πεδίο ροής ενός δισδιάστατου υδροστροβίλου Francis. Η μοντελοποίηση 
πραγματοποιήθηκε στο εμπορικό πακέτο υπολογιστικής ρευστοδυναμικής Ansys Fluent 
χρησιμοποιώντας τα εργαλεία χίμαιρας (chimera ή overset) και αναδημιουργίας πλέγματος 
(remeshing). Μελετήθηκε η πορεία μοντέλων ψαριών διαφόρων σχημάτων και βαρών, και 
καταγράφηκαν κατά μήκος των τροχιών η ταχύτητα, ο προσανατολισμός και η γωνιακή τους 
ταχύτητα. Διαπιστώθηκε ότι η μέθοδος χίμαιρας (overset) δίνει αποτελέσματα ικανοποιητικής 
ακρίβειας σε σύγκριση με την αρκετά ακριβότερη υπολογιστικά μέθοδο αναδημιουργίας 
πλέγματος (remeshing). Ακόμα, αντιμετωπίστηκαν προβλήματα ευστάθειας και στις δύο 
μεθόδους όταν χρησιμοποιούνταν αντικείμενα μεγάλου, σχετικά, μήκους. Τα προβλήματα 
επιλύονταν με την αύξηση της μάζας των αντικειμένων. Η εφαρμογή όλης της μεθοδολογίας 
μοντελοποίησης που αναπτύχθηκε, περιγράφεται με λεπτομέρειες στο Παράρτημα της 
διπλωματικής εργασίας. 
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Abstract 
 
 
While our planet’s Earth conventional energy sources are depleting, the continuous and ever-
growing exploitation of them is proved to have negative consequences both to the environment 
and the health of living beings inhabiting it. Facing this situation, mankind is now switching to 
renewable energy sources. Hydropower has been used by man since antiquity taking advantage 
of its great flexibility as an energy source, thus remaining until today the major renewable 
energy source. Despite their environmental superiority, renewable energy resources still have an 
environmental impact with hydropower being no exception. One of biggest concerns about 
hydropower is its interaction with the fish fauna, that can be heavily impacted concerning the 
extreme hydraulic environment and spinning mechanical parts that has to pass through. Firstly, 
in the present dissertation, an extensive literature review was conducted regarding the injury 
mechanisms of mechanical and hydraulic nature. Furthermore, modifications in operation, 
installation and design of hydrodynamic machinery resulting in lower injury and mortality rates 
were presented. In addition, the trajectories of various fish models in a two-dimensional flow 
field of a Francis turbine were studied. For this purpose, the commercial computational fluid 
dynamics code Ansys Fluent was selected, using the tools overset and remeshing. Along with the 
trajectory of various shapes and weights; velocity, implicit angular velocity and orientation of 
the objects were also recorded in each time step. It was determined, that the overset technique 
can give satisfactory results, in terms of precision, in comparison with the more expensive, 
computationally, remeshing technique. Moreover, stability problems emerged with both 
techniques, when objects of large, comparatively, length were used. Those problems were 
overcome by raising the objects’ mass. The details of the applies methodology are thoroughly 
presented in the Appendix of the present dissertation.  
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1 Βιβλιογραφική επισκόπηση 
1.1 Γενικά για τους υδροστροβίλους Francis 

 
Αντιπροσωπεύοντας το 60% της παγκόσμιας υδροδυναμικής ενέργειας, ο υδροστρόβιλος Francis είναι 
αδιαμφησβήτητα το πιο διαδεδομένο είδος υδροστροβίλου. Πρόκειται για έναν υδροστρόβιλο 
αντιδράσεως, ποσοστό δηλαδή της συνολικής πτώσης στατικής πίεσης πραγματοποιείται στην πτερωτή 
(δρομέας) όπως ορίζεται από το βαθμό αντιδράσεως (Παπαντώνης, 2016): 

𝑟𝑟𝑒𝑒 = 𝑝𝑝2−𝑝𝑝1
𝑝𝑝𝑎𝑎−𝑝𝑝1

        (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 1.1) 

Ο υδροστρόβιλος Francis μπορεί να είναι ακτινικής ή μεικτής ροής. Όπως φαίνεται και στο Σχήμα 1.1  
είναι κατάλληλος για αξιοποίηση από μικρών έως μεγάλων υδραυλικών πτώσεων (Η=5-800 𝑚𝑚 περίπου) 
με το εύρος της παροχής λειτουργίας να μειώνεται στις μεγαλύτερες υδραυλικές πτώσεις. 

 

Σχήμα 1.1: Διάγραμμα περιοχής λειτουργίας διαφόρων τύπων υδροστροβίλων (ge.com, 2016) 
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Ενδεικτικό του διαδεδομένου εύρους εφαρμογής, της τεχνικής και οικονομικής σημασίας των 
υδροστροβίλων Francis είναι ο επόμενος κατάλογος των τριών μεγαλύτερων υδροηλεκτρικών 
εργοστασίων (ΥΗΕ) μαζί με λεπτομέρειες για τους υδροστροβίλους που τα εξοπλίζουν. 

 Three Gorges Dam (Κίνα): 32 υδροστρόβιλοι Francis καθένας ονομαστικής ισχύος 700 MW. 
(wikipedia.org, 2020) 

 Itaipu Dam (Βραζιλία και Παραγουάη): 20 υδροστρόβιλοι Francis καθένας ονομαστικής ισχύος 
700 MW. (wikipedia.org, 2020) 

 Xiluodu Dam (Κίνα): 18 υδροστρόβιλοι Francis καθένας ονομαστικής ισχύος 770 MW. 
(wikipedia.org, 2020) 

Ο μεγαλύτερος σε ισχύ κατασκευασμένος και εν λειτουργία υδροστρόβιλος αυτή τη στιγμή είναι επίσης 
τύπου Francis και βρίσκεται στο ΥΗΕ Grand Coulee (ΗΠΑ). Συγκεκριμένα υπάρχουν 3 μονάδες 
ονομαστικής ισχύος 805 MW η κάθε μία. (wikipedia.org, 2020) 
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1.2 Σχεδιασμός και λειτουργία 
 
Από κατασκευαστικής πλευράς, μπορεί να γίνει διάκριση σε υδροστροβίλους οριζοντίου και 
κατακόρυφου άξονα. Η πλειοψηφία των υδροστροβίλων Francis είναι διάταξης κάθετου άξονα (μερικοί 
μικρότεροι έχουν διάταξη οριζόντιου άξονα). Στο Σχήμα 1.2 απεικονίζεται ένας υδροστρόβιλος Francis 
κάθετου άξονα σε τομή· διαθέτει δρομέα διαμέτρου 5 m, υδραυλική πτώση 110 𝑚𝑚 και ονομαστική 
ισχύς 200 𝑀𝑀𝑊𝑊.  

 

Σχήμα 1.2: Υδροστρόβιλος Francis κάθετου άξονα, δρομέας 5 m, Η=110 m, P=200 MW (machineryequipmentonline.com, 2015) 

 
Τμήμα εισόδου: Το νερό εισέρχεται μέσω ενός σπειροειδούς κελύφους (volute/casing) που περιβάλει 
το δρομέα. Το εμβαδόν της επιφάνειας της μεσημβρινής τομής ελαττώνεται και τα μήκος του πεδίου 
ροής (Σχήμα 1.2) ώστε η ταχύτητα να παραμένει σταθερή. Λόγω της διέλευσης μέσα από την έλικα το 
νερό αποκτά και μία αρχική τιμή συστροφής, δηλαδή περιφερειακή συνιστώσα της ταχύτητας του. 

Από το σπειροειδές κέλυφος το νερό εισέρχεται σε μία κυκλική διάταξη στατικών οδηγητικών 
πτερυγίων, όπως φαίνεται στο Σχήμα 1.3. Τα στατικά οδηγητικά πτερύγια συμβάλουν στην ενίσχυση 
της μηχανικής αντοχής και της στιβαρότητας του σπειροειδούς κελύφους ενώ παράλληλα εξυπηρετούν 
τη μείωση των διαστάσεων του σπειροειδούς κελύφους. Αυτό επιφέρει σχεδιασμό με μεγαλύτερη 
γωνία σπείρας που προσδίδει στο νερό μεγαλύτερη συστροφή. Η επιπλέον τιμή της συστροφής 
αφαιρείται από τη στεφάνη των οδηγητικών πτερυγίων. 

Η τελική της τιμή της περιστροφής διαμορφώνεται μετά το πέρασμα από τη στεφάνη των ρυθμιστικών 
πτερυγίων, όπως βλέπουμε στο Σχήμα 1.3. Τα πτερύγια αυτά βρίσκονται μετά τα στατικά και πριν το 
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δρομέα, η ροή σε αυτά είναι καθαρά ακτινική, ενώ υπάρχει και δυνατότητα ταυτόχρονης και 
ομοιόμορφης περιστροφής μέσω εξωτερικού μηχανισμού. Με την περιστροφή των ρυθμιστικών 
πτερυγίων εκτός από μεταβολής της κλίσης της ταχύτητας επιτυγχάνεται και η μεταβολή του διακένου, 
άρα της διατομής μεταξύ δύο διαδοχικών πτερυγίων, με αποτέλεσμα τη μεταβολή της παροχής και άρα 
της ισχύος εξόδου, για σταθερές στροφές και υδραυλική πτώση. Το πλήθος των ρυθμιστικών πτερυγίων 
𝑧𝑧𝑑𝑑 είναι πάντοτε ζυγός αριθμός, πολλαπλάσιο του 2 ή του 4 και δίνεται προσεγγιστικά από την 
ακόλουθη σχέση: 

𝑧𝑧𝑑𝑑 ≈ 17 ∙ 𝑅𝑅𝑑𝑑
1
3         (σχέση 1.2) 

Με: 𝑅𝑅𝑑𝑑 = 𝐴𝐴𝑑𝑑
2

 , όπου 𝛢𝛢𝑑𝑑 η τιμή του διακένου μεταξύ δύο διαδοχικών ρυθμιστικών πτερυγίων όπως αυτή 
μετράτε με τη χρήση δισκοειδών καλιμπρών. (Παπαντώνης, 2016) 
 

 

Σχήμα 1.3: Τμήμα εισόδου υδροστρόβιλου Francis με 14 στατικά και 28 ρυθμιστικά πτερύγια. (Bergan, et al., 2014) 

Δρομέας: Το σύνολο της διάταξης σπειροειδές κέλυφος, στατικά οδηγητικά πτερύγια και ρυθμιστικά 
πτερύγια εξασφαλίζουν κατά το δυνατόν ομοιόμορφες συνθήκες ροής και ομοιόμορφη τροφοδοσία 
του δρομέα. Ο περιστρεφόμενος δρομέας αποτελεί το τμήμα του υδροστροβίλου που μετατρέπει την 
ενέργεια του υγρού σε μηχανική ενέργεια, συγκεκριμένα μηχανική κινητήρια ροπή. Όπως φαίνεται στο 
Σχήμα 1.4, στους υδροστροβίλους Francis τα πτερύγια του δρομέα εκτείνονται μεταξύ της πλήμνης και 
της στεφάνης στην οποία είναι πακτωμένα. Ο ρόλος του δίσκου της στεφάνης είναι η αύξηση της 
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μηχανικής στιβαρότητας του δρομέα και ιδιαίτερα των πτερυγίων στα όποια αναπτύσσονται τόσο 
δυνάμεις από τη διερχόμενη ροή όσο και φυγοκεντρικές δυνάμεις λόγω της περιστροφής (75-1000 
rpm). Όσο μεγαλύτερη είναι η διαθέσιμη υδραυλική πτώση 𝐻𝐻 τόσο μεγαλύτερες είναι και οι 
αναπτυσσόμενες δυνάμεις.  
Το πλήθος τον πτερυγίων του δρομέα 𝑧𝑧𝑏𝑏 συνήθως επιλέγεται περιττό ώστε να αποφεύγεται ο κίνδυνος 
ταλαντώσεων και συντονισμού λόγω του άρτιου πλήθους των ρυθμιστικών πτερυγίων. Ο αριθμός των 
πτερυγίων κυμαίνεται από 9 έως 25. Η προτίμηση των κατασκευαστών είναι 𝑧𝑧𝑏𝑏 = 11,13,15 με πιο 
σύνηθες 𝑧𝑧𝑏𝑏 = 13. Με σταθερό το πλήθος των πτερυγίων του δρομέα Francis, όσο μειώνεται η 
διαθέσιμη υδραυλική πτώση 𝐻𝐻 ο δρομέας από καθαρά ακτινικής ροής γίνεται σταδιακά όλο και 
περισσότερο μεικτής ροής. Ακόμα, το μεσημβρινό μήκος των πτερυγίων μειώνεται καθώς επαρκούν 
όλο και μικρότερες φέρουσες επιφάνειες για την ενεργειακή μετατροπή. (Παπαντώνης, 2016) 

 

Σχήμα 1.4: Δρομέας υδροστροβίλου Francis με 14 πτερύγια (globalsources.com, 2020) 

Τμήμα εξόδου: Η όποια κινητική ενέργεια �𝑐𝑐𝑎𝑎
2�

2𝑔𝑔
 στη διατομή εξόδου είναι ενέργεια που διαφεύγει 

αναξιοποίητη και επομένως θεωρείται ως απώλεια. Όμως η μέση ταχύτητα της ροής στην περιοχή της 
διατομής εξόδου του δρομέα είναι 6-10 m/sec (ώστε να μειώνεται το μέγεθος της μηχανής) και 
αντιπροσωπεύει σημαντικό ποσοστό της διαθέσιμης ενέργειας, ειδικότερα για μικρές τιμές διαθέσιμης 
υδραυλικής πτώσης 𝐻𝐻. Για το λόγο αυτό, σκοπός του αγωγού απαγωγής είναι η οδήγηση του υγρού 
στη διώρυγα απαγωγής ή στον κάτω ταμιευτήρα με παράλληλη επιβράδυνση του σε ταχύτητες εξόδου 
𝑐𝑐𝑎𝑎 = 1 − 2.5 𝑚𝑚

𝑠𝑠𝑠𝑠𝑠𝑠
. Ο αγωγός απαγωγής έχει ευθύγραμμο κωνικό αποκλίνον τμήμα, γωνίας κώνου όχι 

μεγαλύτερης των 7ο περίπου ώστε να μην έχουμε αποκόλληση της ροής. Στους υδροστροβίλους 
κατακόρυφου άξονα ο αγωγός απαγωγής καμπυλώνεται στη συνέχεια κατά 90ο έτσι ώστε η διατομή 
εξόδου να είναι οριζόντια, όπως φαίνεται στο Σχήμα 1.5. Η διατομή του αγωγού απαγωγής γίνεται 
σταδιακά πεπλατυσμένη και σχεδόν ορθογωνική (επιβράδυνση της ροής) με σκοπό τη μείωση τόσο του 
μήκους του όσο και της ανάγκης για περεταίρω εκσκαφές. Στους υδροστροβίλους οριζόντιου άξονα ο 
αγωγός απαγωγής επίσης καμπυλώνεται 90ο μέχρι την ελεύθερη επιφάνεια της διώρυγας απαγωγής ή 
του κάτω ταμιευτήρα.  
Ο βαθμός απόδοσης καθώς και η συνολική λειτουργία του υδροστροβίλου συνδέονται άμεσα με τον 
αγωγό απαγωγής. Συνεπώς, ως διατομή εξόδου της μονάδας του υδροστροβίλου θεωρείται η διατομή 
εξόδου του αγωγού απαγωγής ο οποίος σχεδιάζεται και κατασκευάζεται από τον κατασκευαστή του 
υδροστροβίλου. (Παπαντώνης, 2016) 
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Σχήμα 1.5: Υδροηλεκτρικός σταθμός σε τομή (Foroutan, 2008) 
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1.3 Υδροστρόβιλοι Francis και ιχθυοπανίδα 
 
Οι υδροστρόβιλοι Francis αποτελούν το πιο διαδεδομένο είδος υδροστροβίλου στον κόσμο όταν 
αναφερόμαστε σε ισχύ μεγαλύτερη των 50ΜW. Ο συγκεκριμένος τύπος έχει τo μεγαλύτερο ποσοστιαίο 
μερίδιο σε κάθε ήπειρο, ακολουθούμενος από τους υδροστροβίλους Pelton. Τα ακριβή ποσοστά για 
κάθε ήπειρο φαίνονται στο Σχήμα 1.6. Ταυτόχρονα το 2015 η  υδροηλεκτρική ενέργεια κάλυψε τις 
ενεργειακές ανάγκες του πλανήτη σε ποσοστό 16.6% ενώ αποτέλεσε το 71% της συνολικής ενέργειας 
προερχόμενη από ανανεώσιμες πηγές. (nationalgeographic.org, 2016) 
 

 

Σχήμα 1.6: Κατανομή τύπων υδροστροβίλων ανά ήπειρο (2009) (Water Power & Dam Construction, 2009) 

Η υιοθέτηση εναλλακτικών πηγών ενέργειας αποτελεί μονόδρομο μπροστά στην αναπόφευκτη 
εξάντληση των ορυκτών πόρων, ενώ η συνεχής άνοδος της στάθμης των θαλασσών δημιουργεί 
επιπλέον ζήτηση υδροδυναμικών μηχανών. 
Όμως η υδροηλεκτρική ενέργεια, παρότι μια ανανεώσιμη πηγή ενέργειας, μπορεί να έχει και αρνητικό 
περιβαλλοντικό αντίκτυπο. Ο αντίκτυπος αυτός διογκώνεται αν αναλογιστούμε την εκτενή 
χρησιμοποίηση τους, η οποία προβλέπεται να διευρυνθεί.  
Η υδροηλεκτρική ενέργεια αποτελεί απειλή για μετακινούμενους πληθυσμούς ψαριών, αφού ψάρια 
που κινούνται κατάντη της ροής ποταμών μπορούν να τραυματιστούν ή και να θανατωθούν όταν 
διέρχονται από το εσωτερικό υδροδυναμικών μηχανών λόγο δυσμενών υδραυλικών συνθηκών αλλά 
και κινούμενων μηχανικών μερών. Είναι μείζονος σημασίας η κατανόηση των υδραυλικών συνθηκών, 
φυσικών εμποδίων και σωματικών πιέσεων στις οποίες υπόκεινται τα ψάρια κατά τη διέλευση τους 
μέσω υδροδυναμικών μηχανών με σκοπό την κατασκευή φιλικών προς τα ψάρια (fish-friendly) 
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μηχανών που θα μετριάζουν την επίδραση τους στην ιχθυοπανίδα. 
Σήμερα, υδροηλεκτρικοί σταθμοί υψηλών περιβαλλοντικών προδιαγραφών προϋποθέτουν την 
ελάχιστη επίδραση σε πληθυσμούς ψαριών τόσο κατά την ανάντι όσο και κατά την κατάντι 
μετανάστευση τους. Σε σχέση με τις αντλίες, η επίδραση των υδροστροβίλων στα ψάρια έχει μελετηθεί 
σε μεγαλύτερο βαθμό με μελέτες σε μεγάλους υδροηλεκτρικούς σταθμούς να ξεκινάνε από τη 
δεκαετία του 1960. 

Αναφορικά με τους υδροστροβίλους Francis ο φορέας Eicher Associates το 1987 επιθεώρησε 22 
προηγούμενες μελέτες και βρήκε το ποσοστό θνησιμότητας να κυμαίνεται από 5% έως και 50% για 
λογαριασμό του Electric Power Research Institute (EPRI) των ΗΠΑ (Eicher Associates, 1987). Στην ίδια 
μελέτη το EPRI ανακάλυψε πως η είσοδος του δρομέα (αλληλεπίδραση ρυθμιστικών πτερυγίων, 
πτερυγίων δρομέα και ταχύτητας περιστροφής), υψηλές περιφερειακές ταχύτητες δρομέα και 
μεγαλύτερες θέσεις ανοίγματος των ρυθμιστικών πτερυγίων οδηγούν σε μεγαλύτερα ποσοστά 
θνησιμότητας. Ταυτόχρονα παρατηρήθηκε πως η θνησιμότητα παρέμενε ανεπηρέαστη με την αλλαγή 
της διαθέσιμη υδραυλικής πτώσης (παρόμοια θνησιμότητα για 12 m έως 125 m). Αυτό ήρθε σε 
αντίθεση με την μέχρι τότε πεποίθηση πως η υδραυλική πτώση ήταν μια σημαντική παράμετρος 
θνησιμότητας της ιχθυοπανίδας.  

Σε μια ακόμη έρευνα το 1992, το EPRI χρησιμοποίησε δεδομένα τόσο από ψάρια γλυκού νερού όσο και 
από αναδρομικά είδη ψαριών (πρόκειται για ψάρια που ζούνε στο αλμυρό νερό αλλά αναπαράγονται 
και γεννιούνται στα γλυκά νερά) από όλες τις ΗΠΑ (Electric Power Research Institute , 1992). Τα 
ευρήματα της έρευνας έδειξαν 20% ποσοστό θνησιμότητας για τους υδροστροβίλους Francis, ποσοστό 
αρκετά μεγαλύτερο σε σχέση με Kaplan (12%) και υδροστροβίλους Bulb (9%). Αρκετές έρευνες 
υποστήριζαν πως το ποσοστό θνησιμότητας για φυσικά εισερχόμενα ψάρια ήταν στην πραγματικότητα 
πολύ χαμηλότερο, κοντά στο 6% τόσο για Francis όσο και για Kaplan υδροστροβίλους. Στην ίδια έρευνα 
συμπεριλήφθηκαν δεδομένα  που παρουσίαζαν τους υδροστροβίλους Francis με σταθερά μεγαλύτερο 
ποσοστό θνησιμότητας σε σχέση με τους Kaplan. Οι μελετητές του EPRI απέδωσαν τη διαφορά στο 
ποσοστό θνησιμότητας μεταξύ των δημοσιεύσεων κυρίως σε δύο παράγοντες: 

• σε πολλές περιπτώσεις τα τεχνητά εισαγόμενα ψάρια (test fish) ήταν πολύ μεγαλύτερα από τα 
φυσικά εισαγόμενα και όχι κατάλληλα εγκλιματισμένα 

• οι νεότερες έρευνες (από το 1987 και έπειτα) μπορούσαν να ορίσουν καλύτερα τις 
πειραματικές παραμέτρους και χρησιμοποιούσαν βελτιωμένες τεχνικές αξιολόγησης. 

Η Voith Hydro διενέργησε το 1997 τη δική της μελέτη με σκοπό τη βελτίωση των υπαρχόντων τύπων 
υδροστροβίλων αλλά και τη δημιουργία ενός νέου φιλικού στην ιχθυοπανίδα τύπου (Cada, et al., 
1997). Οι ερευνητές μελέτησαν τους διαφόρους μηχανισμούς  τραυματισμού των ψαριών και 
αξιολόγησαν τα δεδομένα των τραυματισμών και θνησιμότητας. Η μελέτη συνείσφερε στη βαθύτερη 
κατανόηση του αντικειμένου, έθεσε νέα ερωτήματα και οδήγησε στα εξής συμπεράσματα: 

• Οι μηχανισμοί τραυματισμού και θνησιμότητας σχετίζονται με την περιοχή διέλευσης του 
ψαριού. 

• Ψάρια που διέρχονται κοντά στα πτερύγια μπορεί να τραυματιστούν εξαιτίας της κίνησης των 
πτερυγίων, της διέλευσης από το διάκενο μεταξύ tip (κορυφή του πτερυγίου) και κελύφους και 
λόγω τοπικών φαινομένων της ροής. 
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• Το σημείο λειτουργίας του υδροστροβίλου επηρεάζει την επιβίωση του ψαριού ενώ τα 
χαμηλότερα ποσοστά θνησιμότητας δεν σχετίζονται με το μέγιστο βαθμό απόδοσης. Η 
ανάλυση των δεδομένων έδειξε πως η μικρότερη θνησιμότητα δεν επιτυγχάνεται για παροχές 
με απόκλιση έως 1% από το μέγιστο βαθμό απόδοσης διαψεύδοντας παλαιότερες 
δημοσιεύσεις.  

• Τα φαινόμενα σπηλαίωσης αποτελούν μηχανισμό τραυματισμού των ψαριών. Επομένως 
σωστή λειτουργία των υδροστροβίλων χωρίς σπηλαίωση θα επιφέρει ταυτόχρονα μείωση του 
κόστους συντήρησης, αύξηση της ισχύς και καλύτερες συνθήκες για τα ψάρια.  

• Οι τραυματισμοί που προκαλούνται από χαμηλές πιέσεις οφείλονται στη διαφορά μεταξύ 
πίεσης εγκλιματισμού των ψαριών. 

• Ορίσθηκε ως ανώτατο όριο διατμητική τάσης τα 137 
𝑚𝑚
𝑠𝑠
𝑚𝑚

. Διατμητικές τάσεις μεγαλύτερες από 
αυτή την τιμή προκαλούν το θάνατο των ψαριών. 

• Ορίσθηκε ως κατώτατο όριο πίεσης τα 68.8 𝑘𝑘𝑘𝑘𝑘𝑘 
• Ορίσθηκε ως ανώτατος ρυθμός μεταβολής της πίεσης τα 550.3 𝑘𝑘𝑘𝑘𝑘𝑘/𝑠𝑠𝑠𝑠𝑠𝑠 

Αξίζει να αναφερθεί ότι έπειτα από σειρά πειραμάτων στο Wanapum Dam (Kaplan υδροστρόβιλος) το 
2016 η υψηλότερη επιβίωση συνδέθηκε με χαμηλές προβλεπόμενες πιθανότητες strike και ασήμαντα 
επίπεδα σπηλαίωσης. (Fu, et al., 2016) 
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1.3.1 Μηχανισμοί τραυματισμού 
 
Όπως αναφέρθηκε και προηγουμένως, η επιβίωση ενός διερχόμενου από το εσωτερικό υδροστροβίλου 
ψαριού εξαρτάται άμεσα από την πορεία που θα έχει το ψάρι. Από τη στιγμή που το ψάρι εξέλθει του 
ταμιευτήρα, και εισέλθει στο σύστημα του υδροστροβίλου πρέπει να αντιμετωπίσει γεωμετρίες και 
χαρακτηριστικά της ροής που μεταβάλλονται πολύ απότομα και είναι δυνητικά θανατηφόρα σε 
συγκεκριμένες περιοχές του συστήματος. Μια αναπαράσταση των περιοχών αυτών φαίνεται στο Σχήμα 
1.7. 

 

Σχήμα 1.7: Σχηματικό διάγραμμα συστήματος υδροστροβίλου Kaplan στο οποίο απεικονίζονται οι περιοχές του συστήματος 
στις οποίες πιστεύεται αναπτύσσονται φαινόμενα δυσμενή προς τα ψάρια. (Cada, 2001) 

Οι πιθανοί μηχανισμοί τραυματισμού λοιπόν είναι: 

• Μηχανικής φύσης: strike (σύγκρουση με πτερύγιο), grinding (όταν το ψάρι εισέρχεται μέσα από 
στενά διάκενα) και abrasion (όταν το ψάρι «τρίβεται» σε μια επιφάνεια). 

• Αυξομειώσεις πίεσης. 
• Σπηλαίωση. 
• Διατμητική τάση.  
• Τύρβη. 
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Οι κύριοι μηχανισμοί που προκαλούν τραυματισμούς και θνησιμότητα ποικίλουν ανάλογα με την 
ηλικία του ψαριού και το μέγεθος του. Για παράδειγμα η διάτμηση και η τύρβη αποτελούν τους 
κύριους κινδύνους για ένα ψάρι στα πρώτα στάδια της ζωής του. Καθώς το ψάρι μεγαλώνει και 
αναπτύσσεται σε μέγεθος απειλείται κυρίως από σύγκρουση με πτερύγια και άλλους μηχανικής 
φύσεως τραυματισμούς (grinding, abrasion). 

Οι μεμονωμένοι μηχανισμοί που προκαλούν τραυματισμούς στα ψάρια έχουν μελετηθεί εις βάθος 
τόσο σε εργαστηριακό περιβάλλον όσο και με χρήση μαθηματικών μοντέλων. Τέτοιες μελέτες από τη 
μια επιτρέπουν τον ακριβή καθορισμό των μεταβλητών όμως δε δίνουν εικόνα για τις συνδυαστικές 
επιπτώσεις των μηχανισμών τραυματισμού που συναντάμε στις πραγματικές εφαρμογές. Από την άλλη 
μία συνδυαστική μελέτη είναι περισσότερο χρονοβόρα και δαπανηρή από άποψη πόρων, επομένως η 
αναγκαιότητα της πρέπει να δικαιολογηθεί μέσω της έρευνας μεμονωμένων μηχανισμών. Ακολουθεί 
μια σύντομη περιγραφή των μηχανισμών τραυματισμού μαζί με σχετικά δεδομένα. 

Μηχανικής φύσης 

Το ψάρι μπορεί να τραυματιστεί όταν προσκρούει με τα στατικά οδηγητικά πτερύγια, τα ρυθμιστικά 
πτερύγια ή τα κινούμενα πτερύγια του δρομέα. Ο μηχανισμός αυτός ονομάζεται σύγκρουση (strike). 
Τραυματισμός μπορεί να προκύψει επίσης και λόγω grinding, όταν το ψάρι διέρχεται από στενά 
διάκενα που βρίσκονται μεταξύ κινούμενων ή όχι επιφανειών. Οι πιθανοί τραυματισμοί είναι (Brenda, 
et al., 2016): 

• Μελάνιασμα 
• Απολέπιση  
• Βαθύ κόψιμο 
• Αιμορραγία 
• Ακρωτηριασμός 
• Αποκεφαλισμός 

Αναφορικά με τους παράγοντες που επηρεάζουν τη σοβαρότητα των εκάστοτε τραυματισμών έχουμε 
(Brenda, et al., 2016): 

• Μήκους του ψαριού 
• Συμπεριφορά του ψαριού 
• Ταχύτητα περιστροφής του δρομέα 
• Διάταξη των πτερυγίων 
• Αριθμός των πτερυγίων 
• Σχήμα των πτερυγίων 
• Διάκενο μεταξύ των πτερυγίων 
• Μορφολογία του ψαριού (ίσως, απαιτείται περαιτέρω έρευνα) 

Strike 

Η κύρια αιτία θνησιμότητας. Ο αριθμός των πτερυγίων και η μεταξύ τους απόσταση φαίνεται να είναι 
οι δύο σημαντικότεροι παράγοντες για τα μοντέλα που υπολογίζουν τις πιθανότητες σύγκρουσης με 
πτερύγιο. Οι υδροστρόβιλοι Francis και Cross-Flow τυπικής σχεδίασης μειονεκτούν έναντι των Kaplan 
αφού διαθέτουν περισσότερα και πυκνότερα κατανεμημένα πτερύγια.  Ήδη από τις πρώτες μελέτες 
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ήταν φανερό πως το μέγεθος του ψαριού ήταν ένας σημαντικός παράγοντας θνησιμότητας στους 
υδροστροβίλους Francis και τα μεγαλύτερα ψάρια παρουσίαζαν περισσότερους τραυματισμούς και 
μεγαλύτερη θνησιμότητα. (Brenda, et al., 2016) 
Αργότερα, σε μελέτες (Cada, et al., 1997) με πρόσφατα νεκρά ψάρια αποδείχθηκε πως τα μικρότερα 
ψάρια (με βάρος μικρότερο των 20 γραμμαρίων) μπορούν να γλιστρήσουν γύρω από το την ακμή του 
πτερυγίου με τη βοήθεια του νερού σε ποσοστό 100% των περιπτώσεων όταν το κέντρο μάζας τους δε 
βρισκόταν στην πορεία του πτερυγίου. Όταν δε, το κέντρο μάζας βρισκόταν στην πορεία του πτερυγίου 
σύγκρουση υπήρχε μόνο σε ποσοστό 13.7% των περιπτώσεων μόνο. Αντιθέτως, τα μεγαλύτερα ψάρια 
έτειναν να ακολουθούν την αρχική τους τροχιά λόγω της αδράνειας τους, αυξάνοντας τις πιθανότητες 
τους για σύγκρουση. Ψάρια μέχρι 200 gr είχαν 75% πιθανότητες να συγκρουστούν όταν το κέντρο 
μάζας τους συνέπιπτε με την πορεία του πτερυγίου, και για βαρύτερα ψάρια η πιθανότητα ήταν 100%. 
Και για τα μεγαλύτερα ψάρια όμως, όσο το κέντρο βάρους απομακρυνόταν από την πορεία του 
πτερυγίου το ψάρι είχε την τάση να ακολουθήσει τις γραμμές ροής μειώνοντας την πιθανότητα 
σύγκρουσης. Για απόσταση κέντρου βάρους- πορείας πτερυγίου ίση με το 40% του μήκους του ψαριού 
οι πιθανότητες σύγκρουσης ήταν μηδενικές για οποιοδήποτε μέγεθος ψαριού. 
Ένα ψάρι που ακολουθεί μια διαδρομή στο μέσο περίπου των πτερυγίων του δρομέα έχει λιγότερες 
πιθανότητες να τραυματιστεί. Αυτό συμβαίνει διότι οι περιοχές κοντά στο hub και στο tip είναι 
περισσότερο επικίνδυνες λόγω της ύπαρξης και άλλων επιφανειών (κέλυφος, tip), υψηλότερων 
ταχυτήτων (tip) και διακένων (hub, tip).  
Θεωρητικά η πιθανότητα σύγκρουσης μπορεί να εκτιμηθεί χρησιμοποιώντας δεδομένα για την 
ταχύτητα του νερού διαμέσου του υδροστροβίλου, τις γωνίες των διαφόρων πτερυγίων (οδηγητικών, 
ρυθμιστικών και δρομέα), την ταχύτητα περιστροφής του δρομέα και το μήκος των ψαριών. Όμως η 
προσέγγιση αυτή βασίζεται σε αρκετές υποθέσεις μεταξύ των οποίων περιλαμβάνονται: 

• Η κατανομή των ψαριών μπορεί να προσδιοριστεί ή να ορισθεί τυχαία. Αυτό είναι σημαντικό 
καθότι όπως αναφέρθηκε και προηγουμένως κοντά σε hub και tip η θνησιμότητα και η 
πιθανότητα τραυματισμού είναι υψηλότερες.  

• Η είσοδος των ψαριών στον υδροστρόβιλο είναι τυχαία χρονικά ή συμβαίνει ανά τακτά 
διαστήματα. 

• Τα ψάρια θεωρητικά είτε παρασύρονται παθητικά από τη ροή είτε αντιστέκονται κινούμενα με 
αντίθετη κατεύθυνση είτε κινούνται με κάποια γωνία σε σχέση με τη ροή. Η κίνηση αντίθετα 
της ροής ελαττώνει το ρυθμό διέλευσης με αποτέλεσμα την παραμονή του ψαριού στην 
επικίνδυνη περιοχή του δρομέα περισσότερο χρονικό διάστημα. Η σύμφωνη με τη ροή κίνηση 
με κάποια γωνία κατευθύνει το ψάρι σε περιοχές υψηλότερου ή χαμηλότερου κινδύνου. 

• Τα ψάρια είναι ευθυγραμμισμένα με τις γραμμές ροής ή τυχαία. Αυτό επηρεάζει το ενεργό 
μήκος, και επομένως την πιθανότητα σύγκρουσης. 

• Το αποτέλεσμα μιας σύγκρουσης είναι το ίδιο (σοβαρός τραυματισμός ή θάνατος). Προφανώς 
αυτή η υπόθεση δεν ανταποκρίνεται στην πραγματικότητα αφού εξαρτάται από πολλούς 
παράγοντες, όπως τις εμπλεκόμενες ταχύτητες, το σημείο σύγκρουσης, το σχήμα της ανάντι 
ακμής του πτερυγίου. 

Επομένως οι προσεγγίσεις της πιθανότητας σύγκρουσης χαρακτηρίζονται από μεγάλη αβεβαιότητα 
κυρίως λόγω της απρόβλεπτης (και άγνωστης) συμπεριφοράς των ψαριών. Εκτελώντας το ίδιο πείραμα 
χρησιμοποιώντας ζωντανά ψάρια, νεκρά ψάρια και αντικείμενα με ουδέτερη πλευστότητα θα 
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μπορούσαν να εξαχθούν συμπεράσματα για το πόσο ή αντίδραση των ψαριών (εάν υπάρχει) επηρεάζει 
ή όχι τη διέλευση τους από το σύστημα του υδροστροβίλου. 

Χρησιμοποιώντας νέα αλλά και παλαιότερα δεδομένα μια ομάδα επιστημόνων το 2008 δημοσίευσε 
ένα νέο μοντέλο πρόβλεψης συγκρούσεων για υδροστροβίλους Francis και Kaplan (Ferguson, et al., 
2008). Επίσης χρησιμοποιήθηκαν γεωμετρικά δεδομένα από υδροστροβίλους υδροηλεκτρικών 
σταθμών για δύο σημεία λειτουργίας: μέγιστου φορτίου και μέγιστης απόδοσης. Η λειτουργία με 
μέγιστο φορτίο είναι η λειτουργία με μέγιστη ισχύς ανεξαρτήτως παροχής όγκου νερού. Η λειτουργία 
μέγιστης απόδοσης είναι η λειτουργία με μέγιστη ισχύς ανά μονάδα όγκου νερού. Ο επιλεγμένος 
υδροστρόβιλος Francis βρίσκεται στο Stornorrfors Power Station. Τα δεδομένα για το Stornorrfors 
Power Station εισήχθησαν σε ένα spreadsheet για να εκτιμηθεί η πιθανότητα strike (P) σύμφωνα με την 
ακόλουθη σχέση: 

𝑃𝑃 = �
𝑛𝑛 ∙ 𝑁𝑁

60
� �
𝑙𝑙 ∙ 𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠
𝑉𝑉𝑟𝑟

�      (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 1.3) 

 
όπου 𝑛𝑛 ο αριθμός των πτερυγίων, 𝑁𝑁 η ταχύτητα περιστροφής σε RPM, 𝑙𝑙 το μήκος του ψαριού σε 𝑚𝑚, 𝑉𝑉𝑟𝑟 
η ακτινική ταχύτητα του νερού στην είσοδο του δρομέα και 𝛼𝛼 γωνία της ροής μεταξύ απόλυτης 
ταχύτητας 𝑉𝑉 και την εφαπτόμενη στο δρομέα ταχύτητα 𝑉𝑉𝑡𝑡. Στο Σχήμα 1.8 φαίνεται το σχηματικό της 
κατάστασης που περιγράφεται από τη σχέση 1.3. 

 

Σχήμα 1.8: Σχηματικό της γεωμετρίας που χρησιμοποιείται σε μοντέλα σύγκρουσης για ψάρια που διέρχονται διαμέσου 
υδροστροβίλων Francis. (Ferguson, et al., 2008) 

Όπως σε κάθε μοντέλο, έγιναν κάποιες παραδοχές. Η διαδρομή που ακολουθεί το νερό μέσα στον 
υδροστρόβιλο είναι ένα κλειστό, σκοτεινό, υψηλών ταχυτήτων περιβάλλον και επομένως πολύ 
δύσκολο να καταγραφεί. Κάποιες έρευνες έχουν γίνει με σκοπό την αξιολόγηση συστημάτων 
παρακολούθησης της διέλευσης των ψαριών μέσω υδροστροβίλων όμως καμία μελέτη δεν έχει 
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καταγράψει δεδομένα προσανατολισμού ή αντίδρασης των ψαριών καθώς πλησιάζουν το δρομέα. 
Ούτε βέβαια εάν τα δεδομένα διαφοροποιούνται ανάλογα με το μέγεθος και είδος του ψαριού, το 
σημείο λειτουργίας, την εποχή και τα περιβαλλοντολογικά χαρακτηριστικά της εκάστοτε τοποθεσίας. 
Επομένως επιλέχθηκε η γνωστή υπόθεση πως τα ψάρια προσανατολίζονται παράλληλα με τις γραμμές 
ροής καθώς πλησιάζουν το δρομέα.  
Ωστόσο κάθε σύγκρουση δε σημαίνει το θάνατο του ψαριού, για αυτό η σχέση για το 𝑃𝑃 έπρεπε να 
προσαρμοστεί για να εκτιμά την πραγματική πιθανότητα θνησιμότητας. Αυτό έγινε εισάγοντας 
μεταβλητές προσανατολισμού και συμπεριφοράς του ψαριού στο μοντέλο στο επίπεδο που αυτό ήταν 
δυνατό.  

Για τα νεαρά ψάρια χρησιμοποιήθηκε η κάτωθεν εξίσωση παλινδρόμησης: 

𝛭𝛭 = 𝑃𝑃 ∙ (0.1533 ∙ log𝑛𝑛 𝑙𝑙 + 0.0125)     (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 1.4) 

όπου 𝑙𝑙 το μήκος του ψαριού σε 𝑐𝑐𝑐𝑐. 

Για τα μεγαλύτερα χρησιμοποιήθηκε η σχέση: 

𝛭𝛭 = 𝑃𝑃 ∙ 0.47     (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 1.5) 

Grinding 

Η διέλευση του ψαριού από στενά διάκενα ονομάζεται grinding και μπορεί να είναι επιβλαβής για το 
ψάρι. Τα διάκενα αυτά έχουν μέγεθος παραπλήσιο αυτού του ψαριού. Στο Σχήμα 1.7 μπορούμε να 
δούμε μια απεικόνιση αυτού του τύπου τραυματισμού. Συνήθως τα τραύματα είναι μελανιές, αλλά 
ενδέχεται να προκύψουν και βαθιά κοψίματα, ακρωτηριασμός και αποκεφαλισμός. Τέτοια διάκενα σε 
περιοχές υψηλών ταχυτήτων υπάρχουν ανάμεσα στην προπορεύουσα  ακμή του πτερυγίου και το hub, 
τα πτερύγια του δρομέα και το δαχτυλίδι λαιμού, τα ρυθμιστικά πτερύγια και τα οδηγά πτερύγια και 
ανάμεσα στα ρυθμιστικά πτερύγια και το δαχτυλίδι κατανομής. Με ελαχιστοποίηση των διακένων στα 
2 mm μόνο τα εξαιρετικά μικρά ψάρια θα διέτρεχαν κίνδυνο τραυματισμού. 
Ωστόσο είναι αδύνατη η ακριβής διάκριση μεταξύ τραυματισμών από strike ή grinding, ενώ μερικοί 
από τους βασικούς τραυματισμούς λόγω μηχανικών αιτίων μπορεί να προέρχονται και από άλλους 
μηχανισμούς τραυματισμού. (Brenda, et al., 2016) 

Abrasion 

Το «τρίψιμο» του ψαριού σε ένα στοιχείο του υδροστροβίλου ονομάζεται abrasion στη βιβλιογραφία 
και μπορεί να προκαλέσει τραυματισμό στο ψάρι. Στο Σχήμα 1.7 μπορούμε να δούμε μια απεικόνιση 
αυτού του τύπου τραυματισμού. Η σοβαρότητα του τραυματισμού εξαρτάται από το μέγεθος της 
παροχής και την ταχύτητα, τον αριθμό πτερυγίων του δρομέα και το διάκενο μεταξύ αυτών, και τη 
γεωμετρία από την οποία διέρχεται η ροή. (Brenda, et al., 2016) 

Στη συνέχεια παρουσιάζονται τα ευρήματα μια έρευνα του 2016 σχετικά με τους κινδύνους 
τραυματισμών από μηχανικά αίτια που αντιμετωπίζει η ιχθυοπανίδα κατά τη διέλευση της από 
υδροστροβίλους (Fu, et al., 2016). Στην έρευνα χρησιμοποιήθηκαν ψάρια-αισθητήρες για την 
αξιολόγηση των υδραυλικών συνθηκών διέλευσης της ιχθυοπανίδας διαμέσου υδροστροβίλων Francis. 
Μεταξύ άλλων αξιολογήθηκε και το φαινόμενο του striking τόσο ως προς τη συχνότητα όσο και ως 
προς τη σοβαρότητα. 
Οι υδροστρόβιλοι προς εξέταση βρισκόντουσαν σε τρία διαφορετικά φράγματα:  
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• Στο Arrowrock Dam με 108 m υδραυλική πτώση εξετάστηκαν 2 υδροστρόβιλοι Francis με ισχύς 
7.5 MW, 24 ρυθμιστικά πτερύγια, 13 πτερύγια δρομέα και 1.72 m διάμετρο δρομέα. 

• Στο Cougar Dam με 138 m υδραυλική πτώση εξετάστηκαν 2 υδροστρόβιλοι Francis με  ισχύς 
12.5 MW, 24 ρυθμιστικά πτερύγια, 13 πτερύγια δρομέα και 1.83 m διάμετρο δρομέα. 

• Στο Detroit Dam με 141 m υδραυλική πτώση εξετάστηκαν 2 υδροστρόβιλοι Francis με  ισχύς 50 
MW, 24 ρυθμιστικά πτερύγια, 13 πτερύγια δρομέα και 3.30 m διάμετρο δρομέα. 

Τα ψάρια-αισθητήρες που χρησιμοποιήθηκαν είχαν διάμετρο 24.5 mm και μήκος 90 mm. To βάρος 
τους ήταν 43 g και είχαν ουδέτερη πλευστότητα. Τα αποτελέσματα της μελέτης κατηγοριοποιήθηκαν σε 
τρία επίπεδα περιστατικών. Ανάλογα με τις επιταχύνσεις που χαρακτηρίζουν κάθε περιστατικό αυτά 
διακρίνονται σε :  

• Δριμέα περιστατικά εάν |𝛼𝛼| > 95 𝑔𝑔 
• Μέτρια περιστατικά εάν 95 𝑔𝑔 > |𝑎𝑎| ≥ 50 𝑔𝑔 
• Μικρά περιστατικά εάν 50 𝑔𝑔 > |𝑎𝑎| ≥ 25 𝑔𝑔 

Επιπλέον ένα περιστατικό σύγκρουσης (striking) χαρακτηρίζεται από διάρκεια μέγιστης επιτάχυνσης 
μικρότερη των 0.0075 sec, όπου ως διάρκεια μέγιστης επιτάχυνσης θεωρείται ο χρόνος για τον οποίο η 
επιτάχυνση έχει τιμή έως 70% της μέγιστης τιμής. 
Εξετάστηκαν συνολικά 3 υδροστρόβιλοι Francis χρησιμοποιώντας 35 τεχνητά ψάρια-αισθητήρες. Στο 

Detroit Dam (παροχή 62.30 𝑚𝑚
3

𝑠𝑠
) χρησιμοποιήθηκαν 19 ψάρια-αισθητήρες και στο Arrowrock Dam 

(άνοιγμα ρυθμιστικών πτερυγίων στο 80%, παροχή 22.65 𝑚𝑚
3

𝑠𝑠
) 5 ψάρια-αισθητήρες. Στο Cougar Dam 

εξετάστηκαν 3 καταστάσεις λειτουργίας: 

• Minimum άνοιγμα ρυθμιστικών πτερυγίων με παροχή 9.63 𝑚𝑚
3

𝑠𝑠
 και 4 ψάρια-αισθητήρες. 

• Maximum άνοιγμα ρυθμιστικών πτερυγίων με παροχή 15.57 𝑚𝑚
3

𝑠𝑠
 και 3 ψάρια-αισθητήρες. 

• Άνοιγμα ρυθμιστικών πτερυγίων για μέγιστη απόδοση με παροχή 12.88 𝑚𝑚
3

𝑠𝑠
 και 4 ψάρια-

αισθητήρες. 

Τα αποτέλεσμα των πειραμάτων παρατίθενται συνοπτικά στον Πίνακας 1.1. 

 Arrowrock 
Dam 

Detroit Dam Cougar Dam 
Min open. Max open. Peak eff. 

Τεχνητά ψάρια-αισθητήρες 5 19 4 3 4 
Περιοχή διέλευσης Αριθμός ψαριών-αισθητήρων που κατέγραψαν δριμέα περιστατικά 

Αγωγός Προσαγωγής 4 3 0 0 0 
Σταθερά και Ρυθμιστικά Πτερύγια 4 6 1 1 1 

Δρομέας 3 8 3 3 1 
Αγωγός Απαγωγής 0 2 1 0 0 

Σύνολο 5 16 3 3 2 
Πίνακας 1.1: Αποτελέσματα πειραμάτων με ψάρια-αισθητήρες που πραγματοποιήθηκαν από το Pacific Northwest National 

Laboratory. Αριθμός ψαριών-αισθητήρων που υπέστησαν δριμέα περιστατικά λόγω σύγκρουσης. (Fu, et al., 2016) 

Τέλος, μερικές αλλαγές που θα μπορούσαν να μειώσουν τους τραυματισμούς από μηχανικά αίτια 
περιλαμβάνουν (Cada, et al., 1997): 
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• Μείωση του αριθμού πτερυγίων ή του συνολικού μήκους της ανάντι ακμής των πτερυγίων θα 
μειώσει την πιθανότητα επαφής. 

• Μεγιστοποίηση του χώρου μεταξύ των πτερυγίων θα παρέχει μεγαλύτερες διαδρομές 
ασφαλούς διέλευσης για τα ψάρια. 

• Αμβλείς ακμές πτερυγίων θα προκαλούν λιγότερους και ηπιότερους τραυματισμούς από τις 
οξείς ακμές. 

• Χαμηλότερες ταχύτητες περιστροφής σημαίνουν χαμηλότερες ταχύτητες σύγκρουσης και άρα 
λιγότεροι τραυματισμοί. Ένα όριο που υπάρχει στη βιβλιογραφία για σχεδιασμό φιλικού προς 
τα ψάρια υδροστροβίλου είναι τα 12 𝑚𝑚

𝑠𝑠
 και κατά προτίμηση 6 𝑚𝑚

𝑠𝑠
. 

• Αποφυγή διέλευσης κοντά στο tip λόγω των υψηλών περιφερειακών ταχυτήτων. Σχεδιασμός 
υδροστροβίλων που θα κατευθύνουν τα ψάρια για διέλευση κοντά στο hub. 

• Ελαχιστοποίηση διακένων στα 2 mm για αποφυγή τραυματισμών λόγω grinding. 
• Ευθυγράμμιση και ελάχιστη απόσταση μεταξύ οδηγητικών και ρυθμιστικών πτερυγίων. 
• Μεγιστοποίηση απόστασης μεταξύ ρυθμιστικών πτερυγίων και δρομέα. 

 
Από ανάλυση δεδομένων θνησιμότητας ψαριών που εισέρχονται σε μια υγρή μάζα προκύπτει 0% 
θνησιμότητα για ταχύτητες έως 20 m/sec και 100% στα 44 m/sec. Για σύγκρουση με στέρεα 
αντικείμενα έχουμε 0% θνησιμότητα για ταχύτητες έως 4.5 m/sec και 100% στα 29 m/sec (Cook, et al., 
1997). Δεδομένα από EPRI υποδεικνύουν ότι η θνησιμότητα  αυξάνει με την αύξηση της περιφερειακής 
ταχύτητας. Ελαχιστοποίηση της θνησιμότητας στους υδροστροβίλους Francis επιτυγχάνεται για 
ταχύτητες περί τα 12 m/sec. Επιπλέον, για περιφερειακές ταχύτητας 6 m/sec ή μικρότερες έχουμε 
μηδενικό ποσοστό θνησιμότητας από συγκρούσεις. 

Πίεση 

Τα ψάρια εκτίθενται σε ραγδαίες μεταβολές πίεσης κατά τη διάβαση τους μέσα στο σύστημα του 
υδροστροβίλου. Οι περιοχές στις οποίες συμβαίνουν αυτές οι μεταβολές φαίνονται στο Σχήμα 1.7. Ο 
τραυματισμός λόγω πίεσης εξαρτάται από την τιμή της πίεσης, το ρυθμό με τον οποίο μεταβάλλεται, 
την πίεση εγκλιματισμού του ψαριού και τον τύπο του ψαριού.  Τα ψάρια διακρίνονται σε δύο τύπους, 
τα φυσόστομα και τα φυσόκλειστα (Duncan, 2011). Η διάκριση αυτή αφορά τα ψάρια που διαθέτουν 
νηκτική κύστη. Ψάρια που δε διαθέτουν νηκτική κύστη ευδοκιμούν σε περιβάλλοντα που δεν υπάρχει 
πιθανότητα εισαγωγής του σε σύστημα υδροστροβίλου. Τα φυσόστομα ψάρια (όπως ο σολομός και η 
πέστροφα) διαθέτουν έναν πνευματικό αγωγό που συνδέει τη νηκτική τους κύστη με τον οισοφάγο, 
επιτρέποντας την άμεση εισαγωγή ή εξαγωγή αέρα και επομένως τον εγκλιματισμό του ψαριού. Στα 
φυσόκλειστα ψάρια (όπως η πέρκα και το λαβράκι) απουσιάζει ο συγκεκριμένος αγωγός, η εξαγωγή ή 
εισαγωγή αέρα γίνεται μέσω του κυκλοφορικού συστήματος και τη δυνατότητα του αίματος να 
μεταφέρει οξυγόνο. Η διαδικασία αυτή όμως μετριέται στην τάξη των ωρών και επομένως τα ψάρια 
αυτά είναι περισσότερο ευαίσθητα στις αλλαγές πίεσης.  

Τα ποσοστά θνησιμότητας διαφέρανε όταν σε πειράματα μεταβάλλονταν η πίεση εγκλιματισμού των 
ψαριών, τα επίπεδα του διαλυμένου στο νερό οξυγόνου και η ελάχιστη πίεση. Επομένως, οι μεταβολές 
της πίεσης που επηρεάζουν τα ψάρια σχετίζονται με την πίεση εγκλιματισμού τους πριν την είσοδο στο 
σύστημα του υδροστροβίλου. H πίεση εγκλιματισμού των εισαγόμενων ψαριών σε κάθε υδροηλεκτρικό 
σταθμό εξαρτάται από τη διαθέσιμη υδραυλική πτώση. Τυπικές τιμές είναι τα 4.5 μέτρα (146 kPa σε 
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απόλυτη πίεση) για σταθμούς με μικρή διαθέσιμη υδραυλική πτώση μέχρι και 52 μέτρα (605 kPa σε 
απόλυτη πίεσης) σε σταθμούς με μεγάλη διαθέσιμη υδραυλική πτώση. 

Αναφορικά με τις μεταβολές πίεσης που αναπτύσσονται στο εσωτερικό υδροστροβίλων ισχύουν τα 
κάτωθεν: 

• Υδροστρόβιλοι με μεγάλη διαθέσιμη υδραυλική πτώση είναι συνήθως μικρότερες μονάδες και 
έχουν μεγάλο ρυθμό μεταβολής πίεσης ανά μονάδα χρόνου, υδροστρόβιλοι με χαμηλή 
διαθέσιμη υδραυλική πτώση είναι μεγάλες μονάδες με μικρό ρυθμό μεταβολής της πίεσης ανά 
μονάδα χρόνου. 

• Τα ψάρια υπόκεινται σε μεταβολές πίεσης από 607 kPa στην είσοδο του δρομέα σε 48 kPa στην 
έξοδο αυτού.  

• Η διαφορά πίεσης ένα τετραγωνική μονάδα εμβαδού πτερυγίων επηρεάζει το χρόνο διέλευσης 
διαμέσου του δρομέα. 

• Το μεγαλύτερο ποσοστό μεταβολής της πίεσης πραγματοποιείται μέσα σε 0.1 με 0.2 
δευτερόλεπτα. 

Υπάρχει πληθώρα δημοσιεύσεων σχετικές με τις επιπτώσεις των μεταβολών πίεσης στα ψάρια. Έρευνα 
του 1951 έδειξε πως η νηκτικές κύστες σε πέρκα 10 εκατοστών (φυσόκλειστο είδος) έσκαγαν σε πιέσεις 
40% μικρότερης της πίεσης εγκλιματισμού (Cada, et al., 1997). Το 1995 μια άλλη μελέτη έδειξε πως 
πέστροφες (φυσόστομο είδος)  εκτιθέμενες σε αύξηση πίεσης από 241 kPa σε 1275 kPa σε λιγότερο 
από ένα λεπτό και ακολούθως ακαριαία αποσυμπίεση δεν παρουσίασαν βλάβη ή τραύμα (Cada, et al., 
1997). Επιπλέον, σε μία μελέτη του 1976 νεογνοί λευκόσαρκων ψαριών και κυπρίνοι εκτέθηκαν σε 
ραγδαία αύξηση της πίεσης από ατμοσφαιρική στα 4997 kPa και ακολούθησε μια αποσυμπίεση πίσω 
στην ατμοσφαιρική πίεσης διάρκειας 10 λεπτών χωρίς των τραυματισμό των ψαριών (Cada, et al., 
1997). Ακόμα, το 1975 σε ψευδορέγγες εξετάστηκε αύξηση της πίεσης από ατμοσφαιρική στα 350 kPa, 
η πίεση αυτή κρατήθηκε για 15 λεπτά και επέστρεψε στην ατμοσφαιρική εντός δύο λεπτών. Τα ψάρια 
δυσκολευόντουσαν να διατηρήσουν την οριζόντια θέση αρχικά λόγω της συμπίεσης της νηκτικής τους 
κύστης όμως τελικά προσαρμόστηκαν.  (Cada, et al., 1997) 

Οι αυξήσεις πίεσης λοιπόν, όσο μεγάλες ή απότομες είναι δε δείχνουν να επηρεάζουν τα ψάρια που 
διέρχονται διαμέσου του υδροστροβίλου, χωρίς αυτό να σημαίνει πως δεν έχουν κάποια συνέπεια στο 
σώμα των ψαριών. Λόγω της μεγάλης πίεσης η νηκτική κύστη των ψαριών συμπιέζεται, επομένως το 
ψάρι βαραίνει και βυθίζεται αφού πλέον δε συμπεριφέρεται σαν ένα αντικείμενο με ουδέτερη 
πλευστότητα (Duncan, 2011). Η βύθιση του ψαριού το ωθεί να ακολουθήσει διαφορετικά μονοπάτια 
της ροής, μεγαλύτερου ή μικρότερου ρίσκου. Ακόμα και τα φυσόστομα ψάρια επηρεάζονται από αυτό 
το φαινόμενο αφου ο διαθέσιμος χρόνος δεν είναι αρκετός για να προσαρμοστούνε. Σχετικά με τις 
κινήσεις του ψαριού στο εσωτερικό του υδροστροβίλου, όπως την ικανότητα του να αποφεύγει 
εμπόδια ή το πως ανταποκρίνεται στην αύξηση της πυκνότητας του λόγω αύξησης της πίεσης, δεν είναι 
τίποτα γνωστό οπότε υποθέτουμε πως συμπεριφέρονται παθητικά. 

Εξετάζοντας τα πειραματικά δεδομένα είναι φανερό πως τα ψάρια είναι περισσότερα ευαίσθητα στις 
μειώσεις πίεσης παρά στις αυξήσεις. Η θνησιμότητα λόγω τραυμάτων πίεσης οφείλεται κυρίως στη 
διόγκωση της νηκτικής κύστης, προκαλώντας εξοφθαλμία, εμβολές και τελικά ρήξη της κύστης και 
θάνατο του ψαριού. Τα παραπάνω είναι αποτελέσματα της απότομης και μεγάλης μείωσης της πίεσης 
σε σχέση με την πίεση εγκλιματισμού του ψαριού. 
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Θεωρητικά στοιχεία σε ψάρια της οικογένειας των σολομονίδων έδειξαν πως τα επίπεδα θνησιμότητας 
είναι μηδενικά για πιέσεις έως και 30% της πίεσης εγκλιματισμού. Τα θεωρητικά ευρήματα 
επιβεβαιώθηκαν και από πειραματικά αποτελέσματα. Εξετάζοντας παλαιότερες δημοσιεύσεις για τη 
θνησιμότητα των ψαριών κατασκευάστηκε το ακόλουθο Σχήμα 1.9 συσχέτισης της θνησιμότητας των 
ψαριών με έκθεση σε πιέσεις μικρότερες της πίεσης εγκλιματισμού τους. Τα μόνα ψάρια που 
εμφάνιζαν θνησιμότητα σε πιέσεις μεγαλύτερες από το 30% ( μεταξύ 30% και 40%) της πίεσης 
εγκλιματισμού ήταν φυσόκλειστα ψάρια, ενώ οι τρεις μελέτες που έγιναν για πίεση έκθεσης 
μεγαλύτερη από το 60% της πίεσης εγκλιματισμού είχαν ελάχιστα ή μηδενικά ποσοστά θνησιμότητας. 

 

Σχήμα 1.9: Διάγραμμα ελάχιστης πίεσης με θνησιμότητα από δεδομένα παλαιότερων δημοσιεύσεων. (Cada, et al., 1997) 

Θα μπορούσαμε λοιπόν να πούμε πως ένα όριο κατώτερης πίεσης για την μείωση της θνησιμότητας θα 
ήταν το 30% της πίεσης εγκλιματισμού. Ένα πιο συντηρητικό όριο είναι το 40% της πίεσης 
εγκλιματισμού προκειμένου να συμπεριληφθούν και τα φυσόκλειστα είδη ψαριών. Οι ερευνητές της 
Voith όρισαν το όρια της κατώτερης πίεσης στα 68.8 kPa (Odeh, 1999). 

Ο ρυθμός όμως με τον οποίο μεταβάλλεται η πίεση σε πολλά σημεία του υδροστροβίλου είναι 
αναπόφευκτα μεγαλύτερος από το ρυθμό με τον οποίο τα φυσόστομα ή φυσόκλειστα ψάρια είναι 
ικανά να προσαρμόσουν την πίεση του σώματος τους. Θεωρητικά κάθε ρυθμός μεταβολής 
μεγαλύτερος απο αυτόν που τα ψάρια είναι ικανά να αντισταθμίσουν μπορεί να προκαλέσει ζημιά στο 
ψάρι. Οι ερευνητές της Voith όρισαν το ανώτατο όριο ρυθμού μεταβολής στα 550.3 kPa/sec (Franke, et 
al., 1997) . 

Για να μπούνε σε σύγκριση αυτά τα όρια ακολουθούν τα προφίλ πιέσεων διαμέσου δύο 
υδροστροβίλων στο Arrowrock Dam. To Arrowrock Dam διαθέτει δύο πανομοιότυπους 
υδροστροβίλους Francis 7.5 MW, οι μετρήσεις έγιναν χρησιμοποιώντας δύο τεχνητά ψάρια 
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εξοπλισμένα με διάφορους αισθητήρες. Οι μετρήσεις πραγματοποιήθηκαν το 2016 από το Pacific 
Northwest National Laboratory (Fu, et al., 2016). Τα αποτελέσματα των μετρήσεων απεικονίζονται 
γραφικά στο Σχήμα 1.10. Τα διαγράμματα a και c προέρχονται από το Τεχνητό Ψάρι 1 και τα 
διαγράμματα b και d από το Τεχνητό Ψάρι 2. Tα πάνω διαγράμματα απεικονίζουν τις μετρήσεις που 
έγιναν από την στιγμή ελευθέρωσης των ψαριών στον πάνω ταμιευτήρα (Tr) μέχρι και την έξοδο τους 
από στον ταμιευτήρα απαγωγής (Τ5). Τα κάτω διαγράμματα απεικονίζουν με λεπτομέρεια τις 
μετρήσεις στην περιοχή των σταθερών πτερυγίων (Τ2 είσοδος), ρυθμιστικών πτερυγίων και δρομέα (Τ3 
είσοδος στο δρομέα, Τ4 έξοδος από το δρομέα και είσοδος στον αγωγό απαγωγής). 

 

Σχήμα 1.10: Προφίλ πιέσεων και επιταχύνσεων όπως μετρήθηκαν από δύο τεχνητά ψάρια στους δύο Francis υδροστροβίλους 
του Arrowrock Dam. Τα δύο πάνω διαγράμματα απεικονίζουν τη συνολική πορεία των αισθητήρων από την είσοδο μέχρι την 

έξοδο. Τα δύο κάτω διαγράμματα αφορούν την περιοχή από τα οδηγά πτερύγια μέχρι και την έξοδο από το δρομέα. (Fu, et al., 
2016) 

Παρατηρώντας τα διαγράμματα βλέπουμε πως η κατώτερη πίεση βρίσκεται περίπου στα 55 kPa ενώ ο 
ρυθμός μεταβολής μετρήθηκε στα 4661 kPa/sec. Η πρώτη τιμή είμαι μειωμένη κατά περίπου 20% από 
το όριο που έθεσαν οι ερευνητές της Voith, όμως ο ρυθμός μεταβολής είναι σχεδόν δεκαπλάσιος. 
Μετρήσεις έγιναν και στους υδροστροβίλους Francis σε δύο ακόμα φράγματα, το Detroit Dam και το 
Cougar Dame. Στο τελευταία εξετάστηκε η λειτουργία του για ελάχιστο και μέγιστο άνοιγμα 



21 
 

ρυθμιστικών πτερυγίων καθώς και για μέγιστη απόδοση. Οι μετρήσεις αυτές έδωσαν τα ίδια ποιοτικά 
αποτελέσματα με το Arrowrock Dam. Ακολουθεί ο Πίνακας 1.2 των αποτελεσμάτων: 

 Arrowrock 
Dam 

Detroit Dam Cougar Dam 
Min open. Max open. Peak eff. 

Μεταβολή πίεσης (𝒌𝒌𝒌𝒌𝒌𝒌) 283 860 787 848 784 
Ελάχιστη πίεση (kPa) 55 49 56 25 56 

Ρυθμός μεταβολής πίεσης �𝒌𝒌𝒌𝒌𝒌𝒌
𝒔𝒔𝒔𝒔𝒔𝒔
� 4661 7670 7769 13215 9300 

Χρόνος διέλευσης από δρομέα (𝒔𝒔𝒔𝒔𝒔𝒔) 0.090 0.174 0.152 0.085 0.173 
Πίνακας 1.2: Μέσα μέτρα των αλλαγών πίεσης, ρυθμού μεταβολής της πίεσης, και χρόνου διέλευσης κατά τη διάρκειας 

μετάβασης του αισθητήρα από την είσοδο των ρυθμιστικών πτερυγίων έως την έξοδο από τον υδροστρόβιλο. (Fu, et al., 2016) 

Παρατηρούμε πως σε όλες τις εξεταζόμενες μονάδες το κύριο πρόβλημα δεν είναι η κατώτερη πίεση, 
αφού βρίσκεται πολύ κοντά στην προτεινόμενη τιμή των ερευνητών της Voith αλλά ο ρυθμός 
μεταβολής της πίεσης που είναι τάξη μεγέθους μεγαλύτερος. Ανάλογες μελέτες με τα τεχνητά ψάρια-
αισθητήρες έγιναν και σε υδροστροβίλους Kaplan όπου βρέθηκαν αρκετά υψηλότερες τιμές για την 
κατώτερη πίεση (2.5 – 3 φορές μεγαλύτερη) καθώς και χαμηλότερες τιμές ρυθμού μεταβολής της 
πίεσης (5-10 φορές μικρότερες). Ακόμα ο χρόνος διέλευσης διαμέσου του δρομέα είναι 2-4 
μεγαλύτερος, ανάλογα την περίπτωση. Τα αποτελέσματα αυτά επιβεβαιώνουν τις ενδείξεις 
πειραμάτων με ζωντανά ψάρια που υπεδείκνυαν την ανωτερότητα των υδροστροβίλων Kaplan 
αναφορικά με τα ποσοστά επιβίωσης της ιχθυοπανίδας. 

Σπηλαίωση 

Η παρουσία θυλάκων ατμού στο ρευστό προκαλεί ζημιά στα πτερύγια των υδροδυναμικών μηχανών. 
Οι θύλακες αυτοί σχηματίζονται όταν η στατική πίεση τείνει τοπικά να γίνει μικρότερη από την πίεση 
ατμοποίησης του νερού. Το φαινόμενο της ραγδαίας ατμοποίησης και έπειτα συμπύκνωσης ενός 
υγρού ονομάζεται σπηλαίωση (Παπαντώνης, 2016). Η πλέον πιθανή περιοχή ανάπτυξης του 
φαινομένου στο δρομέα υδροστροβίλου Francis είναι η περιοχή εξόδου του δρομέα όπου η μέση 
στατική πίεση είναι χαμηλή. 
Ο λόγος: 

𝜎𝜎 =
𝐻𝐻𝛩𝛩
𝛨𝛨

=
(𝐻𝐻𝐵𝐵 −𝐻𝐻𝜋𝜋 − 𝐻𝐻𝑆𝑆)

𝐻𝐻
    (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 1.6) 

όπου 𝛨𝛨𝛩𝛩 η διαφορά της ολικής πίεσης, 𝛨𝛨𝛣𝛣 η ατμοσφαιρική πίεση, 𝛨𝛨𝜋𝜋 το ύψος τοποθέτησης του 
υδροστροβίλου σε σχέση με τη διώρυγα απαγωγής, 𝐻𝐻𝑆𝑆 η τάση ατμών του υγρού και 𝛨𝛨 η διαθέσιμη 
υδραυλική πτώση, ονομάζεται παράμετρος Thοma ή παράμετρος  σπηλαίωσης και χαρακτηρίζει 
αποκλειστικά την τοποθέτηση του υδροστροβίλου. Επομένως, η συνθήκη μη ανάπτυξης σπηλαίωσης 
εκφράζεται ως: 

𝜎𝜎 =
𝛨𝛨𝛩𝛩
𝛨𝛨

> 𝜎𝜎𝜅𝜅𝜅𝜅 =
𝛨𝛨𝜅𝜅𝜅𝜅
𝛨𝛨

  (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 1.7) 

όπου με 𝜎𝜎𝜅𝜅𝜅𝜅 συμβολίζεται η παράμετρος σπηλαίωσης του υδροστροβίλου: 

𝜎𝜎𝜅𝜅𝜅𝜅 =
𝛨𝛨𝜅𝜅𝜅𝜅
𝛨𝛨

  (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 1.8) 

Η λειτουργία του υδροστροβίλου θα είναι επισφαλής από πλευράς σπηλαίωσης όταν 𝛨𝛨𝛩𝛩 ≈ 𝛨𝛨𝜅𝜅𝜅𝜅 ή 
αντίστοιχα 𝜎𝜎 ≈ 𝜎𝜎𝜅𝜅𝜅𝜅 ενώ για 𝛨𝛨𝛩𝛩 < 𝛨𝛨𝜅𝜅𝜅𝜅, αντίστοιχα 𝜎𝜎 < 𝜎𝜎𝜅𝜅𝜅𝜅, η λειτουργία του υδροστροβίλου γίνεται με 
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συστηματική ανάπτυξη σπηλαίωσης. Κατά τη λειτουργία ενός υδροστροβίλου οι ελάχιστες πιέσεις 
τοπικά είναι γενικά κοντά στο όριο σπηλαίωσης. 

Η παράμετρος σπηλαίωσης 𝜎𝜎 χαρακτηρίζει την εμφάνιση της κυριότερης μορφής σπηλαίωσης στους 
υδροστροβίλου αντιδράσεως, αυτής δηλαδή που έχει τη μορφή φυσαλίδων (θυλάκων) που 
αναπτύσσονται στην κυρτή επιφάνεια των πτερυγίων και κοντά στην ακμή εκφυγής. Υπάρχουν και 
άλλες μορφές σπηλαίωσης των οποίων η εμφάνιση είναι σχεδόν ανεξάρτητη της τιμής της παραμέτρου 
σπηλαίωσης 𝜎𝜎 και εξαρτώνται κυρίως από το σημείο λειτουργίας. Για καλά σχεδιασμένο υδροστρόβιλο 
αυτές οι μορφές σπηλαίωσης δεν εμφανίζονται στο κανονικό σημείο λειτουργίας. Οι μορφές 
σπηλαίωσης αυτές είναι (Cook, et al., 1997): 

• Σπηλαίωση εισόδου εξωτερικής επιφάνειας. 
• Σπηλαίωση εισόδου εσωτερικής επιφάνειας. 
• Σχηματισμός στροβίλων Karman. 
• Στήλη σπηλαίωσης. 
• Σπηλαίωση πλήμνης. 
• Σπηλαίωση στεφάνης ή ακροπτερυγίων. 

Η σπηλαίωση εισόδου εξωτερικής επιφάνειας (extrados) εμφανίζεται στους υδροστροβίλους Francis 
λόγω της μεγάλης καμπυλότητας της μεσημβρινής τομής της στεφάνης και οφείλεται στην περιρροή 
της ακμής εισόδου των πτερυγίων σε υψηλές τιμές της διαθέσιμης υδραυλικής πτώσης (Cada, et al., 
1997). Ο συγκεκριμένος τύπος σπηλαίωσης είναι και ο πιο επικίνδυνος από πλευράς φθοράς στους 
υδροστροβίλους Francis, προκαλώντας ζώνες φθοράς μικρής έκτασης αλλά σημαντικού βάθους. 

Το φαινόμενο της σπηλαίωσης προξενεί σημαντικές φθορές στον υδροστρόβιλο επομένως είναι λογικό 
να αποτελεί απειλή και για την ιχθυοπανίδα. Οι θύλακες υδρατμού αφού πρώτα σχηματιστούν σε 
περιοχές χαμηλής πίεσης μεταφέρονται με τη ροή σε περιοχές υψηλότερων πιέσεων όπου γίνονται 
ασταθείς και επανυγροποιούνται συνοδευόμενοι από την κρουστική αύξηση της στατικής τάσης  λόγω 
της μεγάλης διαφοράς στην πυκνότητα μεταξύ υγρής φάσης και φάσης ατμού. Η βίαιη 
επανυγροποίηση των θυλάκων ατμού προκαλεί θόρυβο, δονήσεις, αυξομείωσης πίεσης, διάβρωση των 
περιρρεόμενων επιφανειών και μείωση της απόδοσης του υδροστροβίλου. Η φθορά λόγω σπηλαίωσης 
είναι αποτέλεσμα κυμάτων κρούσης υψηλής πίεσης (μέχρι και 7 𝐺𝐺𝑃𝑃𝑃𝑃) που δημιουργούνται από την 
κατάρρευση των θυλάκων και υψηλής ταχύτητας δεσμών νερού που αμφότερα ξεκινάνε από το κέντρο 
των φυσαλίδων (Cada, et al., 1997). 

Η περιοχή στην οποία λαμβάνει χώρα η κατάρρευση των θυλάκων έχει μεγάλη σημασία. Για ένα 
θύλακα που καταρρέει μακριά από οποιαδήποτε επιφάνεια οι συνεκτικές δυνάμεις που αντιστέκονται 
στην κατάρρευση είναι κατανεμημένες συμμετρικά γύρω από το θύλακα και επομένως και η 
κατάρρευση θα είναι συμμετρική, ενώ το προκύπτον κύμα κρούσης θα διαδοθεί σφαιρικά από το 
σημείο κατάρρευσης. Όμως για ένα θύλακα που καταρρέει κοντά σε κάποια άκαμπτη επιφάνεια (λ.χ. 
τοίχος, πτερύγιο, ψάρι) οι συνεκτικές δυνάμεις δε θα είναι κατανεμημένες συμμετρικά. Στην 
περίπτωση αυτή, νερό εισέρχεται από την περισσότερο απομακρυσμένη από την επιφάνεια πλευρά 
του θύλακα προκαλώντας την κατάρρευση του με κατεύθυνση προς την κοντινή επιφάνεια, καμιά 
φορά σχηματίζεται και μια δέσμη νερού υψηλής ταχύτητας (microjet). Τα φαινόμενα αυτά 
δημιουργούν τοπικές διαβρώσεις στα γειτονικά στη φυσαλίδα στερεά σύνορα και τραυματισμούς στα 
ψάρια που μπορεί να βρίσκονται κοντά. Η μορφή των τραυματισμών μπορεί να είναι σημειακή (από το 
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microjet) ή άλλης μορφής (από το κύμα κρούσης). Τέλος, όταν έχουμε ελαστική ή ελεύθερη επιφάνεια 
(διεπαφή νερού-αέρα) ο θύλακας καταρρέει στην αντίθετη κατεύθυνση, απομακρυνόμενος από την 
επιφάνεια. 

Η σπηλαίωση μπορεί επίσης να περιοριστεί σχεδιάζοντας κατάλληλα τη γεωμετρία του δρομέα 
ελαχιστοποιώντας σημαντικούς παράγοντες σπηλαίωσης όπως (Odeh, 1999): 

• περιοχές υψηλών ταχυτήτων και χαμηλών πιέσεων 
• ανωμαλίες στις επιφάνειες 
• απότομες αλλαγές στην κατεύθυνση της ροής 
• ελαχιστοποίηση διακένων 
• ύψος τοποθέτησης του υδροστροβίλου 
• ατμοσφαιρική πίεση 
• αύξηση του διαλυμένου στο νερό αέρα 

Όλοι οι άνωθεν παράγοντες επηρεάζουν το πόσο διαδεδομένες είναι οι ελάχιστες πιέσεις και επομένως 
τη δυνητική εμφάνιση σπηλαίωσης στα πτερύγια του δρομέα. 

Οι πρώτοι πέντε από τους αναφερθέντες παράγοντες είναι παράμετροι σχεδιασμού και επομένως 
επηρεάζονται από τη γεωμετρία του δρομέα. Η γεωμετρία του δρομέα μπορεί να τροποποιηθεί για να 
μεταβληθούν οι αντίστοιχες παράμετροι με σκοπό τη δημιουργία μια κατανομής πιέσεων που 
ελαχιστοποιεί την εμφάνιση σπηλαίωσης. 

Οι επόμενοι τρεις παράγοντες ορίζονται την τοποθεσία του υδροστροβίλου. Χαμηλότερο ύψος 
τοποθέτησης του υδροστροβίλου σε σχέση με τον διώρυγα απαγωγής είναι προτιμότερο λόγω 
αυξημένων ελάχιστων πιέσεων και άρα μειωμένη σπηλαίωση, όμως παράλληλα αυξάνονται τα κόστη 
εκσκαφών και πολιτικού μηχανικού με αποτέλεσμα να γίνονται συμβιβασμοί.  Η ατμοσφαιρική πίεση 
εξαρτάται από το υψόμετρο της τοποθεσίας και είναι παράμετρος εισόδου για το σχεδιασμό 
ελαχιστοποίησης σπηλαίωσης. Ο διαλυμένος στο νερό αέρας εξαρτάται από την ποιότητα του νερού 
και συνήθως δε λαμβάνεται υπόψη κατά το σχεδιασμό. 

Σχετικά με τους τύπους των τραυματισμών που προξενούνται στα ψάρια λόγω σπηλαίωσης και τους 
παράγοντες που επηρεάζουν τη σοβαρότητα τους λίγα είναι γνωστά, αφού είναι πολύ δύσκολο να 
απομονώσουμε το φαινόμενο και τις επιπτώσεις του. Η πιθανότητα τραυματισμού των ψαριών από 
σπηλαίωση θα μπορούσε να προβλεφθεί με μοντέλα παρόμοια με αυτά για την πρόβλεψη strike. Προς 
το παρόν δεν υπάρχουν δεδομένα για το πόσο κοντά μπορούν να διέλθουν τα ψάρια από κάποια 
περιοχή σπηλαίωσης χωρίς να τραυματιστούν, ενώ μεγάλη αβεβαιότητα υπάρχει και στο αν τα ψάρια 
μπορούν να αναγνωρίσουν της περιοχές σπηλαίωσης και να τις αποφύγουν.  Πάντως, υπάρχουν 
ενδείξεις πως ψάρια που διέρχονται κοντά στο hub είναι πιθανότερο να εκτεθούν σε σπηλαίωση 
συγκριτικά με τα ψάρια που διέρχονται από το μέσο των πτερυγίων. Επίσης, χρησιμοποιώντας 
παχύτερη ακμή στα πτερύγια δε θα έχουμε σπηλαίωση εισόδου σε υψηλές διαθέσιμες υδραυλικές 
πτώσεις ενώ παράλληλα ο διαχωρισμός της ροής θα περιοριστεί. 

Εάν οι υδροστρόβιλοι σχεδιαστούν για λειτουργία  έτσι ώστε η πίεση του νερού δεν πέφτει κάτω από 
το 60% της πίεσης περιβάλλοντος το φαινόμενο της σπηλαίωσης δε θα συμβαίνει. Η σχεδίαση αυτή 
όμως είναι πολύ περιοριστική και δύσκολο να υιοθετηθεί από τους κατασκευαστές. Μια άλλη 
προσέγγιση είναι η μείωση της έντασης των κυμάτων κρούσης. Η ένταση των κυμάτων κρούσης 
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εξαρτάται από πολλούς παράγοντες, όπως το μέγεθος του εκάστοτε θύλακα, την πίεση του νερού στην 
περιοχή κατάρρευσης, το διαλυμένο στο νερό οξυγόνο και άρα την παρουσία φυσαλίδων αέρα. Το 
τελευταίο μπορεί να επιτευχθεί με τεχνητή τροφοδοσία του υδροστροβίλου με αέρα. Ο εισαγόμενος 
αέρας μπορεί να επηρεάσει τα κύματα κρούσης της σπηλαίωσης με δύο τρόπους: 

• η παρουσία αέρα στο εσωτερικό των θυλάκων υδρατμών εξομαλύνει την κατάρρευση τους και 
ελαττώνει την ένταση του προκύπτοντος κύματος κρούσης 

• η παρουσία αέρα στο νερό μειώνει την ταχύτητα του κύματος κρούσης και επομένως την 
επίπτωση αυτών σε κάποια επιφάνεια  

Το αποτέλεσμα είναι ο περιορισμός των συνεπειών του φαινομένου της σπηλαίωσης και επομένως 
θορύβων, δονήσεων, διάβρωσης και τραυματισμού της ιχθυοπανίδας. 
 
Διατμητική Τάση και Τύρβη 

Από όλους του πιθανούς μηχανισμούς τραυματισμού, οι επιδράσεις της διατμητικής τάσης και της 
τύρβης στην ιχθυοπανίδα είναι οι δυσκολότερες να προσδιοριστούν. Η διατμητική τάση σε ένα πεδίο 
ροής είναι το αποτέλεσμα της αλλαγής ταχύτητας σε σχέση με την απόσταση, του ρυθμού 
παραμόρφωσης του υγρού, των όποιων επιταχύνσεων της ροής και/ή της παρουσίας τύρβης. Η 
διατμητική τάση, όπως και η πίεση μετριέται σε δύναμη ανά μονάδα επιφάνειας. Η διαφορά μεταξύ 
των δύο μεγεθών έγκειται στην κατεύθυνση στην οποία ασκείται η δύναμη. Στην πίεση η δύναμη 
ασκείται κάθετα στην επιφάνεια ενώ στη διατμητική τάση παράλληλα στην επιφάνεια. Η διατμητική 
τάση είναι περισσότερο προφανής όταν συναντώνται δύο μάζες νερού που κινούνται σε αντίθετες 
κατευθύνσεις ή όταν μια κινούμενη μάζα νερού επιβραδύνει κοντά σε μια στερεή επιφάνεια (οριακό 
στρώμα).  

Στη φύση οι διατμητικές τάσεις είναι σχεδόν πάντοτε μικρές και δεν τραυματίζουν την ιχθυοπανίδα. Οι 
υδρόβιοι οργανισμοί έχουν αναπτύξει εξελικτικά χαρακτηριστικά που τους επιτρέπουν να 
ανταπεξέρχονται σε αυτά τα επίπεδα διατμητικών τάσεων. (Cook, et al., 1997) 

Στους υδροστροβίλους οι μεγαλύτερες τιμές διατμητικών τάσεων συναντώνται στη διεπαφή μεταξύ της 
ροής και στερεών επιφανειών στις οποίες η ροή επιταχύνει, όπως είναι οι κατάντι ακμές των 
πτερυγίων, τα οδηγητικά και ρυθμιστικά πτερύγια. Ερευνητές της Voith Hydro χρησιμοποιώντας CFD 
επιβεβαίωσαν την ανάπτυξη αυξημένων διατμητικών τάσεων στις προαναφερθέντες περιοχές (Odeh, 
1999). Ανάπτυξη διατμητικών τάσεων έχουμε επίσης στο σωλήνα απαγωγής. Η τύρβη εμφανίζεται σε 
διαφορετικά μεγέθη. Τοπική ανάπτυξη τύρβης, όπως μικρές αναταραχές (eddies) μπορεί να 
παραμορφώσουν ή να τραυματίσουν τοπικά το ψάρι. Τύρβη σε μεγαλύτερη κλίμακα, όπως δίνες στον 
αγωγό απαγωγής μπορούν να αποπροσανατολίσουν τα ψάρια καθιστώντας τα περισσότερα ευάλωτα 
σε θηρευτές μετά την έξοδο τους από την υδροδυναμική μηχανή. 

Τυπικές αλλαγές ταχύτητας μεταξύ των διαφόρων ζωνών διάτμησης είναι της τάξης των 10 𝑚𝑚/𝑠𝑠. 
Διάφορα κενά που βρίσκονται κοντά στα ρυθμιστικά πτερύγια αλλά και τα πτερύγια του δρομέα, 
διαρροές από αυτά τα σημεία και όχι βέλτιστη λειτουργία του υδροστροβίλου προκαλούν διαχωρισμό 
της ροής και δημιουργία δινών και άρα ζωνών υψηλών διατμητικών τάσεων. Ο ακριβής προσδιορισμός 
των περιοχών αυτών μπορεί να συμβάλει στον καλύτερο σχεδιασμό και λειτουργία των υδροστροβίλων 
με στόχο την ελαχιστοποίηση των ζωνών αυτών. Οι δίνες τύρβης στον αγωγό απαγωγής επίσης 
δημιουργούν ζώνες υψηλών διατμητικών τάσεων και ίσως είναι η κύρια πηγή τραυματισμού από 
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διατμητικές τάσεις στους υδροστροβίλους Francis. Μερικά κριτήρια σχεδιασμού στη βιβλιογραφία 
(Cada, et al., 2006) είναι: 

• Περιφερειακή ταχύτητα δρομέα έως 12 𝑚𝑚
𝑠𝑠

 και κατά προτίμηση 6 𝑚𝑚
𝑠𝑠

. 

• Ρυθμός διάτμησης 180 
𝑚𝑚
𝑠𝑠
𝑚𝑚

, για τη συγκεκριμένη τιμή ακόμα και τα πιο ευαίσθητα ψάρια δεν 
τραυματίζονται 

Οι επιδράσεις των διατμητικών τάσεων στη διερχόμενη μέσω υδροστροβίλων ιχθυοπανίδα είναι 
ελάχιστα γνωστές εξαιτίας των δυσκολιών προσδιορισμού τόσο των τιμών όσο και των περιοχών που 
αναπτύσσονται μέσα στον υδροστρόβιλο και στη συνέχεια την αναπαραγωγή τους σε ελεγχόμενο 
εργαστηριακό περιβάλλον. Τα ψάρια μπορούν να τραυματιστούν, ακόμα και θανάσιμα όταν συναντάνε 
περιοχές υψηλών διατμητικών τάσεων. Oι τραυματισμοί λόγω υψηλών διατμητικών τάσεων και/ή 
τύρβης περιλαμβάνουν (Brenda, et al., 2016): 

• Απολέπιση 
• Καταστροφή επιθηλιακού ιστού 
• Καταστροφή βλεννογόνου 
• Αποπροσανατολισμός 
• Αδυναμία αντιμετώπισης θηρευτών 
• Παραμορφώσεις (επιμήκυνση, συμπίεση, στρέψη) 

ενώ εξαρτώνται από τους ακόλουθους παράγοντες: 

• Μήκος του ψαριού 
• Μορφολογία του ψαριού 
• Στάδιο της ζωής του ψαριού 
• Τρόπος εισόδου στη ζώνη διάτμησης 
• Τύπος του υδροστροβίλου (ίσως) 

Με σκοπό την μεγιστοποίηση της επιβίωσης της ιχθυοπανίδας είναι απαραίτητη η κατανόηση της 
επίδρασης των διατμητικών τάσεων και, αν αυτό κριθεί απαραίτητο, η υιοθέτηση σχεδιαστικών και 
λειτουργικών τροποποιήσεων στους υδροστροβίλους. Δύο ερευνητές το 1992 (Electric Power Research 
Institute, 1992) εκτίμησαν πως οι διατμητικές δυνάμεις σε έναν υδροστρόβιλο είναι κατά μέσο όρο 500 
𝛮𝛮
𝑚𝑚2, ενώ οι μέγιστες τιμές κυμαίνονται μεταξύ 3740 𝛮𝛮

𝑚𝑚2 και 5421 𝛮𝛮
𝑚𝑚2, για λειτουργία on-design και off-

design αντίστοιχα. Βάσει αυτών των εκτιμήσεων πραγματοποιήθηκαν πειράματα σε πολλά είδη 
ψαριών. Σχετικά μεγάλα ψάρια όπως αυτά της οικογένειας των σολομονίδων για χαμηλές τιμές 
διατμητικών τάσεων (206 με 774 𝛮𝛮

𝑚𝑚2) παρουσίασαν μόνο απώλεια λεπιών και είχαν μηδενική 

θνησιμότητα 7 μέρες μετα την έκθεση τους. Στα 3410 𝛮𝛮
𝑚𝑚2 παρουσιάστηκαν καταστροφή του 

βλεννογόνου και βλάβες στα μάτια, η θνησιμότητα μετά από 7 μέρες ήταν 10%. Μικρότερα ψάρια 
όπως αυτά της οικογένειας των κλυπεΐδων είναι πολύ πιο ευάλωτα στις διατμητικές δυνάμεις. Όλα τα 
ψάρια που χρησιμοποιήθηκαν στα πειράματα ακόμα και για διατμητική τάση 206 𝛮𝛮

𝑚𝑚2 είχαν 100% 
θνησιμότητα εντός μίας ώρας. Τέλος στα χέλια παρατηρήθηκαν ελαφροί τραυματισμοί και 0% 
θνησιμότητα έπειτα από 7 ημέρες ακόμα για έκθεση στις μεγαλύτερες τιμές διατμητικών τάσεων. Οι 
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διαφορές αποδόθηκαν στην ανθεκτικότητα των εξωτερικών ιστών (επιθηλιακός ιστός και βλεννογόνο), 
με τα χέλια να διαθέτουν τις πιο παχιές και άρα ανθεκτικές στρώσεις. 

Τα συγκεκριμένα πειράματα μπορούσαν να προσομοιάσουν μόνο τις συνθήκες μικρής κλίμακας 
φαινομένων τύρβης και διατμητικών τάσεων. Σε μεγάλης κλίμακας φαινόμενα τα ψάρια υπόκεινται 
ακόμα σε δυνάμεις επιμήκυνσης, συμπίεσης και στρέψης. 

Πειράματα με τεχνητά ψάρια-αισθητήρες έχουν γίνει με σκοπό τη βαθύτερη κατανόηση όχι μόνο των 
φαινομένων ανάπτυξης διατμητικών τάσεων και τύρβης αλλά γενικότερα της διέλευσης των ψαριών 
διαμέσου υδροστροβίλων (Fu, et al., 2016). Τα τεχνητά ψάρια έχουν τη δυνατότητα καταγραφής των 
περιβαλλοντικών συνθηκών, τα όποια στη συνέχεια οι ερευνητές κατηγοριοποιούν ανάλογα με τη 
ένταση τους. Σύμφωνα με τη βιβλιογραφία τα περιστατικά διακρίνονται ανάλογα με τις επιταχύνσεις 
που τα χαρακτηρίζουν σε: (1) δριμύ περιστατικά εάν |𝛼𝛼| > 95 𝑔𝑔, μέτρια περιστατικά εάν 95 𝑔𝑔 > |𝑎𝑎| ≥
50 𝑔𝑔 και μικρά περιστατικά εάν 50 𝑔𝑔 > |𝑎𝑎| ≥ 25 𝑔𝑔. 

Την περίοδο 2009-2010 το US Army Corps of Engineers πραγματοποίησε μετρήσεις σε υδροστρόβιλο 
Francis στο Oregon Cougar Dam χρησιμοποιώντας τεχνητά ψάρια εξοπλισμένα με αισθητήρες (Duncan, 
2011). Από όλα τα πιθανά περιστατικά που μπορεί να αντιμετωπίσει ένα ψάρι κατά τη διέλευση του 
μέσω ενός υδροστροβίλου τα δριμύτερα από αυτά συνέβησαν στην περιοχή των ρυθμιστικών 
πτερυγίων και του δρομέα, με 50% αυτών να χαρακτηρίζονται ως περιστατικά διάτμησης όταν ο 
υδροστρόβιλος λειτουργούσε στη μέγιστη απόδοση. Για λειτουργία στη χαμηλότερη παροχή τα 
περιστατικά διάτμησης αντιστοιχούσαν στο 25% του συνόλου.  Αξίζει να σημειωθεί πως τα υπόλοιπα 
ακραία περιστατικά ήταν συγκρούσεις (strike). 

H έρευνα προσδιορισμού των συνθηκών διέλευσης μέσα από υδροστρόβιλο Francis (Fu, et al., 2016) 
που αναφέρθηκε και στην ενότητα μηχανικής φύσεως τραυματισμών και πίεσης ασχολήθηκε επίσης 
και με τις διατμητικές τάσεις που δέχεται η ιχθυοπανίδα. Εξετάστηκαν συνολικά 3 υδροστρόβιλοι 
Francis χρησιμοποιώντας 35 τεχνητά ψάρια-αισθητήρες. Στον αγωγό προσαγωγής δεν καταγράφηκε 
δριμύ περιστατικό. Στην περιοχή των σταθερών και ρυθμιστικών πτερυγίων είχαμε συνολικά δύο δριμύ 
περιστατικά, ενώ στο δρομέα τα περισσότερα με 31 περιστατικά στο σύνολο. Τέλος στον αγωγό 
απαγωγής καταγράφηκε 1 δριμύ περιστατικό. Τα αποτελέσματα παρατίθενται αναλυτικά στον Πίνακας 
1.3. 

 Arrowrock 
Dam 

Detroit Dam Cougar Dam 
Min open. Max open. Peak eff. 

Τεχνητά ψάρια-αισθητήρες 5 19 4 3 4 
Περιοχή διέλευσης Αριθμός ψαριών-αισθητήρων που κατέγραψαν δριμέα περιστατικά 

Αγωγός Προσαγωγής 0 0 0 0 0 
Σταθερά και Ρυθμιστικά Πτερύγια 1 1 0 0 0 

Δρομέας 1 19 4 3 4 
Αγωγός Απαγωγής 0 1 0 0 0 

Σύνολο  2 19 4 3 4 
Πίνακας 1.3: Αποτελέσματα πειραμάτων με ψάρια-αισθητήρες που πραγματοποιήθηκαν από το Pacific Northwest National 

Laboratory. Αριθμός ψαριών-αισθητήρων που υπέστησαν δριμέα περιστατικά λόγω διάτμησης. (Fu, et al., 2016) 

Η τύρβη στον αγωγό απαγωγής είναι πολύ μεγαλύτερη από ότι σε ένα ποτάμι (εξαιρουμένων των 
καταρρακτών). Επειδή κατά την έξοδο από τον δρομέα ο αγωγός έχει σχήμα «στροφής», τα ψάρια ίσως 
αισθάνονται τη στροφή αυτή σαν μία φυσική δίνη με αποτέλεσμα να κατευθύνονται προς την 
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περιφέρεια. Περιφερειακά όμως υπάρχει το τοίχωμα του αγωγού απαγωγής με αποτέλεσμα τα ψάρια 
να τραυματίζονται (abrasion). 

Η κλίση της ταχύτητας κάθετη στη διεύθυνση της ροής είναι μέγιστη κατά μήκος των επιφανειών των 
πτερυγίων όταν η ροή πλησιάζει το πτερύγιο με μεγάλη γωνία πρόσπτωσης. Η ταχύτητα είναι μηδέν 
στο σύνορο του τοίχου αλλά αποκτά τη μέγιστη τιμή της σε μικρή απόσταση, ίση με το οριακό στρώμα. 
Η διατμητικές δυνάμεις δε μπορούν να αποφευχθούν σε αυτή την περίπτωση, όμως μπορούν να 
περιοριστούν διατηρώντας ένα πολύ λεπτό οριακό στρώμα, κάτι που επιτυγχάνεται με την προσεκτική 
επιλογή κλίσης της ταχύτητας (ελαχιστοποιώντας τις επιβραδυνόμενες ροές). 

Άλλες περιοχές διατμητικών τάσεων σχηματίζονται όταν υπάρχει ανακυκλοφορία. Η ανακυκλοφορία 
είναι αποτέλεσμα διαχωρισμού της ροής σε τοίχους όπου η κυκλοφορία της ροής πραγματοποιείται 
όπως φαίνεται στο Σχήμα 1.11. Ο διαχωρισμός της ροής είναι δύσκολο να αποφευχθεί για off-design 
λειτουργία, για on-design αποφεύγεται με προσεκτικό σχεδιασμό. 

 

Σχήμα 1.11:Περιοχή ανακυκλοφορίας και σχηματισμός διατμητικών τάσεων. (Cook, et al., 1997)  
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2 Υπολογιστική Μέθοδος 
 
Η παρούσα εργασία έχει ως στόχο τον προσδιορισμό της τροχιάς που ακολουθούν τα ψάρια στο 
εσωτερικό ενός υδροστροβίλου Francis και τη σύγκριση αυτής με τις γραμμές ροής. Για το σκοπό αυτό 
επιλέχθηκε η δισδιάστατη προσέγγιση του προβλήματος. Το δισδιάστατο υπολογιστικό χωρίο που 
θεωρήθηκε αποτελείται από ένας σπειροειδές κέλυφος, ένα απλοποιημένο μοντέλο δρομέα χωρίς 
σταθερά και κινητά οδηγητικά πτερύγια και το μοντέλο του ψαριού-αντικειμένου. Ως μοντέλο του 
ψαριού-αντικειμένου χρησιμοποιήθηκαν διάφορες γεωμετρίες. Ορίστηκαν τρία μοντέλα ως ένα 
αντικείμενο κυλινδρικής μορφής με ορισμένο πάχος 𝑐𝑐 και μήκος 𝑙𝑙 και ένα ως σφαιρικό. Για την επίλυση 
των ασυμπίεστων εξισώσεων Navies-Stokes χρησιμοποιήθηκε το εμπορικό λογισμικό Ansys Fluent™. 
Για τη μοντελοποίηση της τύρβης δοκιμάστηκαν τα μοντέλα 𝑘𝑘 − 𝜀𝜀 realizable με κλιμακούμενες 
συναρτήσεις τοίχου (scalable wall functions) και 𝑘𝑘 − 𝜔𝜔 Shear Stress Transport (SST). Η κίνηση του 
ψαριού-αντικειμένου προσομοιώθηκε χρησιμοποιώντας το dynamic mesh model. Αρχικά έγινε χρήση 
του dynamic mesh model σε overset διάταξη του προβλήματος χρησιμοποιώντας μόνο το six-dof solver. 
Σε δεύτερη φάση χρησιμοποιήθηκε κανονική διάταξη πλέγματος ενώ από τα dynamic mesh 
ενεργοποιήθηκαν οι επιλογές smoothing, remeshing και six-dof solver. 

Προκειμένου να αποφευχθεί το remeshing του υπολογιστικού χώρου κατά την κίνηση τόσο του δρομέα 
(mesh motion) όσο και του ψαριού-αντικειμένου αρχικά εφαρμόστηκε η τεχνική overset. Σύμφωνα με 
την τεχνική αυτή ο υπολογιστικός χώρος αποτελείται από πολλαπλές αλληλοκαλυπτόμενες ζώνες 
κελιών (cell zones) η κάθε μία από τις οποίες έχει το δικό της πλέγμα και μεταξύ τους συνδέονται με 
διεπαφή overset (overset interface).  Τα μικρότερα δομικά στοιχεία (components) έχουν το δικό τους 
mesh (component mesh) και ενσωματώνονται  σε ένα πλέγμα παρασκηνίου (background mesh) μέσω 
του overset. Η τιμές των μεγεθών στα αλληλοκαλυπτόμενα κελιά υπολογίζονται με παρεμβολή. 

Στην εφαρμογή της τεχνικής remeshing για τη μοντελοποίηση της κίνησης του ψαριού αντικειμένου, ο 
δρομέας επιλέχθηκε να είναι ακίνητος. Για την εφαρμογή της μεθόδου ήταν απαραίτητες μερικές 
αλλαγές στην αρχική γεωμετρία. Ο λόγος είναι οι ειδικές οριακές συνθήκες που πρέπει να επιβληθούν 
για την εφαρμογή της μεθόδου καθώς και ο διαφορετικός τρόπος προσέγγισης του προβλήματος.  
Σύμφωνα με την τεχνική αυτή ο υπολογιστικός χώρος αποτελείται από τις ζώνες του αντικειμένου, του 
πεδίου του ρευστού, του δρομέα καθώς και άλλες ζώνες απαραίτητες για την εφαρμογή της μεθόδου. 
Όλες οι ζώνες ανήκουν γενικά στο ίδιο πλέγμα ενώ το στήσιμο του προβλήματος είναι περισσότερο 
περίπλοκο και χρονοβόρο από αυτό της τεχνικής overset. 
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2.1 Γεωμετρία και πλέγμα 
 

2.1.1 Προσέγγιση overset 
 

Συνολικά χρησιμοποιήθηκαν τρία αρχεία γεωμετρίας, ένα για το σπειροειδές κέλυφος (volute), ένα για 
το δρομέα και ένα για το ψάρι αντικείμενο, όπως φαίνονται στο Σχήμα 2.1. Τα αρχεία 
κατασκευάστηκαν στο εμπορικό λογισμικό SolidWorks. 

Η γεωμετρία του σπειροειδούς κελύφους αποτελείται από έξι διαφορετικές ακμές: τρείς ευθείες και 
τρία κυκλικά τόξα. Η γεωμετρία του δρομέα είναι απλοποιημένη, δεν υπάρχουν σταθερά και 
ρυθμιζόμενα οδηγητικά πτερύγια, μόνο 7 πτερύγια δρομέα. Η γεωμετρία του ψαριού-αντικειμένου 
είναι μια εγκοπή σε σχήμα κάψουλας περικλειόμενη από ένα παραλληλόγραμμο πλαίσιο , η 
εσωτερικές ακμές λειτουργούν ως τα όρια του αντικειμένου ενώ η επιφάνεια που σχηματίζεται μεταξύ 
εσωτερικών και εξωτερικών ακμών χρησιμοποιείται για τη δημιουργία του mesh. Η γεωμετρία του 
ψαριού αντικειμένου είναι ενδεικτική αφού λόγω τον διαφόρων παραμετρικών μελετών 
αντικαθίσταται από αρχεία διαφορετικού σχήματος (πχ κυκλικό), λόγου διαστάσεων και θέσης 
εκκίνησης. Μια ολοκληρωμένη απεικόνιση παρουσιάζεται στο Σχήμα 2.2. 

   
Σχήμα 2.1: Τα αρχεία γεωμετρίας που χρησιμοποιήθηκαν, σε περιβάλλον Design Modeler. Aπό αριστερά προς τα δεξιά: 

σπειροειδές κέλυφος, δρομέας, ψάρι-αντικείμενο. 
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Σχήμα 2.2: H τελική σύνθεση της γεωμετρίας σε περιβάλλον Design Modeler. 

Στη συνέχεια έγινε η κατασκευή του πλέγματος (mesh), χρησιμοποιώντας το Ansys Workbench™ και 
συγκεκριμένα το εργαλείο Ansys Meshing™. Όλα τα πλέγματα κατασκευάστηκαν χρησιμοποιώντας 
τετραεδρικά στοιχεία. Για κάθε γεωμετρία ξεχωριστά επιλέχθηκαν το μέγεθος του στοιχείου πλέγματος  
για τη διακριτοποίηση των επιφανειών, το μέγεθος του στοιχείου πλέγματος για τη διακριτοποίηση των 
ακμών. Αμφότερα τα μεγέθη αρχικά ορίστηκαν στο 1.5 mm, για λόγους οικονομίας υπολογισμών όμως 
καθώς και σύγκλισης των αποτελεσμάτων τελικά επιλέχθηκε μέγεθος διακριτοποίησης 3.5 mm για το 
σπειροειδές κέλυφος και το δρομέα και 1.5 mm για το ψάρι-αντικείμενο. Για τα τοιχώματα επιλέχθηκε 
η προσθήκη inflation. Λεπτομέρειες του τελικού πλέγματος φαίνονται στο Σχήμα 2.3. Ο λόγος που 
χρησιμοποιήθηκε μέγεθος στοιχείου 1.5 mm στο πλέγμα του αντικειμένου ήταν η αδυναμία του 
στοιχείου πλευράς 3.5 mm να ακολουθήσει τη γεωμετρία της κάψουλας λόγω των παραπλήσιων 
διαστάσεων της. Η προσθήκη inflation δημιουργεί υψηλής ποιότητας ικανά να ακολουθήσουν τα 
χαρακτηριστικά της γεωμετρίας κελιά με σκοπό το σωστό προσδιορισμό των οριακών στρωμάτων αλλά 
και την σωστή λειτουργία της εφαρμοζόμενης τεχνικής overset. Συγκεκριμένα βοηθάει στο να 
πληρούνται οι συνθήκες αλληλοεπικάλυψης κελιών σε περίπτωση που δύο τοιχώματα πλησιάσουν 
πολύ κοντά.  

   
Σχήμα 2.3: Λεπτομέρειες από τα πλέγματα κάθε γεωμετρίας, από τα αριστερά προς τα δεξιά: σπειροειδές κέλυφος, δρομέας, 

ψάρι-αντικείμενο. 
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2.1.2 Προσέγγιση remeshing 
 
Η κατασκευή του αρχείου γεωμετρίας για την εφαρμογή της μεθόδου remeshing έγινε με μερικές 
μετατροπές των υπάρχοντων αρχείων της τεχνικής overset, χρησιμοποιώντας το σχεδιαστικό 
πρόγραμμα SolidWorks. Τα διαφορετικά αρχεία ενώθηκαν σε ένα, ενώ χρησιμοποιήθηκε το εργαλείο 
offset για τη δημιουργία μια ζωνών γύρω από το αντικείμενο, τα τοίχωμα των πτερυγίων του δρομέα 
και το τοίχωμα του κελύφους, όπως φαίνεται στο Σχήμα 2.4. Το παραπάνω έγινε για λόγους σωστής 
εφαρμογής της τεχνικής remeshing. Η γεωμετρία απεικονίζεται ολόκληρη στο Σχήμα 2.5. 

  
Σχήμα 2.4: Η γεωμετρία σε περιβάλλον SolidWorks. Κατά σειρά από αριστερά προς τα δεξιά: η γεωμετρία, λεπτομέρεια ψάρι-

αντικείμενο, λεπτομέρεια δρομέα. 

 

Σχήμα 2.5: H τελική γεωμετρία σε περιβάλλον SolidWorks. 
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Στη συνέχεια έγινε η κατασκευή του πλέγματος (mesh), χρησιμοποιώντας το Ansys Workbench™ και 
συγκεκριμένα το εργαλείο Ansys Meshing™. Το πλέγμα κατασκευάστηκε χρησιμοποιώντας τριγωνικά 
στοιχεία. Η επιλογή αυτή έγινε λόγω περιορισμών που επιβάλει η χρησιμοποιούμενη τεχνική 
remeshing, συγκεκριμένα για 2D πλέγματα είναι υποχρεωτική η χρήση τριγωνικών στοιχείων ενώ για 
3D τετραδικών στοιχείων. Για κάθε γεωμετρία ξεχωριστά επιλέχθηκαν το μέγεθος του στοιχείου 
πλέγματος  για τη διακριτοποίηση των επιφανειών (3.5 𝑚𝑚𝑚𝑚), το μέγεθος του στοιχείου πλέγματος για 
τη διακριτοποίηση των ακμών (3.5 𝑚𝑚𝑚𝑚). Η επιλογή του μεγέθους στοιχείου δεν είναι τυχαία και έγινε 
μετά από δοκιμές. Για το μέγεθος στοιχείου αυτό το τελικό πλέγμα αποτελείται από 35700 περίπου 
στοιχεία, ανάλογα με το επιλεγμένο ψάρι-αντικείμενο. Για τα τοιχώματα κελύφους, πτερυγίων και 
ψαριού-αντικειμένου επιλέχθηκε η προσθήκη inflation. Είναι φανερή η πύκνωση των στοιχείων γύρω 
από το ψάρι-αντικείμενο στο Σχήμα 2.6, λόγο της προσθήκης inflation. Στο ίδιο σχήμα φαίνονται 
λεπτομέρειες από διάφορα σημεία του πλέγματος. 

 

   
Σχήμα 2.6: Πάνω, απεικόνιση ολόκληρου του πλέγματος, Κάτω, λεπτομέρειες από το πλέγμα, από τα αριστερά προς τα δεξιά: 

συνολικό πλέγμα, ψάρι-αντικείμενο, λεπτομέρεια inflation στο τοίχωμα όπως φαίνεται στο σημείο εισόδου, λεπτομέρεια 
inflation σε πτερύγιο του δρομέα.  



33 
 

2.2 Οι εξισώσεις Navier-Stokes για 2-D ασυμπίεστο ρευστό 
 
Οι εξισώσεις Navier-Stokes είναι σημαντικές διέπουσες εξισώσεις στη δυναμική των ρευστών που 
περιγράφουν την ροή των ρευστών. Οι εξισώσεις προκύπτουν από την εφαρμογή του 2ου Νόμου του 
Νεύτωνα στην κίνηση του ρευστού με την υπόθεση ότι το ρευστό δέχεται δυνάμεις λόγω πίεσης, 
ιξώδους και ενίοτε εξωτερικών δυνάμεων. Οι Navier-Stokes ιστορικά αναφέρονται στις τρείς εξισώσεις 
ορμής, αλλά συνηθίζεται να αποκαλούμε έτσι και τις πέντε συνολικά διαφορικές εξισώσεις διατήρησης 
που υπάρχουν: μία εξίσωση διατήρησης μάζας (εξίσωση συνέχειας), μία εξίσωση διατήρησης ενέργειας  
και μία εξίσωση διατήρησης ορμής για κάθε μία από τις τρείς διευθύνσεις του χώρου.  

Ωστόσο, οι εξισώσεις Navier-Stokes είναι μη γραμμικές και δύσκολο να επιλυθούν αναλυτικά. 
Προκειμένου να επιλυθούν, γίνονται διάφορες απλοποιήσεις, όπως γραμμικοποίηση ή υποθέσεις 
ελαφράς μη γραμμικότητας, μικρές διακυμάνσεις, διακριτοποίηση κλπ. Παρά την εκτεταμένη έρευνα 
πάνω στις εξισώσεις Navier Stokes οι καθολικές λύσεις δεν έχουν ακόμα βρεθεί. Οι καθολικές λύσεις 
των τρισδιάστων εξισώσεων Navier-Stokes αποτελούν ένα από τα μεγαλύτερα προβλήματα της 
σύγχρονης φυσικής. 

Οι μέθοδοι της Υπολογιστικής Ρευστομηχανικής (Computational Fluid Dynamics ή CFD) λύνουν 
αριθμητικά τις διακριτοποιημένες μορφές των εξισώσεων Navier-Stokes. Οι αριθμητικές επιλύσεις 
είναι επιτυχημένες αλλά συνοδεύονται πάντα από σφάλματα προσέγγισης και το ανάλογο 
υπολογιστικό κόστος. Η ανάπτυξη ισχυρών υπολογιστών οδηγεί στη βελτίωση των μεθόδων 
διακριτοποίησης και επιτρέπει την αριθμητική προσέγγιση της τυρβώδους ροής. Οι αναλυτικές λύσεις 
των εξισώσεων Navier-Stokes μπορούν να βρεθούν σε πολύ συγκεκριμένες περιπτώσεις. Με την 
εύρεση των αναλυτικών λύσεων αποκτάμε μία λύση αναφοράς για την επιβεβαίωση των 
προσεγγιστικών μεθόδων. 

Οι περισσότεροι νόμοι της μηχανικής αναφέρονται σε υλικά συστήματα, με τη έννοια ότι περιγράφουν 
τις κινήσεις υλικών σωμάτων, ανεξάρτητα του σημείου που βρίσκονται μέσα στο χώρο. Όμως, για τη 
ευκολία της μελέτης των ροών, είναι καλύτερα να εκφράζονται οι νόμοι αυτοί, όχι για ένα 
συγκεκριμένο υλικό σύστημα, αλλά για ένα συγκεκριμένο όγκο του χώρου (όγκος ελέγχου). Την 
μετατροπή της μελέτης από ένα υλικό κινούμενο σύστημα σε ένα σταθερό όγκο ελέγχου, αναλαμβάνει 
το θεώρημα μεταφοράς του Reynolds. Το θεώρημα Reynolds μετατρέπει το ρυθμό μεταβολής μιας 
εντατικής ποσότητας ενός συγκεκριμένου υλικού συστήματος, σε ρυθμό μεταβολής της εντατικής 
ποσότητας σε συγκεκριμένο όγκο ελέγχου.  
 
Ο ρυθμός μεταβολής της εντατικής ποσότητας 𝛷𝛷, ενός υλικού συστήματος είναι:  

𝑑𝑑𝛷𝛷
𝑑𝑑𝑑𝑑

=
𝑑𝑑
𝑑𝑑𝑑𝑑
�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡)𝑑𝑑𝑑𝑑
𝑉𝑉

 

Όπου 𝑉𝑉 ο όγκος που καταλαμβάνει το υλικό σύστημα κάθε χρονική στιγμή και 𝜌𝜌 η πυκνότητα του 
ρευστού. Δηλαδή ο όγκος δεν είναι σταθερός, αλλά κινείται. Έτσι η σχέση γράφεται: 

𝑑𝑑
𝑑𝑑𝑑𝑑
�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖, 𝑡𝑡)𝑑𝑑𝑑𝑑
𝑉𝑉

= lim
𝛿𝛿𝑡𝑡→0

1
𝛿𝛿𝑡𝑡 �

�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖, 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑉𝑉′ −�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡)𝑑𝑑𝑑𝑑
𝑉𝑉𝑉𝑉′

�  
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Στη σχέση αυτή ο όγκος 𝑉𝑉′ είναι ο όγκος που καταλαμβάνει το υλικό σύστημα τη χρονική στιγμή 𝑡𝑡 , ενώ 
ο όγκος 𝑉𝑉 της χρονικής στιγμής 𝑡𝑡 + 𝛿𝛿𝑡𝑡. 

Το πρώτο ολοκλήρωμα του δεύτερου μέλους της σχέσης γράφεται: 

�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑉𝑉′

𝑉𝑉′

= 

�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑑𝑑 −
𝑉𝑉

�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖, 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑑𝑑
𝛿𝛿𝑉𝑉1

+ �𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖, 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑑𝑑
𝛿𝛿𝑉𝑉2

 

Επομένως: 

𝑑𝑑
𝑑𝑑𝑑𝑑
�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡)𝑑𝑑𝑑𝑑
𝑉𝑉

= 

= lim
𝛿𝛿𝑡𝑡→0

1
𝛿𝛿𝑡𝑡
��𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑑𝑑 −�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑑𝑑 + �𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑑𝑑

𝛿𝛿𝑉𝑉2𝛿𝛿𝑉𝑉1𝑉𝑉

−�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡)𝑑𝑑𝑑𝑑
𝑉𝑉

� = 

= lim
𝛿𝛿𝑡𝑡→0

1
𝛿𝛿𝑡𝑡 �

�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑑𝑑
𝑉𝑉

−�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖, 𝑡𝑡)𝑑𝑑𝑑𝑑
𝑉𝑉

� + 

+ lim
𝛿𝛿𝑡𝑡→0

1
𝛿𝛿𝑡𝑡 �

−�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖, 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑉𝑉 + �𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖, 𝑡𝑡 + 𝛿𝛿𝑡𝑡)𝑑𝑑𝑑𝑑
𝛿𝛿𝑉𝑉2𝛿𝛿𝑉𝑉1

� 

Πλέον η τελική σχέση εκφράζει το ρυθμό μεταβολής της εντατικής ποσότητας 𝜑𝜑 σε ένα συγκεκριμένο 
όγκο ελέγχου 𝑉𝑉. 

Το πρώτο όριο εκφράζει την μεταβολής της ιδιότητας μέσα στον όγκο αυτό, ενώ το δεύτερο όριο το 
ρυθμό με τον οποίο περνά η ιδιότητα αυτή από την επιφάνεια του όγκου αυτού. Έτσι έχουμε: 

𝑑𝑑𝛷𝛷
𝑑𝑑𝑑𝑑

=
𝑑𝑑
𝑑𝑑𝑑𝑑
�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡)𝑑𝑑𝑑𝑑
𝑉𝑉

+ �𝜌𝜌 ∙ 𝑢𝑢�⃗ ∙ 𝑛𝑛�⃗ ∙ 𝜑𝜑 ∙ 𝑑𝑑𝑑𝑑
𝑆𝑆

 

όπου 𝑢𝑢�⃗  η διανυσματική ταχύτητα του ρευστού στην επιφάνεια 𝑑𝑑𝑠𝑠 και 𝑛𝑛�⃗  το μοναδιαίο κάθετο διάνυσμα 
στην επιφάνεια. 

Έτσι λόγω του θεωρήματος Green η σχέση γράφεται: 

𝑑𝑑𝛷𝛷
𝑑𝑑𝑑𝑑

=
𝑑𝑑
𝑑𝑑𝑑𝑑
�𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖 , 𝑡𝑡)𝑑𝑑𝑑𝑑
𝑉𝑉

+ �∇(𝜌𝜌 ∙ 𝑢𝑢�⃗ ∙ 𝜑𝜑)𝑑𝑑𝑑𝑑
𝑉𝑉

= ��
𝑑𝑑
𝑑𝑑𝑑𝑑 �

𝜌𝜌 ∙ 𝜑𝜑(𝑥𝑥𝑖𝑖, 𝑡𝑡)� + ∇(𝜌𝜌 ∙ 𝑢𝑢�⃗ ∙ 𝜑𝜑)� 𝑑𝑑𝑑𝑑
𝑉𝑉

 

Επομένως η εξίσωση μεταφοράς του Reynolds, από την οποία δημιουργούνται οι εξισώσεις Navier-
Stokes, γίνεται: 
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𝑑𝑑
𝑑𝑑𝑑𝑑
�𝜌𝜌 ∙ 𝜑𝜑𝑑𝑑𝑑𝑑
𝑉𝑉

= ��
𝑑𝑑
𝑑𝑑𝑑𝑑

(𝜌𝜌 ∙ 𝜑𝜑) + ∇(𝜌𝜌 ∙ 𝑢𝑢�⃗ ∙ 𝜑𝜑)�
𝑉𝑉

𝑑𝑑𝑑𝑑 

Για την εξίσωση της διατήρηση της μάζας, ο ρυθμός μεταβολής του 𝛷𝛷 θα είναι μηδέν, αφού δεν 
παράγεται ή δημιουργείται μάζα και θα έχουμε 𝜑𝜑 = 1. 

Άρα: 

��
𝑑𝑑
𝑑𝑑𝑑𝑑

(𝜌𝜌 ∙ 𝜑𝜑) + ∇(𝜌𝜌 ∙ 𝑢𝑢�⃗ ∙ 𝜑𝜑)� 𝑑𝑑𝑑𝑑
𝑉𝑉

= 0 

Επομένως: 

𝑑𝑑
𝑑𝑑𝑑𝑑

(𝜌𝜌 ∙ 𝜑𝜑) + ∇(𝜌𝜌 ∙ 𝑢𝑢�⃗ ∙ 𝜑𝜑) = 0 

Αφού ο ρυθμός μεταβολής του 𝛷𝛷 είναι μηδέν: 

𝑑𝑑𝑑𝑑
𝑑𝑑𝑑𝑑

+ 𝑢𝑢�⃗ ∙ ∇𝜌𝜌 + 𝜌𝜌 ∙ ∇𝑢𝑢�⃗ =
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

+ 𝜌𝜌 ∙ ∇ ∙ 𝑢𝑢�⃗ = 0 

Όπου 𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

= 𝑑𝑑𝑑𝑑
𝑑𝑑𝑑𝑑

+ 𝑢𝑢�⃗ ∙ ∇𝜌𝜌 η υλική παράγωγος (material derivative), η οποία εκφράζει το ρυθμό μεταβολής 
που βλέπει ένας παρατηρητής κινούμενος μαζί με το ρευστό. Η εξίσωση αυτή απλοποιείται ανάλογα με 
τις ιδιότητες του ρευστού. Στην περίπτωση μας έχουμε ασυμπίεστο ρευστό άρα: 

𝑑𝑑𝑑𝑑
𝑑𝑑𝑑𝑑

+ 𝑢𝑢�⃗ ∙ ∇𝜌𝜌 + 𝜌𝜌 ∙ ∇ ∙ 𝑢𝑢����⃗ = 0 ↔  ∇ ∙ 𝑢𝑢�⃗ = 0 ↔ 

↔  
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

= 0 

όπου 𝑢𝑢, 𝑣𝑣 και 𝑤𝑤 η τιμής της ταχύτητας στις διευθύνσεις x,𝑦𝑦 και 𝑧𝑧 αντίστοιχα. 

Και επειδή το πρόβλημα μας είναι δισδιάστατο η εξίσωση της συνέχειας γίνεται: 

𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

= 0 (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 2.1) 

Για τις εξισώσεις της ορμής χρησιμοποιούμε πάλι το θεώρημα Reynolds με 𝜑𝜑 = 𝑢𝑢 με τον παρακάτω 
τρόπο: 

𝑑𝑑
𝑑𝑑𝑑𝑑
�𝜌𝜌 ∙ 𝑢𝑢𝑢𝑢𝑢𝑢
𝑉𝑉

= �𝜌𝜌 ∙ 𝐹𝐹𝑑𝑑𝑑𝑑
𝑉𝑉

+ �𝑝𝑝�𝑛𝑛𝑗𝑗, 𝑥𝑥𝑗𝑗, 𝑡𝑡�𝑑𝑑𝑑𝑑
𝑆𝑆

 

Όπου 𝐹𝐹 οι δυνάμεις που ενεργούν σε όλο τον όγκο ελέγχου (π.χ. πεδιακές δυνάμεις), 𝑝𝑝�𝑛𝑛𝑗𝑗, 𝑥𝑥𝑗𝑗, 𝑡𝑡� ο 
τανυστής πρώτου βαθμού των δυνάμεων επαφής. Όμως ισχύει: 𝑝𝑝�𝑛𝑛𝑗𝑗, 𝑥𝑥𝑗𝑗, 𝑡𝑡� = 𝑇𝑇𝑖𝑖𝑗𝑗 ∙ 𝑛𝑛𝑗𝑗, όπου 𝛵𝛵𝑖𝑖𝑖𝑖 
τανυστής δεύτερης τάξης και n𝑗𝑗 τανυστής πρώτης τάξης. Άρα: 

𝑑𝑑
𝑑𝑑𝑑𝑑
�𝜌𝜌 ∙ 𝑢𝑢𝑢𝑢𝑢𝑢
𝑉𝑉

= �𝜌𝜌 ∙ 𝐹𝐹𝑑𝑑𝑑𝑑
𝑉𝑉

+ �𝑇𝑇𝑖𝑖𝑖𝑖 ∙ 𝑛𝑛𝑗𝑗𝑑𝑑𝑑𝑑
𝑆𝑆

= �𝜌𝜌 ∙ 𝐹𝐹𝑑𝑑𝑑𝑑
𝑉𝑉

+ �
𝜕𝜕𝑇𝑇𝑖𝑖𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

𝑑𝑑𝑑𝑑
𝑉𝑉

 



36 
 

 

Για το πρώτο μέλος ισχύει: 

𝑑𝑑
𝑑𝑑𝑑𝑑
�𝜌𝜌 ∙ 𝑢𝑢𝑢𝑢𝑢𝑢
𝑉𝑉

= �𝜌𝜌 ∙
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

𝑑𝑑𝑑𝑑
𝑉𝑉

 

Επομένως: 

�𝜌𝜌 ∙
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

𝑑𝑑𝑑𝑑
𝑉𝑉

= �𝜌𝜌 ∙ 𝐹𝐹𝑑𝑑𝑑𝑑
𝑉𝑉

+ �
𝜕𝜕𝑇𝑇𝑖𝑖𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

𝑑𝑑𝑑𝑑
𝑉𝑉

 ↔  
𝐷𝐷𝑢𝑢𝑗𝑗
𝐷𝐷𝐷𝐷

= 𝐹𝐹𝑖𝑖 +
1
𝜌𝜌
𝜕𝜕𝛵𝛵𝑖𝑖𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

  ↔ 𝜌𝜌
𝐷𝐷𝑢𝑢𝑗𝑗
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝜌𝜌𝑖𝑖 +
𝜕𝜕𝛵𝛵𝑖𝑖𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

 

 

Ο όρος 
𝜕𝜕𝛵𝛵𝑖𝑖𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

 από τη στιγμή που μιλάμε για νευτώνειο ρευστό αναλύεται ως: 

𝜕𝜕𝛵𝛵𝑖𝑖𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

= −∇p + ∇ ∙ �𝜇𝜇�∇𝑢𝑢�⃗ + (∇𝑢𝑢�⃗ )𝛵𝛵��+ ∇ ∙ �𝜆𝜆(∇ ∙ 𝑢𝑢�⃗ )𝛪𝛪� + 𝐹⃗𝐹 

Όμως η ροή είναι επιπλέον και ασυμπίεστη, άρα: 

• Ο συντελεστής συνεκτικότητας 𝜇𝜇 είναι σταθερός 
• Tο ιξώδες όγκου 𝜆𝜆 = 0 (στην ελληνική βιβλιογραφία συμβολίζεται και ως 𝜇𝜇′)  
• Από την εξίσωση της συνέχειας έχουμε ∇ ∙ 𝑢𝑢�⃗ = 0 

Έτσι έχουμε για την 𝑥𝑥 διεύθυνση: 

𝜌𝜌
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝜌𝜌𝑥𝑥 −
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+
𝜕𝜕
𝜕𝜕𝜕𝜕

�2𝜇𝜇
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕
� +

𝜕𝜕
𝜕𝜕𝜕𝜕

�𝜇𝜇 �
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕
��+

𝜕𝜕
𝜕𝜕𝜕𝜕
�𝜇𝜇 �

𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕
�� ↔ 

↔ 𝜌𝜌
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝜌𝜌𝑥𝑥 −
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+ 2𝜇𝜇
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑥𝑥2

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑦𝑦2

+ 𝜇𝜇
𝜕𝜕2𝑣𝑣
𝜕𝜕𝜕𝜕𝜕𝜕𝜕𝜕

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑧𝑧2

+ 𝜇𝜇
𝜕𝜕2𝑤𝑤
𝜕𝜕𝜕𝜕𝜕𝜕𝜕𝜕

↔ 

↔ 𝜌𝜌
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝜌𝜌𝑥𝑥 −
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑥𝑥2

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑦𝑦2

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑧𝑧2

+ 𝜇𝜇
𝜕𝜕
𝜕𝜕𝜕𝜕

�
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕
� 

Όμως: 

𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

= 0 

Άρα:  
 

𝜌𝜌
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝐹𝐹𝑥𝑥 −
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑥𝑥2

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑦𝑦2

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑧𝑧2

 

Τελικώς για την εξίσωση διατήρησης της ορμής στην κατεύθυνση του άξονα 𝑥𝑥 έχουμε: 

𝜌𝜌
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝜌𝜌𝑥𝑥 −
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+ 𝜇𝜇 �
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑥𝑥2

+
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑦𝑦2

+
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑧𝑧2

� 
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Για τους άξονες 𝑦𝑦 και 𝑧𝑧 ομοίως: 

𝜌𝜌
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝜌𝜌𝑦𝑦 −
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+ 𝜇𝜇 �
𝜕𝜕2𝑣𝑣
𝜕𝜕𝑥𝑥2

+
𝜕𝜕2𝑣𝑣
𝜕𝜕𝑦𝑦2

+
𝜕𝜕2𝑣𝑣
𝜕𝜕𝑧𝑧2

� 

𝜌𝜌
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝜌𝜌𝑧𝑧 −
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+ 𝜇𝜇 �
𝜕𝜕2𝑤𝑤
𝜕𝜕𝑥𝑥2

+
𝜕𝜕2𝑤𝑤
𝜕𝜕𝑦𝑦2

+
𝜕𝜕2𝑤𝑤
𝜕𝜕𝑧𝑧2

� 

Και επειδή το πρόβλημα μας είναι δισδιάστατο: 

𝜌𝜌
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝜌𝜌𝑥𝑥 −
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+ 𝜇𝜇 �
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑥𝑥2

+
𝜕𝜕2𝑢𝑢
𝜕𝜕𝑦𝑦2

�  (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 2.2)  

𝜌𝜌
𝐷𝐷𝐷𝐷
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝜌𝜌𝑦𝑦 −
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+ 𝜇𝜇 �
𝜕𝜕2𝑣𝑣
𝜕𝜕𝑥𝑥2

+
𝜕𝜕2𝑣𝑣
𝜕𝜕𝑦𝑦2

�  (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 2.3) 

Μια περισσότερο συμπτυγμένη μορφή των εξισώσεων Navies-Stokes είναι η ακόλουθη: 

𝜌𝜌
𝐷𝐷𝑢𝑢𝑖𝑖
𝐷𝐷𝐷𝐷

= 𝜌𝜌𝑓𝑓𝑖𝑖 −
𝜕𝜕𝜕𝜕
𝜕𝜕𝑥𝑥𝑖𝑖

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗2

 

Αναλύοντας και την υλική παράγωγο για λόγους σαφήνειας έχουμε: 

𝜌𝜌 �
𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝜕𝜕

+ 𝑢𝑢𝑗𝑗
𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

� = 𝜌𝜌𝑓𝑓𝑖𝑖 −
𝜕𝜕𝑝𝑝
𝜕𝜕𝑥𝑥𝑖𝑖

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗2
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2.3 Pressure Based Solver 
 
Η επιλογή του επιλυτή πίεσης (pressure based solver) έγινε γιατί θεωρείται κατάλληλος για 
ασυμπίεστες ροές χαμηλών ταχυτήτων Mach (ANSYS, Inc., 2011). 
Το πεδίο ταχυτήτων προκύπτει από την εξίσωση της ορμής. Το πεδίο πιέσεων βρίσκεται με την επίλυση 
μια εξίσωσης πίεσης ή διόρθωσης πίεσης η οποία προκύπτει ύστερα από κατάλληλη διαμόρφωση των 
εξισώσεων συνέχειας και ορμής. 
Το Ansys Fluent επιλύει έτσι τις διέπουσες εξισώσεις για τη διατήρηση της μάζας και της ορμής και 
άλλα βαθμωτά μεγέθη όπως η τύρβη. Χρησιμοποιείται μια τεχνική όγκου ελέγχου που περιλαμβάνει: 

• Διαίρεση του πεδίου σε διακριτούς όγκους ελέγχου χρησιμοποιώντας ένα υπολογιστικό 
πλέγμα. 

• Εφαρμογή των διεπουσών εξισώσεων στον κάθε όγκο ελέγχου ξεχωριστά για την κατασκευή 
των αλγεβρικών εξισώσεων για τις διακριτές εξαρτημένες μεταβλητές (άγνωστοι) όπως 
ταχύτητες, πίεση, θερμοκρασία και συντηρητικά βαθμωτά μεγέθη. 

• Γραμμικοποίηση των διακριτοποιημένων εξισώσεων και επίλυση του προκύπτοντος γραμμικού 
συστήματος για λήψη των ανανεωμένων τιμών των εξαρτημένων μεταβλητών. 

Ο pressure-based solver χρησιμοποιεί έναν αλγόριθμο που ανήκει με μία ευρύτερη κατηγορία 
μεθόδων, τη μέθοδο προβολής. Στη μέθοδο προβολής, ο περιορισμός της διατήρησης της μάζας 
(συνέχεια) του πεδίου ταχυτήτων επιτυγχάνεται επιλύοντας μία εξίσωση πίεσης (ή διόρθωσης πίεσης). 
Η εξίσωση πίεσης λαμβάνεται από τις εξισώσεις συνέχειας και ορμής με τέτοιο τρόπο ώστε το πεδίο 
ταχυτήτων, διορθωμένο από την πίεση, να ικανοποιεί την εξίσωση της συνέχειας. Εφόσον οι διέπουσες 
εξισώσεις είναι μη γραμμικές και συζευγμένες μεταξύ τους, η διαδικασία επίλυσης περιλαμβάνει 
επαναλήψεις, κατά τις οποίες όλες η διέπουσες εξισώσεις λύνονται επαναλαμβανόμενα μέχρι τη 
σύγκλιση της λύσης. 
 
Στο ANSYS FLUENT είναι διαθέσιμοι δύο pressure-based αλγόριθμοι επίλυσης, ο αποζευγμένος 
(segregated) και ο συζευγμένος (coupled) αλγόριθμος (ANSYS, Inc., 2011). Η χρήση της συζευγμένης 
προσέγγισης προσφέρει κάποια πλεονεκτήματα έναντι της αποζευγμένης. Το συζευγμένο σχήμα είναι 
περισσότερο στιβαρό και αποδοτικό για μονοφασικά steady-state προβλήματα, ενώ για μεταβατικές 
ροές είναι απαραίτητο όταν το πλέγμα δεν είναι αρκετά καλό ή χρησιμοποιούνται μεγάλα χρονικά 
βήματα (time steps). 

Ο συζευγμένος αλγόριθμος επιλύει τις εξισώσεις ορμής και pressure-based συνέχειας ταυτόχρονα. Η 
πλήρως πεπλεγμένη σύζευξη επιτυγχάνεται μέσω της πεπλεγμένης διακριτοποίησης των όρων κλίσης 
πίεσης στις εξισώσεις ορμής και της πεπλεγμένης διακριτοποίησης της παροχής μάζας, 
συμπεριλαμβανομένων των Rhie-Chow όρων καταστροφής της πίεσης. 
Στις εξισώσεις ορμής: 
 

𝑎𝑎𝑃𝑃𝑢𝑢 = �𝑎𝑎𝑛𝑛𝑛𝑛𝑢𝑢𝑛𝑛𝑛𝑛 + �𝑝𝑝𝑓𝑓𝐴𝐴 ∙ 𝚤𝚤̂
𝑛𝑛𝑛𝑛

+ 𝑆𝑆 

η κλίση της πίεσης για το 𝑘𝑘 είναι της μορφής: 
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�𝑝𝑝𝑓𝑓𝐴𝐴𝑘𝑘 = −�𝑎𝑎𝑢𝑢𝑘𝑘𝑝𝑝𝑝𝑝𝑗𝑗
𝑗𝑗𝑓𝑓

 

Όπου ο όρος 𝑎𝑎𝑢𝑢𝑘𝑘𝑝𝑝 είναι ο συντελεστής που προκύπτει από το θεώρημα του Gauss και οι συντελεστές 
από τα σχήματα παρεμβολής της πίεσης: 
 

𝑝𝑝𝑓𝑓 =

𝑝𝑝𝑐𝑐0
𝑎𝑎𝑝𝑝,𝑐𝑐0

+
𝑝𝑝𝑐𝑐1
𝑎𝑎𝑝𝑝,𝑐𝑐1

1
𝑎𝑎𝑝𝑝,𝑐𝑐0

+ 1
𝑎𝑎𝑝𝑝,𝑐𝑐1

 

Τέλος για κάθε i-οστό κελί, η διακριτοποιημένη μορφή της εξίσωσης της ορμής για το 𝑢𝑢𝑘𝑘 
προσδιορίζεται ως: 
 

�𝑎𝑎𝑖𝑖𝑖𝑖
𝑢𝑢𝑘𝑘𝑢𝑢𝑘𝑘𝑢𝑢𝑘𝑘𝑘𝑘

𝑗𝑗

+ �𝑎𝑎𝑖𝑖𝑖𝑖
𝑢𝑢𝑘𝑘𝑝𝑝𝑝𝑝𝑗𝑗

𝑗𝑗

= 𝑏𝑏𝑖𝑖
𝑢𝑢𝑘𝑘 

Στην εξίσωση της συνέχειας, η εξίσωση: 
 

� 𝐽𝐽𝑓𝑓𝐴𝐴𝑓𝑓 = 0
𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁

𝑓𝑓

 

Όπου ο όρος 𝐽𝐽𝑓𝑓 είναι η παροχή μάζας διαμέσου του face 𝑓𝑓,𝜌𝜌𝑣𝑣𝑛𝑛. 
Για να προχωρήσουμε είναι απαραίτητο να συσχετιστούν οι τιμές της ταχύτητας στο face, 𝑣𝑣𝑛𝑛����⃗ , στις 
αποθηκευμένες τιμές της ταχύτητας στα κέντρα των κελιών. Η γραμμική παρεμβολή των 
κεντροκυψελικών ταχυτήτων στα faces δημιουργεί πρόβλημα checkerboarding στις πιέσεις (οι τιμές 
των πιέσεων, και άρα η εξίσωση της ορμής, δε μπορούν πλέον να μεταβάλουν το πεδίο ταχυτήτων). Το 
Ansys Fluent, χρησιμοποιεί μια διαδικασία παρόμοια με αυτή που περιέγραψαν οι Rhie και Cow για την 
αποφυγή του checkerboarding. Οι τιμές των ταχυτήτων στα faces δεν προκύπτουν γραμμικά, αλλά με 
συντελεστές βάρους-ορμής που βασίζονται στο συντελεστή 𝑎𝑎𝑝𝑝 της εξίσωσης: 
 

𝑎𝑎𝑃𝑃𝑢𝑢 = �𝑎𝑎𝑛𝑛𝑛𝑛𝑢𝑢𝑛𝑛𝑛𝑛 + �𝑝𝑝𝑓𝑓𝐴𝐴 ∙ 𝚤𝚤̂
𝑛𝑛𝑛𝑛

+ 𝑆𝑆 

 
Με αυτόν τον τρόπο, η παροχή μάζας στο face, 𝐽𝐽𝑓𝑓, μπορεί να γραφεί: 

𝐽𝐽𝑓𝑓 = 𝜌𝜌𝑓𝑓 �
𝑎𝑎𝑝𝑝,𝐶𝐶0𝑣𝑣𝑛𝑛,𝐶𝐶0 + 𝑎𝑎𝑝𝑝,𝐶𝐶1𝑣𝑣𝑛𝑛,𝐶𝐶1

𝑎𝑎𝑝𝑝,𝐶𝐶0 + 𝑎𝑎𝑝𝑝,𝐶𝐶1
�+ 𝑑𝑑𝑓𝑓 ��𝑝𝑝𝐶𝐶0 + �∇𝑝𝑝�𝐶𝐶0 ∙ 𝑟𝑟0���⃗ �+ �𝑝𝑝𝐶𝐶1 + �∇𝑝𝑝�𝐶𝐶1 ∙ 𝑟𝑟1���⃗ ��

= 𝐽𝐽𝑓𝑓 + 𝑑𝑑𝑓𝑓�𝑝𝑝𝐶𝐶𝑜𝑜 − 𝑝𝑝𝐶𝐶1� 
 

Όπου οι όροι 𝑝𝑝𝐶𝐶0 ,𝑝𝑝𝐶𝐶1 και 𝑣𝑣𝑛𝑛,𝑐𝑐0 , 𝑣𝑣𝑛𝑛,𝑐𝑐1 είναι οι πιέσεις και οι κάθετες συνιστώσες των ταχυτήτων 
αντίστοιχα, μέσα στα δύο κελιά που εφάπτονται στο face, και ο όρος  𝐽𝐽𝑓𝑓 εκφράζει την επιρροή των 
ταχυτήτων στα κελιά. Ο όρος 𝑑𝑑𝑓𝑓 είναι μια συνάρτηση του 𝑎𝑎𝑃𝑃, το μέσο όρο δηλαδή των συντελεστών 𝛼𝛼𝑃𝑃 
της εξίσωσης της ορμής για τα κελιά που εφάπτονται στο face. 
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με αποτέλεσμα τη διακριτοποιημένη μορφή: 
 

��𝑎𝑎𝑖𝑖𝑖𝑖
𝑝𝑝𝑢𝑢𝑘𝑘𝑢𝑢𝑘𝑘𝑘𝑘 + �𝑎𝑎𝑖𝑖𝑖𝑖

𝑝𝑝𝑝𝑝𝑝𝑝𝑗𝑗 = 𝑏𝑏𝑖𝑖
𝑝𝑝

𝑗𝑗𝑗𝑗𝑘𝑘

 

Αποτέλεσμα είναι το συνολικό σύστημα των εξισώσεων: 
 

�𝑎𝑎𝑖𝑖𝑖𝑖
𝑢𝑢𝑘𝑘𝑢𝑢𝑘𝑘𝑢𝑢𝑘𝑘𝑘𝑘

𝑗𝑗

+ �𝑎𝑎𝑖𝑖𝑖𝑖
𝑢𝑢𝑘𝑘𝑝𝑝𝑝𝑝𝑗𝑗

𝑗𝑗

= 𝑏𝑏𝑖𝑖
𝑢𝑢𝑘𝑘 

��𝑎𝑎𝑖𝑖𝑖𝑖
𝑝𝑝𝑢𝑢𝑘𝑘𝑢𝑢𝑘𝑘𝑘𝑘 + �𝑎𝑎𝑖𝑖𝑖𝑖

𝑝𝑝𝑝𝑝𝑝𝑝𝑗𝑗 = 𝑏𝑏𝑖𝑖
𝑝𝑝

𝑗𝑗𝑗𝑗𝑘𝑘

 

 
αφού μετατραπεί στη δ-μορφή, παρουσιάζεται ως: 

�[𝐴𝐴]𝑖𝑖𝑖𝑖𝑋⃗𝑋𝑗𝑗 = 𝐵𝐵�⃗ 𝑖𝑖
𝑗𝑗

 

όπου η επιρροή ενός κελιού 𝑖𝑖 σε ένα κελί 𝑗𝑗 εκφράζεται με τον πίνακα: 

𝐴𝐴𝑖𝑖𝑗𝑗 =

⎣
⎢
⎢
⎢
⎢
⎡𝑎𝑎𝑖𝑖𝑖𝑖

𝑝𝑝𝑝𝑝

𝑎𝑎𝑖𝑖𝑖𝑖
𝑢𝑢𝑢𝑢

𝑎𝑎𝑖𝑖𝑖𝑖
𝑣𝑣𝑣𝑣

𝑎𝑎𝑖𝑖𝑖𝑖
𝑤𝑤𝑤𝑤

𝑎𝑎𝑖𝑖𝑖𝑖
𝑝𝑝𝑝𝑝

𝑎𝑎𝑖𝑖𝑖𝑖𝑢𝑢𝑢𝑢

𝑎𝑎𝑖𝑖𝑖𝑖𝑣𝑣𝑣𝑣

𝑎𝑎𝑖𝑖𝑖𝑖𝑤𝑤𝑤𝑤

     

𝑎𝑎𝑖𝑖𝑖𝑖
𝑝𝑝𝑝𝑝

𝑎𝑎𝑖𝑖𝑖𝑖𝑢𝑢𝑢𝑢

𝑎𝑎𝑖𝑖𝑖𝑖𝑣𝑣𝑣𝑣

𝑎𝑎𝑖𝑖𝑖𝑖𝑤𝑤𝑤𝑤

𝑎𝑎𝑖𝑖𝑖𝑖
𝑝𝑝𝑝𝑝

𝑎𝑎𝑖𝑖𝑖𝑖𝑢𝑢𝑢𝑢

𝑎𝑎𝑖𝑖𝑖𝑖𝑣𝑣𝑣𝑣

𝑎𝑎𝑖𝑖𝑗𝑗𝑤𝑤𝑤𝑤⎦
⎥
⎥
⎥
⎥
⎤

 

και τα διανύσματα των αγνώστων και των υπόλοιπων (residuals) έχουν τη μορφή: 

𝑋𝑋𝚥𝚥���⃑ =

⎣
⎢
⎢
⎢
⎡𝑝𝑝𝑖𝑖

′

𝑢𝑢𝑖𝑖′

𝑣𝑣𝑖𝑖′

𝑤𝑤𝑖𝑖′⎦
⎥
⎥
⎥
⎤
 

𝐵𝐵𝚤𝚤���⃑ =

⎣
⎢
⎢
⎢
⎡−𝑟𝑟𝑖𝑖

𝑝𝑝

−𝑟𝑟𝑖𝑖𝑢𝑢

−𝑟𝑟𝑖𝑖𝑣𝑣

−𝑟𝑟𝑖𝑖𝑤𝑤⎦
⎥
⎥
⎥
⎤
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2.4 Μοντελοποίηση τύρβης 
 
Οι εξισώσεις Navier-Stokes που αναλύθηκαν προηγουμένως είναι μη γραμμικές διαφορικές εξισώσεις 
δεύτερης τάξης οι οποίες μπορούν να περιγράψουν με ακρίβεια κάθε κίνηση των ρευστών, ακόμα 
δηλαδή και στις περιπτώσεις εμφάνισης τύρβης. Για να περιγραφούν όμως με ικανοποιητική ακρίβεια 
τα φαινόμενα της τύρβης, καθότι ιδιαίτερα πολύπλοκα, απαιτείται υψηλή πυκνότητα πλέγματος και 
εξαιρετικά μικρά χρονικά υπολογιστικά βήματα για την προσέγγιση των πηγών διαταραχών μέσα στη 
ροή καθώς και των πιθανών σημείων εμφάνισης πηγών διαταραχών. Οι απαιτήσεις αυτές είναι 
ανάλογες του κύβου του αριθμού Reynolds (R𝑒𝑒3). Σύμφωνα με τα παραπάνω, συμπεραίνουμε ότι η 
άμεση επίλυση της τυρβώδης ροής από τις εξισώσεις Navier-Stokes (Direct Numerical Simulation – DNS) 
απαιτεί μεγάλη υπολογιστική ισχύ ιδιαίτερα για μεγαλύτερους αριθμούς Reynolds. 

Προκειμένου να ξεπεραστεί το εμπόδιο του υψηλού υπολογιστικού κόστους, αναπτύχθηκε η μέθοδος 
της προσομοίωσης μεγάλων δινών (Large Eddy Simulation – LES). Στη συγκεκριμένη μέθοδο οι πηγές 
διαταραχών στις οποίες θα εφαρμοστών οι Navier-Stokes, πρακτικά οι πηγές διαταραχών οι οποίες θα 
προσομοιωθούν, επιλέγονται ανάλογα με το μέγεθος τους. Έτσι μόνο η ανάπτυξη δινών μεγάλης 
κλίμακας προσομοιώνεται, ενώ η γένεση και κίνηση δινών μικρότερης κλίμακας περιγράφεται μέσω 
εξισώσεων προσεγγιστικών μοντέλων και δεν προσομοιώνεται άμεσα. Το υπολογιστικό κόστος για τη 
μέθοδο LES παραμένει μεγάλο αλλά είναι σαφώς μικρότερο από εκείνο της μεθόδου DNS. 

Μια περισσότερη οικονομική υπολογιστικά μέθοδος για την επίλυση της τύρβης είναι οι σταθμισμένες 
κατά Reynolds εξισώσεις Navier-Stokes (Reynolds-Averaged Navier-Stokes – RANS). Στη συγκεκριμένη 
μέθοδο χρησιμοποιούνται πάλι οι εξισώσεις Navier-Stokes με τη διαφορά ότι αντί για τις στιγμιαίες 
τιμές των μεγεθών των ταχυτήτων και της πίεσης χρησιμοποιούνται το άθροισμα μια μέσης χρονικά 
τιμής των μεγεθών και μια διαταραχής, η μέση τιμής της οποίας εξ ορισμού θεωρείται μηδέν. 
Επομένως έχουμε: 

𝑢𝑢 = 𝑢𝑢� + 𝑢𝑢′ 

𝑣𝑣 = 𝑣̅𝑣 + 𝑣𝑣′ 

𝑤𝑤 = 𝑤𝑤� + 𝑤𝑤′ 

𝑝𝑝 = 𝑝̅𝑝 + 𝑝𝑝′ 

Όπου 𝑢𝑢, 𝑣𝑣,𝑤𝑤 οι ταχύτητες για τις διευθύνσεις 𝑥𝑥,𝑦𝑦, 𝑧𝑧 αντίστοιχα και 𝑝𝑝 η πίεση. Για κάθε μέγεθος 𝑎𝑎 
ισχύει: 𝛼𝛼′��� = 0 

Εφαρμόζοντας τη νέα γραφή των μεγεθών στις εξισώσεις Navier-Stokes λαμβάνουμε: 

𝜌𝜌 �
𝜕𝜕𝑢𝑢𝚤𝚤�
𝜕𝜕𝜕𝜕

+ 𝑢𝑢𝚥𝚥�
𝜕𝜕𝑢𝑢𝚤𝚤�
𝜕𝜕𝑥𝑥𝑗𝑗

� = 𝜌𝜌𝑓𝑓𝑖𝑖 −
𝜕𝜕𝑝̅𝑝
𝜕𝜕𝑥𝑥𝑖𝑖

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢𝚤𝚤�
𝜕𝜕𝑥𝑥𝑗𝑗2

− 𝜌𝜌
𝜕𝜕�𝑢𝑢𝚤𝚤′𝑢𝑢𝚥𝚥′���������

𝜕𝜕𝑥𝑥𝑗𝑗
 

Γράφοντας αναλυτικά τις εξισώσεις για τις διευθύνσεις 𝑥𝑥, 𝑦𝑦 και 𝑧𝑧 έχουμε: 

𝜌𝜌 �
𝜕𝜕𝑢𝑢�
𝜕𝜕𝜕𝜕

+ 𝑢𝑢�
𝜕𝜕𝑢𝑢�
𝜕𝜕𝜕𝜕

+ 𝑣̅𝑣
𝜕𝜕𝑢𝑢�
𝜕𝜕𝜕𝜕

+ 𝑤𝑤�
𝜕𝜕𝑢𝑢�
𝜕𝜕𝜕𝜕
� 

= 𝜌𝜌𝑓𝑓𝑥𝑥 −
𝜕𝜕𝑝̅𝑝
𝜕𝜕𝜕𝜕

+ 𝜇𝜇 �
𝜕𝜕2𝑢𝑢�
𝜕𝜕𝑥𝑥2

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢�
𝜕𝜕𝑦𝑦2

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢�
𝜕𝜕𝑧𝑧2�

− 𝜌𝜌�
𝜕𝜕(𝑢𝑢′𝑢𝑢′)��������

𝜕𝜕𝜕𝜕
+
𝜕𝜕(𝑢𝑢′𝑣𝑣′)��������

𝜕𝜕𝜕𝜕
+
𝜕𝜕(𝑢𝑢′𝑤𝑤′)���������

𝜕𝜕𝜕𝜕 � 
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𝜌𝜌 �
𝜕𝜕𝑣̅𝑣
𝜕𝜕𝜕𝜕

+ 𝑢𝑢�
𝜕𝜕𝑣̅𝑣
𝜕𝜕𝜕𝜕

+ 𝑣̅𝑣
𝜕𝜕𝑣̅𝑣
𝜕𝜕𝜕𝜕

+ 𝑤𝑤�
𝜕𝜕𝑣̅𝑣
𝜕𝜕𝜕𝜕
� 

= 𝜌𝜌𝑓𝑓𝑦𝑦 −
𝜕𝜕𝑝̅𝑝
𝜕𝜕𝜕𝜕

+ 𝜇𝜇 �
𝜕𝜕2𝑣̅𝑣
𝜕𝜕𝑥𝑥2

+ 𝜇𝜇
𝜕𝜕2𝑣̅𝑣
𝜕𝜕𝑦𝑦2

+ 𝜇𝜇
𝜕𝜕2𝑣̅𝑣
𝜕𝜕𝑧𝑧2�

− 𝜌𝜌�
𝜕𝜕(𝑣𝑣′𝑢𝑢′)��������

𝜕𝜕𝜕𝜕
+
𝜕𝜕(𝑣𝑣′𝑣𝑣′)��������

𝜕𝜕𝜕𝜕
+
𝜕𝜕(𝑣𝑣′𝑤𝑤′)���������

𝜕𝜕𝜕𝜕 � 

𝜌𝜌 �
𝜕𝜕𝑤𝑤�
𝜕𝜕𝜕𝜕

+ 𝑢𝑢�
𝜕𝜕𝑤𝑤�
𝜕𝜕𝜕𝜕

+ 𝑣̅𝑣
𝜕𝜕𝑤𝑤�
𝜕𝜕𝜕𝜕

+ 𝑤𝑤�
𝜕𝜕𝑤𝑤�
𝜕𝜕𝜕𝜕
� 

= 𝜌𝜌𝑓𝑓𝑧𝑧 −
𝜕𝜕𝑝̅𝑝
𝜕𝜕𝜕𝜕

+ 𝜇𝜇 �
𝜕𝜕2𝑤𝑤�
𝜕𝜕𝑥𝑥2

+ 𝜇𝜇
𝜕𝜕2𝑤𝑤�
𝜕𝜕𝑦𝑦2

+ 𝜇𝜇
𝜕𝜕2𝑤𝑤�
𝜕𝜕𝑧𝑧2 �

− 𝜌𝜌�
𝜕𝜕(𝑤𝑤′𝑢𝑢′)���������

𝜕𝜕𝜕𝜕
+
𝜕𝜕(𝑤𝑤′𝑣𝑣′)���������

𝜕𝜕𝜕𝜕
+
𝜕𝜕(𝑤𝑤′𝑤𝑤′)���������

𝜕𝜕𝜕𝜕 � 

Και αν γραφούν για την περίπτωση μας δισδιάστατου πεδίου: 

𝜌𝜌 �
𝜕𝜕𝑢𝑢�
𝜕𝜕𝜕𝜕

+ 𝑢𝑢�
𝜕𝜕𝑢𝑢�
𝜕𝜕𝜕𝜕

+ 𝑣̅𝑣
𝜕𝜕𝑢𝑢�
𝜕𝜕𝜕𝜕
� = 𝜌𝜌𝑓𝑓𝑥𝑥 −

𝜕𝜕𝑝̅𝑝
𝜕𝜕𝜕𝜕

+ 𝜇𝜇 �
𝜕𝜕2𝑢𝑢�
𝜕𝜕𝑥𝑥2

+ 𝜇𝜇
𝜕𝜕2𝑢𝑢�
𝜕𝜕𝑦𝑦2�

− 𝜌𝜌�
𝜕𝜕(𝑢𝑢′𝑢𝑢′)��������

𝜕𝜕𝜕𝜕
+
𝜕𝜕(𝑢𝑢′𝑣𝑣′)��������

𝜕𝜕𝜕𝜕 � 

 

𝜌𝜌 �
𝜕𝜕𝑣̅𝑣
𝜕𝜕𝜕𝜕

+ 𝑢𝑢�
𝜕𝜕𝑣̅𝑣
𝜕𝜕𝜕𝜕

+ 𝑣̅𝑣
𝜕𝜕𝑣̅𝑣
𝜕𝜕𝜕𝜕
� = 𝜌𝜌𝑓𝑓𝑦𝑦 −

𝜕𝜕𝑝̅𝑝
𝜕𝜕𝜕𝜕

+ 𝜇𝜇 �
𝜕𝜕2𝑣̅𝑣
𝜕𝜕𝑥𝑥2

+ 𝜇𝜇
𝜕𝜕2𝑣̅𝑣
𝜕𝜕𝑦𝑦2�

− 𝜌𝜌�
𝜕𝜕(𝑣𝑣′𝑢𝑢′)��������

𝜕𝜕𝜕𝜕
+
𝜕𝜕(𝑣𝑣′𝑣𝑣′)��������

𝜕𝜕𝜕𝜕 � 

 

Οι παραπάνω εξισώσεις είναι οι γνωστές εξισώσεις του Reynolds και περιγράφουν την τυρβώδη 
ροή. Διαφέρουν από αυτές των Navier-Stokes στα εξής: 

• Είναι διατυπωμένες ως προς τι μέσες τιμές ταχυτήτων και πιέσεων και όχι ως προς τις 
στιγμιαίες τιμές. 

• Περιέχουν στο δεύτερο μέλους τους πρόσθετους όρους �𝜌𝜌
𝜕𝜕�𝑢𝑢𝚤𝚤′𝑢𝑢𝚥𝚥′����������

𝜕𝜕𝑥𝑥𝑗𝑗
� οι οποίοι εκφράζουν την 

επίδραση των διακυμάνσεων της τύρβης στη μέση ροή. 

Οι πρόσθετοι όροι εισάγονται μέσω του τανυστή 𝜏𝜏𝑖𝑖𝑗𝑗′ = �𝑢𝑢𝚤𝚤′𝑢𝑢𝚥𝚥′��������� , ο οποίος ονομάζεται τανυστής τάσεων 
Reynolds και πρόκειται για συνολικά 6 νέες άγνωστες ποσότητες όταν λαμβάνουμε υπόψη και τις τρεις 
διευθύνσεις του χώρου. Το σύστημα των εξισώσεων Reynolds σε συνδυασμό με την εξίσωση της 
συνέχειας δεν είναι πλέον ολοκληρωμένο. Χρειάζονται επιπλέον εξισώσεις έτσι ώστε να «κλείσει» το 
πρόβλημα και να προχωρήσει η επίλυση. 

Από εδώ και στο εξής το σύμβολο που χρησιμοποιήθηκε για το διαχωρισμό των μέσων τιμών των 
μεταβλητών (¯) θα παραλείπεται αφού όλα τα μεγέθη των εξισώσεων θα αναφέρονται στις μέσες τιμές. 

Το πρόβλημα υπολογισμού των τάσεων του Reynolds μπορεί να προσεγγισθεί με δύο τρόπους. Ο 
πρώτος είναι ο απευθείας υπολογισμούς τους με εξισώσεις μεταφοράς, δηλαδή εξισώσεις που λύνουν 
τις τάσεις Reynolds, ενώ ο δεύτερος έχει να κάνει με τη χρήση της υπόθεσης Boussinesq. Η υπόθεση 
Boussinesq αποτελεί μία έκφραση των τάσεων Reynolds συναρτήσει ενός συντελεστή ιξώδους που 
ονομάζεται τυρβώδης συνεκτικότητα. Η τυρβώδης συνεκτικότητα λαμβάνει υπόψιν τις διατμητικές 
τάσεις που δημιουργούνται λόγω της διάχυσης της ορμής μέσα στην τύρβη. Η υπόθεση Boussinesq 
διατυπώνεται ως εξής: 
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−𝜌𝜌𝑢𝑢𝚤𝚤′𝑢𝑢𝚥𝚥′������ = 𝜇𝜇𝑡𝑡 �
𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

+
𝜕𝜕𝑢𝑢𝑗𝑗
𝜕𝜕𝑥𝑥𝑖𝑖

� −
2
3�

𝜌𝜌𝑘𝑘 + 𝜇𝜇𝑡𝑡
𝜕𝜕𝑢𝑢𝑗𝑗
𝜕𝜕𝑥𝑥𝑖𝑖

� 𝛿𝛿𝑖𝑖𝑖𝑖  

ή αλλιώς: 

𝜏𝜏𝑖𝑖𝑖𝑖′ = 𝑢𝑢𝚤𝚤′𝑢𝑢𝚥𝚥′������ = −
2𝜇𝜇𝑡𝑡
𝜌𝜌
�
1
2�

𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

+
𝜕𝜕𝑢𝑢𝑗𝑗
𝜕𝜕𝑥𝑥𝑖𝑖

� −
1
3
𝜕𝜕𝑢𝑢𝑗𝑗
𝜕𝜕𝑥𝑥𝑖𝑖

𝛿𝛿𝑖𝑖𝑖𝑖� +
2
3
𝑘𝑘𝛿𝛿𝑖𝑖𝑖𝑖  

 
Όπου 𝜇𝜇𝑡𝑡 η τυρβώδης συνεκτικότητα και οι δείκτες 𝑖𝑖, 𝑗𝑗 αναφέρονται στην οριζόντια και κάθετη 
διεύθυνση αντίστοιχα. Ο όρος μ𝑡𝑡

𝜌𝜌
 , δηλαδή η τυρβώδης συνεκτικότητα διαιρεμένη με την πυκνότητα του 

ρευστού ονομάζεται τυρβώδης κινηματική συνεκτικότητα και συμβολίζεται ως 𝑣𝑣𝑡𝑡 = 𝜇𝜇𝑡𝑡
𝜌𝜌

. 

Η τιμή της τυρβώδους συνεκτικότητας, και κατ’ επέκταση του τανυστή των τάσεων Reynolds, 
παραμένει άγνωστη και βρίσκεται από τις εξισώσεις μεταφοράς του εκάστοτε μοντέλου τύρβης. 

Συνοψίζοντας, χρησιμοποιώντας την προσέγγιση των χρονικά σταθμισμένων εξισώσεων Navier-Stokes 
RANS, μόνο οι μέσες χρονικά τιμές των πεδίων ταχύτητας και πίεσης υπολογίζονται αριθμητικά και οι 
διακυμάνσεις τους στου χρόνο λόγω τύρβης μοντελοποιούνται μέσω κατάλληλων μοντέλων τύρβης. 
Έτσι το υπολογιστικό κόστος για την εύρεση της λύσης είναι κατά πολύ μικρότερο σε σύγκριση με τις 
μεθόδους DNS και LES. Η μέθοδος RANS χρησιμοποιείται σε πρακτικές εφαρμογές  υπολογιστικής 
ρευστοδυναμικής κατά τη μοντελοποίηση τυρβώδων ροών και είναι η μέθοδος που χρησιμοποιήθηκε 
και στην παρούσα εργασία. 

Μοντέλα Τύρβης: 
 
Στο λογισμικό Fluent είναι διαθέσιμα ως μοντέλα τύρβης τα εξής (ANSYS, Inc., 2011): 

• Μοντέλο των Spalart-Allmaras 
• Μοντέλα k-ε : 

 Μοντέλο Standard k-ε 
 Μοντέλο RNG k-ε 
 Μοντέλο Realizable k-ε 

• Μοντέλα k-ω 
 Μοντέλο Standard k-ω 
 Μοντέλο Baseline (BSL) k-ω 
 Μοντέλο Shear Stress Transport (SST) k-ω 

• Μοντέλο Transition k-kl-ω 
• Μοντέλο Transition SST 
• Μοντέλα Τάσεων Reynolds (δε χρησιμοποιούν την παραδοχή του Boussinesq) 

 Μοντέλο Linear Pressure-Strain 
 Μοντέλο Quadratic Pressure-Strain 
 Μοντέλο Stress-Omega 

Τα μοντέλα τύρβης εισάγουν στο σύστημα μας από μηδέν νέες μερικές διαφορικές εξισώσεις, εάν 
πρόκειται για αλγεβρικά μοντέλα έως και δώδεκα νέες διαφορικές εξισώσεις. Στη συνέχεια θα 
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αναφερθούμε πιο αναλυτικά στα μοντέλα k−ε (συγκεκριμένα στο μοντέλο Realizable k – ε) και k−ω 
(συγκεκριμένα στο μοντέλο k – ω SST). 
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2.4.1 Μοντέλα τύρβης 𝑘𝑘 –  𝜀𝜀 
 
Τα μοντέλα k-ε ανήκουν στην κατηγορία των μοντέλων δύο εξισώσεων, δηλαδή εισάγουν στο σύστημα 
των εξισώσεων RANS δύο επιπλέον εξισώσεις μεταφοράς και κατ’ επέκταση δύο νέες μεταβλητές. Η 
πρώτη μεταβλητή είναι η τυρβώδης κινητική ενέργεια 𝑘𝑘, ενώ η δεύτερη η τυρβώδης διάχυση ή αλλιώς 
η καταστροφή της τυρβώδους κινητικής ενέργειας 𝜀𝜀. Πρόκειται για τα περισσότερο διαδεδομένα 
μοντέλα τύρβης και ενσωματώνονται στους περισσότερους εμπορικούς κώδικες CFD, οι εφαρμογές 
τους κυμαίνονται από βιομηχανικές μέχρι περιβαλλοντικές ροές. 

Στην κατηγορία των μοντέλων τύρβης k-ε ανήκουν τα μοντέλα Standard, RNG και Realizable. Οι 
εξισώσεις του Standard μοντέλου k-ε για ασυμπίεστο ρευστό, όπως παρουσιάστηκε από τον (Chien, 
1982)  είναι: 

𝜌𝜌
𝜕𝜕𝑘𝑘
𝜕𝜕𝜕𝜕

+ 𝜌𝜌𝑢𝑢𝑗𝑗
𝜕𝜕𝑘𝑘
𝜕𝜕𝑥𝑥𝑗𝑗

=
𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

��𝜇𝜇 +
𝜇𝜇𝑡𝑡
𝜎𝜎𝑘𝑘
�
𝜕𝜕𝑘𝑘
𝜕𝜕𝑥𝑥𝑗𝑗

� + 𝜏𝜏𝑖𝑖𝑖𝑖′
𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

− 𝜌𝜌𝜌𝜌 

𝜌𝜌
𝜕𝜕𝜀𝜀
𝜕𝜕𝜕𝜕

+ 𝜌𝜌𝑢𝑢𝑗𝑗
𝜕𝜕𝜀𝜀
𝜕𝜕𝑥𝑥𝑗𝑗

=
𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

��𝜇𝜇 +
𝜇𝜇𝑡𝑡
𝜎𝜎𝜀𝜀
�
𝜕𝜕𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

� + 𝐶𝐶1𝜀𝜀
𝜀𝜀
𝑘𝑘
𝜏𝜏𝑖𝑖𝑖𝑖′

𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

− 𝐶𝐶2𝜀𝜀𝜌𝜌
𝜀𝜀2

𝑘𝑘
 

όπου η τυρβώδης συνεκτικότητα 𝜇𝜇𝑡𝑡 δίνεται από τη σχέση Prandtl-Kolmogorov-Taylor: 

μ𝑡𝑡 =
𝜌𝜌𝐶𝐶𝜇𝜇𝑘𝑘2

𝜀𝜀
 

ενώ οι τιμές των συντελεστών των εξισώσεων έχουνε υπολογιστεί ημιεμπειρικά και είναι: 

𝐶𝐶𝜀𝜀1 = 1.44,      𝐶𝐶𝜀𝜀2 = 1.92,      𝐶𝐶𝜇𝜇 = 0.09,      𝜎𝜎𝑘𝑘 = 1.0,      𝜎𝜎𝜀𝜀 = 1.3 

Το μοντέλο Realizable ικανοποιεί ιδιαίτερους μαθηματικούς περιορισμούς για τις κανονικές τάσεις, οι 
οποίοι τίθενται σύμφωνα με τη φυσική των τυρβώδων ροών.  

Συνδέοντας τη σχέση του Boussinesq με τον ορισμό της συνεκτικότητας του στροβίλου μπορούμε να 
εξάγουμε τη σχέση για την κανονική τάση σε μια ασυμπίεστη και παραμορφώσιμη μέση ροή: 

𝑢𝑢𝚤𝚤𝑢𝑢𝚥𝚥����� =
2
3
𝑘𝑘𝛿𝛿𝑖𝑖𝑖𝑖 − 𝑣𝑣𝑡𝑡 �

𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

+
𝜕𝜕𝑢𝑢𝑗𝑗
𝜕𝜕𝑥𝑥𝑖𝑖

� 

Αντικαθιστώντας την παραπάνω εξίσωση στο μοντέλο Standard k-ε με 

𝑣𝑣𝑡𝑡 = 𝜇𝜇𝑡𝑡
𝜌𝜌

= 𝐶𝐶𝜇𝜇
𝑘𝑘2

𝜀𝜀
  

και 

 𝐶𝐶𝜇𝜇 = 0.09 

καταλήγουμε σε αρνητική τιμή για την κανονική τάση 𝑢𝑢𝚤𝚤𝑢𝑢𝚥𝚥�����, αποτέλεσμα που είναι άτοπο καθώς η 
κανονική τάση είναι θετική ποσότητα εξ’ ορισμού. Έτσι όταν η παραμόρφωση είναι αρκετά μεγάλη, για 
παράδειγμα, το μοντέλο είναι μη πραγματοποιήσιμο (non-realizable) καθώς δεν ικανοποιείται η σχέση: 
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𝑘𝑘
𝜀𝜀 �

𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

+
𝜕𝜕𝑢𝑢𝑗𝑗
𝜕𝜕𝑥𝑥𝑖𝑖

� >
1

3𝐶𝐶𝜇𝜇
≈ 3.7 

Παρομοίως, μπορεί να δειχθεί ότι όταν ο μέσος ρυθμός παραμόρφωσης είναι υψηλός τότε μπορεί να 
παραβιαστεί η ανισότητα του Schwarz (≤ 𝑢𝑢𝑎𝑎2𝑢𝑢𝛽𝛽2�������). Ο πιο άμεσος τρόπος για να είναι θετικές οι κανονικές 
τάσεις και να ισχύει η ανισότητα του Schwarz για τις επιφανειακές τάσεις (δηλαδή για να είναι το 
μοντέλο πραγματοποιήσιμο), είναι να γίνει η μεταβλητή 𝐶𝐶𝜇𝜇 ευαίσθητη στη μέση ροή και στην τύρβη. 
Προκειμένου να επιλυθεί αυτό το πρόβλημα έχει προταθεί από πολλούς ερευνητές η ιδέα του 
μεταβλητού 𝐶𝐶𝜇𝜇, η οποία είναι καλά τεκμηριωμένη από πειραματικά δεδομένα. Επίσης και στην 
εξίσωση που αφορά το ρυθμό καταστροφής της τυρβώδους κινητικής ενέργειας 𝜀𝜀 μπορεί να εντοπιστεί 
άλλη μία αδυναμία του μοντέλου Standard 𝑘𝑘 − 𝜀𝜀. 

Μοντέλο τύρβης 𝒌𝒌 –  𝜺𝜺 Realizable 

Με σκοπό την κάλυψη αυτών των ατελειών του Standard 𝑘𝑘 − 𝜀𝜀 μοντέλου οι (Shih, et al., 1994) 
πρότειναν το Realizable 𝑘𝑘 − 𝜀𝜀 μοντέλο το οποίο υιοθετεί τα ακόλουθα: 

• Έναν καινούριο τύπο για την τυρβώδη συνεκτικότητα, ο οποίος προτάθηκε από τον Reynolds, 
και θέτει το 𝐶𝐶𝜇𝜇 μεταβλητό. 

• Μια νέα εξίσωση για την καταστροφή της τυρβώδους κινητικής ενέργειας 𝜀𝜀, η οποία είναι 
βασισμένη στη δυναμική εξίσωση της μέσης τιμής των τετραγώνων της διακύμανσης της 
στροβιλότητας. 

Έτσι, οι νέες εξισώσεις είναι: 

𝜌𝜌
𝜕𝜕𝑘𝑘
𝜕𝜕𝜕𝜕

+ 𝜌𝜌𝑢𝑢𝑗𝑗
𝜕𝜕𝑘𝑘
𝜕𝜕𝑥𝑥𝑗𝑗

=
𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

��𝜇𝜇 +
𝜇𝜇𝑡𝑡
𝜎𝜎𝑘𝑘
�
𝜕𝜕𝑘𝑘
𝜕𝜕𝑥𝑥𝑗𝑗

� + 𝐺𝐺𝑘𝑘 + 𝐺𝐺𝑏𝑏 − 𝑌𝑌𝑀𝑀 + 𝑆𝑆𝑘𝑘 − 𝜌𝜌𝜌𝜌 

𝜌𝜌
𝜕𝜕𝜀𝜀
𝜕𝜕𝜕𝜕

+ 𝜌𝜌𝑢𝑢𝑗𝑗
𝜕𝜕𝜀𝜀
𝜕𝜕𝑥𝑥𝑗𝑗

=
𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

��𝜇𝜇 +
𝜇𝜇𝑡𝑡
𝜎𝜎𝜀𝜀
�
𝜕𝜕𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

� + 𝜌𝜌𝐶𝐶1𝑆𝑆𝜀𝜀 − 𝜌𝜌𝐶𝐶2
 𝜀𝜀2

𝑘𝑘 + √𝜈𝜈𝜈𝜈
+  𝐶𝐶1𝜀𝜀

𝜀𝜀
𝑘𝑘
𝐶𝐶3𝜀𝜀𝐺𝐺𝑏𝑏 + 𝑆𝑆𝜀𝜀 

όπου: 

𝐶𝐶1 = max �0.43,
𝑛𝑛

𝑛𝑛 + 5�
 

𝑛𝑛 = 𝑆𝑆
𝑘𝑘
𝜀𝜀

 

𝑆𝑆 = �2𝑆𝑆𝑖𝑖𝑖𝑖𝑆𝑆𝑖𝑖𝑖𝑖 

Ακόμα: 

• Ο όρος 𝐺𝐺𝑘𝑘 αναπαριστά τη εμφάνιση της τυρβώδους κινητικής ενέργειας λόγω των μεταβολών 
της μέσης ταχύτητας. 

• Ο όρος 𝐺𝐺𝑏𝑏 αναπαριστά τη γένεση της τυρβώδους κινητικής ενέργειας λόγω της άνωσης. 
• Ο όρος 𝑌𝑌𝛭𝛭 αναπαριστά τη συνεισφορά της διακυμαινόμενης διαστολής στη συμπιεστή τύρβη 

ως προς το συνολικό ρυθμό σκέδασης. 
• Οι όροι 𝐶𝐶1𝜀𝜀,𝐶𝐶3𝜀𝜀 και 𝐶𝐶2 είναι σταθερές. 
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• Οι ποσότητες 𝜎𝜎𝜀𝜀 και 𝜎𝜎𝑘𝑘 είναι αριθμοί του Prandtl για την τύρβη για τα ε και k αντίστοιχα. 
• Οι όροι 𝑆𝑆𝜀𝜀 και 𝑆𝑆𝑘𝑘 ορίζονται από τον χρήστη. 

Στο μοντέλο Realizable 𝑘𝑘 − 𝜀𝜀 ο τρόπος υπολογισμού της τυρβώδης συνεκτικότητας είναι σχεδόν ο 
ίδιος με αυτόν των άλλων μοντέλων 𝑘𝑘 − 𝜀𝜀: 

𝜇𝜇𝑡𝑡 = 𝜌𝜌𝐶𝐶𝜇𝜇
𝑘𝑘2

𝜀𝜀
 

με την μόνη διαφορά να εντοπίζεται στον όρο 𝐶𝐶𝐶𝐶 , ο οποίος δεν είναι πλέον σταθερά αλλά 
υπολογίζεται από τη σχέση: 

𝐶𝐶𝜇𝜇 =
1

𝛢𝛢0 + 𝛢𝛢𝑠𝑠
𝑘𝑘𝑈𝑈∗

𝜀𝜀
 

όπου: 

𝐴𝐴0 = 4.04 

𝐴𝐴𝑆𝑆 = √6 𝑐𝑐𝑐𝑐𝑐𝑐𝜑𝜑 

𝑈𝑈∗ = �𝑆𝑆𝑖𝑖𝑖𝑖𝑆𝑆𝑖𝑖𝑖𝑖 + 𝛺𝛺𝚤𝚤𝚤𝚤�𝛺𝛺𝚤𝚤𝚤𝚤�  

με: 

𝛺𝛺𝚤𝚤𝚤𝚤� = 𝛺𝛺𝑖𝑖𝑖𝑖 − 2𝜀𝜀𝑖𝑖𝑖𝑖𝑖𝑖𝜔𝜔𝑘𝑘 

𝛺𝛺𝑖𝑖𝑖𝑖 = 𝛺𝛺𝚤𝚤𝚤𝚤���� − 𝜀𝜀𝑖𝑖𝑖𝑖𝑖𝑖𝜔𝜔𝑘𝑘 

𝜑𝜑 =
1
3

cos−1(√6𝑊𝑊) 

𝑊𝑊 =
𝑆𝑆𝑖𝑖𝑖𝑖𝑆𝑆𝑗𝑗𝑗𝑗𝑆𝑆𝑘𝑘𝑘𝑘

𝑆𝑆3�
 

𝑆̃𝑆 = �𝑆𝑆𝑖𝑖𝑖𝑖𝑆𝑆𝑖𝑖𝑖𝑖  

𝑆𝑆𝑖𝑖𝑖𝑖 =
1
2�

𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

+
𝜕𝜕𝑢𝑢𝑗𝑗
𝜕𝜕𝑥𝑥𝑖𝑖

� 

Ο όρος 𝛺𝛺𝚤𝚤𝚤𝚤���� αποτελεί τον τανυστή για το μέσο ρυθμό περιστροφής, ο οποίος παρατηρείται από ένα 
σημείο αναφοράς που περιστρέφεται με γωνιακή ταχύτητα 𝜔𝜔𝑘𝑘. 

Η μέση παραμόρφωση και ο μέσος ρυθμός περιστροφής, της γωνιακής ταχύτητας του 
περιστρεφόμενου συστήματος και οι παράμετροι της τύρβης (δηλαδή τα k και ε) είναι οι παράγοντες 
από τους οποίους εξαρτάται η τιμή του 𝐶𝐶𝜇𝜇. 

Ο όρος 2𝜀𝜀𝑖𝑖𝑖𝑖𝑖𝑖𝜔𝜔𝑘𝑘 είναι ένας πρόσθετος όρος που αφορά την περιστροφή και δεν είναι συμβατός με τις 
υποθέσεις που έχουν να κάνουν με πολλαπλά πλαίσια αναφοράς (Multiple Reference Frames) ή με 
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πλέγματα που κινούνται. Επίσης δεν περιλαμβάνεται στο Fluent από επιλογή του κατασκευαστή του 
κώδικα.  

Οι σταθερές του μοντέλου Realizable k-ε είναι: 

𝐶𝐶1𝜀𝜀 = 1.44,      𝐶𝐶2 = 1.9,      𝐶𝐶𝜇𝜇 = 0.09,      𝜎𝜎𝑘𝑘 = 1.0,      𝜎𝜎𝜀𝜀 = 1.2 

To realizable k-ε μοντέλο προσφέρει ανώτερες επιδόσεις για ροές που περιλαμβάνουν περιστροφή, 
οριακά στρώματα που υπόκεινται σε υψηλές αντίρροπες κλίσεις πίεσης, αποκόλληση της ροής και 
ανακυκλοφορία. Τα μειονεκτήματα του μοντέλου k−ε είναι ότι παράγει αφύσικες τιμές για την 
τυρβώδη συνεκτικότητα σε περιπτώσεις που το υπολογιστικό χωρίο περιέχει περιστρεφόμενες και 
ακίνητες ζώνες ρευστού όπως για παράδειγμα στη χρήση πολλαπλών πλαισίων αναφοράς (Multiple 
Reference Frames) ή περιστρεφόμενων ολισθαίνοντων πλεγμάτων (rotating sliding meshes). 
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2.4.2 Μοντέλα τύρβης 𝑘𝑘 –  𝜔𝜔 
 
Τα μοντέλα τύρβης k −𝜔𝜔 είναι και αυτά μοντέλα δύο εξισώσεων, δηλαδή εισάγονται δύο επιπλέον 
διαφορικές εξισώσεις για τον υπολογισμό των μεταβλητών της τύρβης. Οι μεταβλητές αυτές είναι η 
τυρβώδης κινητική ενέργεια 𝑘𝑘 (turbulent kinetic energy), η οποία εκφράζει την ενέργεια της τύρβης, και 
ο ειδικός ρυθμός καταστροφής της τύρβης ή ειδική διάχυση της τύρβης 𝜔𝜔 (turbulent specific dissipation 
rate), που εκφράζει την κλίμακα της τύρβης. Οι εξισώσεις που διέπουν το μοντέλο 𝑘𝑘 –  𝜔𝜔 για 
ασυμπίεστο ρευστό είναι, κατά Wilcox οι εξής: 

𝜌𝜌
𝜕𝜕𝑘𝑘
𝜕𝜕𝜕𝜕

+ 𝜌𝜌𝑢𝑢𝑗𝑗
𝜕𝜕𝑘𝑘
𝜕𝜕𝑥𝑥𝑗𝑗

=
𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

��𝜇𝜇 +
𝜇𝜇𝑡𝑡
𝜎𝜎𝑘𝑘
�
𝜕𝜕𝑘𝑘
𝜕𝜕𝑥𝑥𝑗𝑗

� + 𝜏𝜏𝑖𝑖𝑖𝑖′
𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

− 𝛽𝛽∗𝜌𝜌𝑘𝑘𝜔𝜔 

𝜌𝜌
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+ 𝜌𝜌𝑢𝑢𝑗𝑗
𝜕𝜕𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

=
𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

��𝜇𝜇 +
𝜇𝜇𝑡𝑡
𝜎𝜎𝜔𝜔
�
𝜕𝜕𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

� + 𝛼𝛼
𝜔𝜔
𝑘𝑘
𝜏𝜏𝑖𝑖𝑖𝑖′

𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

− 𝛽𝛽𝛽𝛽𝜔𝜔2 

όπου η τυρβώδης συνεκτικότητα μ𝑡𝑡 δίνεται από τη σχέση 

𝜇𝜇𝑡𝑡 =
𝜌𝜌𝑘𝑘
𝜔𝜔

 

Ενώ για τις τιμές των συντελεστών: 

𝑎𝑎 = 5
9
,     𝛽𝛽 = 3

40
,     𝛽𝛽∗ = 9

100
,     𝜎𝜎𝑘𝑘 = 1

2
,     𝜎𝜎𝜔𝜔 = 1

2
 

 
Μοντέλο τύρβης 𝒌𝒌 –  𝝎𝝎 Shear-Stress Transport (SST) 

Τα δύο μοντέλα που παρουσιάστηκαν νωρίτερα έχουν διαφορετικά πλεονεκτήματα και μειονεκτήματα. 
Το μοντέλο 𝑘𝑘 − 𝜔𝜔 είναι πιο στιβαρό και ακριβές στις περιοχές κοντά σε τοίχο και είναι επιρρεπές στην 
εμφάνιση ανακυκλοφορίας. Από την άλλη το μοντέλο 𝑘𝑘 − 𝜀𝜀 αποδίδει καλύτερα στην περιοχή της 
ελεύθερης ροής όμως εμφανίζει αδυναμίες στα τοιχώματα καθώς και στην περίπτωση ύπαρξης 
περιστρεφόμενων και κινούμενων πλεγμάτων. Η τελευταία αδυναμία φάνηκε και στην περίπτωση της 
παρούσας εργασίας, όπως θα αναλυθεί στη συνέχεια. 
Το μοντέλο τύρβης k – ω SST αναπτύχθηκε από τον (Menter, 1994) και αποτελεί μια μείξη των 
μοντέλων 𝑘𝑘 − 𝜀𝜀 και 𝑘𝑘 − 𝜔𝜔 με τέτοιο τρόπο ώστε να εκμεταλλεύεται τα πλεονεκτήματα και των δύο.  
Είναι παρόμοιο με το κλασικό μοντέλο 𝑘𝑘 − 𝜔𝜔 μοντέλο αφού εισάγονται οι ίδιες νέες μεταβλητές  𝑘𝑘 και 
𝜔𝜔, με τη διαφορά ότι περιλαμβάνει και έναν μετασχηματισμό του μοντέλου 𝑘𝑘 − 𝜀𝜀. Οι δύο εξισώσεις 
του μοντέλου πολλαπλασιάζονται με έναν συντελεστή ο οποίος ανάλογα με την απόσταση από τον 
κοντινότερο τοίχο ενεργοποιεί τους κατάλληλους όρους. Οι εξισώσεις του μοντέλου 𝑘𝑘 − 𝜔𝜔 SST για 
ασυμπίεστο ρευστό είναι: 

𝜌𝜌
𝜕𝜕𝑘𝑘
𝜕𝜕𝜕𝜕

+ 𝜌𝜌𝑢𝑢𝑗𝑗
𝜕𝜕𝑘𝑘
𝜕𝜕𝑥𝑥𝑗𝑗

=
𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

�(𝜇𝜇 + 𝜎𝜎𝑘𝑘𝜇𝜇𝑡𝑡)
𝜕𝜕𝑘𝑘
𝜕𝜕𝑥𝑥𝑗𝑗

� + 𝜏𝜏𝑖𝑖𝑖𝑖′
𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

− 𝛽𝛽∗𝜌𝜌𝑘𝑘𝜔𝜔 

𝜌𝜌
𝜕𝜕𝜕𝜕
𝜕𝜕𝜕𝜕

+ 𝜌𝜌𝑢𝑢𝑗𝑗
𝜕𝜕𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

=
𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

�(𝜇𝜇 + 𝜎𝜎𝜔𝜔𝜇𝜇𝑡𝑡)
𝜕𝜕𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

� + 𝜌𝜌
𝛾𝛾
𝜇𝜇𝑡𝑡
𝜏𝜏𝑖𝑖𝑖𝑖′

𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

− 𝛽𝛽𝛽𝛽𝜔𝜔2 + 
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+2(1− 𝐹𝐹1)
𝜌𝜌𝜎𝜎𝜔𝜔2
𝜔𝜔

𝜕𝜕𝑘𝑘
𝜕𝜕𝑥𝑥𝑗𝑗

𝜕𝜕𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗

 

όπου η τυρβώδης συνεκτικότητα 𝜇𝜇𝑡𝑡 δίνεται από τη σχέση: 

𝜇𝜇𝑡𝑡 =
𝜌𝜌𝛼𝛼1𝑘𝑘

max (𝛼𝛼1𝜔𝜔,𝛺𝛺𝐹𝐹2)
 

όπου 𝛺𝛺 η απόλυτη τιμή του τανυστή του ρυθμού στροβιλότητας (vorticity tensor). 

𝛺𝛺 = �2𝑊𝑊𝑖𝑖𝑖𝑖𝑊𝑊𝑗𝑗𝑗𝑗 και 𝑊𝑊𝑖𝑖𝑖𝑖 = 1
2
�𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

− 𝜕𝜕𝑢𝑢𝑗𝑗
𝜕𝜕𝑥𝑥𝑖𝑖
� 

Οι όροι F1, 𝐹𝐹2 είναι συναρτήσεις ανάμειξης που μπορούν να πάρουν οποιαδήποτε τιμή μεταξύ μηδέν 
και ένα.  
Σχετικά με τον όρο 𝐹𝐹1, για την τιμή μηδέν ο επιπλέον όρος στην εξίσωση ειδικής διάχυσης της τύρβης 𝜔𝜔 
υπάρχει και η συγκεκριμένη εξίσωση είναι ίδια με του 𝑘𝑘 − 𝜀𝜀 μοντέλου. Για την τιμή ένα ο επιπλέον 
όρος εξαφανίζεται και η εξίσωση είναι ίδια με το standard k −𝜔𝜔 μοντέλο.  
Ο όρος 𝐹𝐹2 είναι μεγαλύτερος καθώς η απόσταση από το πλησιέστερο τοίχωμα ελαττώνεται. Καθώς 
μεγαλώνει ο όρος είναι πιθανότερο να περιορίζει τη δυναμική συνεκτικότητα (περιοριστής). 
O όρος ανάμειξης 𝐹𝐹1 συναντάται και στον προσδιορισμό των σταθερών του μοντέλου. Οι σταθερές των 
εξισώσεων είναι συνδυασμός μιας εσωτερικής σταθεράς 𝜑𝜑1 και μιας εξωτερικής σταθεράς φ2. Ο όρος 
φ1 αντιπροσωπεύει τις σταθερές του μοντέλου k −𝜔𝜔 και ο όρος 𝜑𝜑2 τις σταθερές του μοντέλου 𝑘𝑘 − 𝜀𝜀. 
Οι σταθερές υπολογίζονται από την ακόλουθη σχέση: 

𝜑𝜑 = 𝐹𝐹1𝜑𝜑1 + (1 − 𝐹𝐹1)𝜑𝜑2 

Οι περιορισμοί του πρώτου σετ (𝜑𝜑1) είναι: 

𝜎𝜎𝜅𝜅1 = 0.85,     𝜎𝜎𝜔𝜔1 = 0.5,     𝛽𝛽1 = 0.0750,     𝛼𝛼1 = 0.31,     𝛽𝛽∗ = 0.09,     𝜅𝜅 = 0.41,     𝛾𝛾1 = 𝛽𝛽1
𝛽𝛽∗
− 𝜎𝜎𝜔𝜔1𝜅𝜅2

�𝛽𝛽∗
 

Οι περιορισμοί του δεύτερου σετ (𝜑𝜑2) είναι: 

𝜎𝜎𝜅𝜅2 = 1.0,     𝜎𝜎𝜔𝜔2 = 0.856,     𝛽𝛽2 = 0.0828,     𝛽𝛽∗ = 0.09,     𝜅𝜅 = 0.41,     𝛾𝛾2 = 𝛽𝛽2
𝛽𝛽∗
− 𝜎𝜎𝜔𝜔2𝜅𝜅2

�𝛽𝛽∗
 

Ακόμα ισχύουν οι διευκρινήσεις: 

𝜏𝜏𝑖𝑖𝑖𝑖 = 𝜇𝜇𝑡𝑡 �
𝜕𝜕𝑢𝑢𝑖𝑖
𝜕𝜕𝑥𝑥𝑗𝑗

+
𝜕𝜕𝑢𝑢𝑗𝑗
𝜕𝜕𝑥𝑥𝑖𝑖

−
2
3
𝜕𝜕𝑢𝑢𝑘𝑘
𝜕𝜕𝑥𝑥𝑘𝑘

𝛿𝛿𝑖𝑖𝑖𝑖� −
2
3
𝜌𝜌𝑘𝑘𝛿𝛿𝑖𝑖𝑖𝑖  

F1 = tanh(𝑎𝑎𝑎𝑎𝑎𝑎14) 

arg1 = min ��max�
√𝑘𝑘

0.09𝜔𝜔𝑦𝑦
;
500𝑣𝑣
𝑦𝑦2𝜔𝜔 � ;

4𝜌𝜌𝜎𝜎𝜔𝜔2𝑘𝑘
𝐶𝐶𝐷𝐷𝑘𝑘𝜔𝜔𝑦𝑦2

�� 

Όπου 𝑦𝑦 είναι η απόσταση από τον πλησιέστερο τοίχο και 𝐶𝐶𝐷𝐷𝑘𝑘𝑘𝑘 το θετικό τμήμα της εξίσωσης, δηλαδή: 

𝐶𝐶𝐷𝐷𝑘𝑘𝑘𝑘 = 2
𝜌𝜌𝜎𝜎𝜔𝜔2
𝜔𝜔

𝜕𝜕𝑘𝑘
𝜕𝜕𝑥𝑥𝑗𝑗

𝜕𝜕𝜕𝜕
𝜕𝜕𝑥𝑥𝑗𝑗
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Προφανώς ο όρος 𝑎𝑎𝑎𝑎𝑎𝑎1 τείνει στο μηδέν για πολύ μακρινά τοιχώματα εξαιτίας της εξάρτησης από τα 
1/𝑦𝑦 ή 1/𝑦𝑦2 σε καθένα από τους τρεις όρους (Menter, 1994). Σε ένα οριακό στρώμα οι τρεις όροι έχουν 
τον εξής σκοπό: ο πρώτος όρος είναι η τυρβώδης κλίμακα μήκους διαιρεμένη με το y. Ισούται με 2.5  
στο λογαριθμικό στρώμα και τείνει στο μηδέν πλησιάζοντας την ακμή του οριακού στρώματος. Ο 
δεύτερος όρος εξασφαλίζει ότι το 𝐹𝐹1 είναι ίσο με 1 στο υπόστρωμα αφού το 𝜔𝜔 συμπεριφέρεται όπως 
το 1/𝑦𝑦2 κοντά στα τοιχώματα και είναι ανάλογο του 1/𝑦𝑦 στη λογαριθμική περιοχή, έτσι ώστε το 
1/(𝜔𝜔𝑦𝑦2) να είναι σταθερά κοντά στα τοιχώματα και να τείνει στο μηδέν στη λογαριθμική περιοχή. Ο 
τρίτος όρος είναι μια επιπλέον ασφαλιστική δικλείδα έναντι επίλυσης εξαρτώμενης από την ελεύθερη 
ροή. Ο όρος αυτός εξασφαλίζει ότι ο όρος 𝑎𝑎𝑎𝑎𝑎𝑎1 τείνει στο μηδέν κοντά στην ακμή του οριακού 
στρώματος στο ενδεχόμενο προσέγγισης της εκφυλιστικής λύσης ελεύθερης ροής. Καθώς το 𝑎𝑎𝑎𝑎𝑎𝑎1 
πλησιάζει το  μηδέν το ίδιο κάνει και το 𝐹𝐹1 και τελικά το standard 𝑘𝑘 − 𝜀𝜀 μοντέλο χρησιμοποιείται σε 
αυτή την περιοχή. 

Ακόμα: 

𝐹𝐹2 = tanh (𝑎𝑎𝑎𝑎𝑎𝑎22) 

𝑎𝑎𝑎𝑎𝑎𝑎2 = max�2
√𝑘𝑘

0.09𝜔𝜔𝑦𝑦
;
500𝑣𝑣
𝑦𝑦2𝜔𝜔 � 
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2.5 Η τεχνική overset 
 
Μεταξύ άλλων εμπορικών λογισμικών, και το Ansys Fluent, παρέχει τη δυνατότητα σχεδιασμού του 
υπολογιστικού χωρίου από αλληλοκαλυπτόμενα πλέγματα, η τεχνική αυτή ονομάζεται chimera ή 
overset. Η τεχνική αυτή δίνει μια ακόμα επιλογή διαμόρφωσης του τελικού πλέγματος, 
συμπληρώνοντας τις τεχνικής conformal, non-conformal και structured (mapped), unstructured 
πλέγματος. (ANSYS, Inc., 2011) 

Σε μια διεπαφή overset (overset interface) τα διάφορα πλέγματα συνδέονται με παρεμβολή της 
πληροφορίας των αλληλοκαλυπτόμενων κελιών. Ως εκ τούτου για την αποτελεσματική εφαρμογή της 
τεχνικής θα πρέπει να υπάρχει επαρκής αλληλοεπικάλυψη που ορίζεται στα 4-6 κελιά. Επιπλέον, τα 
διάφορα πλέγματα θα πρέπει να έχουν παραπλήσια μεγέθη στοιχείων, εάν τα μεγέθη των στοιχείων 
διαφέρουν σημαντικά, επηρεάζεται η παρεμβολή των δεδομένων των στοιχείων και η ποιότητα της 
λύσης. Οι περιορισμοί αυτοί είναι πολύ απλοί και δίνουν μεγάλη ελευθερία στο χρήστη σε σχέση με τις 
υπάρχουσες τεχνικές. Ακόμα η διαφοροποίηση του πλέγματος για παραμετρικές μελέτες είναι πολύ 
εύκολη αφου αρκεί η διαφοροποίηση ή αντικατάσταση του επιθυμητού μέρους του πλέγματος, 
αποφεύγοντας έτσι τη διαδικασία remeshing μεγάλων τμημάτων ή ολόκληρου του πλέγματος. Κάθε 
overset πλέγμα αποτελείται από τουλάχιστον ένα background πλέγμα και τουλάχιστον ένα component 
πλέγμα ή κανένα background πλέγμα και τουλάχιστον δύο component πλέγματα: 

• τα background πλέγματα δεν μπορούν να αλληλοεπιδρούν μεταξύ τους (δεν έχουν overset 
συνοριακές συνθήκες) και πρέπει να έχουν conformal σύνδεση μεταξύ τους 

• τα component πλέγματα έχουν overset συνοριακές συνθήκες υποχρεωτικό και μπορούν να 
αλληλοεπιδρούν με τα background πλέγματα αλλά και μεταξύ τους. 

Στην παρούσα εργασία χρησιμοποιήθηκε μία overset διάταξη αποτελούμενη από ένα background 
πλέγμα του κελύφους του υδροστροβίλου και τα 2 component πλέγματα, του ψαριού-αντικειμένου και 
του δρομέα. Στο Σχήμα 2.7 φαίνεται το component πλέγμα του ψαριού-αντικειμένου πάνω στο 
background πλέγμα του κελύφους. 

 

Σχήμα 2.7: Background και overset πλέγματα όπως χρησιμοποιήθηκαν στην παρούσα εργασία. 
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Υπάρχει, ωστόσο, ο περιορισμός ότι οι ζώνες φυσικών οριακών συνθηκών (τοίχωμα, είσοδος, έξοδος, 
συμμετρία κλπ.) δεν επιτρέπεται να διασταυρώνονται μεταξύ τους. Επιτρέπεται όμως να ταυτίζονται, 
δίνοντας έτσι τη δυνατότητα εύκολης παραμετροποίησης ενός component πλέγματος με την πρόσθεση 
ενός επιπλέον component αντί για τον επανασχεδιασμό ολόκληρου του κομματιού.  
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2.5.1 Συνδεσμολογία overset 
 
Κατά την αρχικοποίηση μιας διεπαφής overset το Fluent ακολουθεί τρία βήματα για τον προσδιορισμό 
της συνδεσμολογίας μεταξύ background και component πλεγμάτων: 

• Δημιουργία οπών 
• Ελαχιστοποίηση αλληλοεπικάλυψης  
• Αναζήτηση δοτών  

Η δημιουργία της παραπάνω συνδεσμολογίας  έχει τις βάσεις της στους πέντε διαφορετικούς τύπους 
κελιών που μπορούν να κατηγοριοποιηθούν τα κελιά ενός πλέγματος-μέλος μια διεπαφής overset: 

• Κελιά επίλυσης (solve cells) – κελιά τα οποία συμμετέχουν στην επίλυση 
• Κελιά δότες (donor cells) – κελιά τα οποία δίνουν την πληροφορία σε κελιά δέκτες άλλου 

πλέγματος 
• Κελιά δέκτες  (receptor cells) – κελιά τα οποία λαμβάνουν την πληροφορία από κελιά δότες 

άλλου πλέγματος 
• Νεκρά κελιά (dead cells) – απενεργοποιημένα κελιά που βρίσκονται στην περιοχή 

αλληλοεπικάλυψης background πλέγματος με component πλέγμα όπου πολλαπλά κελιά 
βρίσκονται στην ίδια περιοχή. Μόνο τε κελιά ενός πλέγματος σε μία περιοχή μπορούν να 
πάρουν μέρος στην επίλυση. Επιπλέον κελιά εκτός του πεδίου ροής λαμβάνονται ως νεκρά. 

• Ορφανά κελιά (orphan cells) – πρόκειται για κελιά δέκτες που δεν έχουν βρει ένα κελί δότη. Το 
Fluent διαθέτει αλγορίθμους που αντιμετωπίζουν την εμφάνιση αυτών των κελιών, ωστόσο η 
δημιουργία τους θα πρέπει να αποφεύγεται καθώς δημιουργούν ανακριβείς λύσεις και 
αποκλίσεις. Το πρόβλημα λύνεται κυρίως επιλέγοντας ίδιο μέγεθος στοιχείου για τα πλέγματα 
που συμμετέχουν στη διεπαφή overset.  

Οι συγκεκριμένοι τύπου κελιών αποτυπώνονται και με αντίστοιχες τιμές και χρώματα στα contours που 
θα ακολουθήσουν, όπως φαίνεται στον Πίνακας 2.1. 

Τύπος κελιού Ακέραια τιμή Χρώμα contour 
Δότης 2 κόκκινο 

Επιλύτης 1 πράσινο 
Δέκτης 0 μπλε 

Ορφανό -1 δεν αντιστοιχεί 
Νεκρό -2 λευκό 

Πίνακας 2.1: Χρωματική και αριθμητική αντιστοιχία σε διαγράμματα ισοκαμπύλων των κελιών που συμμετέχουν σε 
συνδεσμολογίες overset. (ANSYS, Inc., 2011)  
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2.5.2 Δημιουργία οπών 
 

Δημιουργία οπών ονομάζεται η διαδικασία κατά την οποία τα κελιά που δε βρίσκονται στο πεδίο της 
ροής (δηλαδή το εσωτερικό σωμάτων) χαρακτηρίζονται ως νεκρά κελιά. Το τελικό αποτέλεσμα είναι 
ένα αποδεκτό overset πλέγμα με μέγιστη, όμως, αλληλοεπικάλυψη κελιών. Στα Σχήμα 2.8 και Σχήμα 2.9 
που ακολουθούν φαίνεται η διαδικασία της δημιουργίας οπών στις περιοχές των δύο component 
πλεγμάτων του προβλήματος. 

  
Σχήμα 2.8: Πριν και μετά τη δημιουργία οπής στην περιοχή ψαριού-αντικειμένου. 

  
Σχήμα 2.9: Πριν και μετά τη δημιουργία οπών στην περιοχή του δρομέα. 

Υπερβολική αλληλοεπικάλυψη μεταξύ background και component πλέγματος είναι υπολογιστικά 
καταχρηστική αφού οι εξισώσεις ροής λύνονται σε περισσότερα κελιά από ότι είναι απαραίτητο. 
Ταυτόχρονα όμως θα πρέπει να πληρείται το κριτήριο αλληλοεπικάλυψης 4-6 κελιών. 

Ελαχιστοποίηση αλληλοεπικάλυψης  

Η ελαχιστοποίηση αλληλοεπικάλυψης (overlap minimization) χρησιμοποιείται για την ελαχιστοποίηση 
της επικάλυψης μεταξύ διαφορετικών πλεγμάτων component και background μετατρέποντας επιπλέον 
κελιά επίλυσης σε κελιά δέκτες και μεταβάλλοντας περιττά κελιά δέκτες σε νεκρά κελιά. Κατά τη 
διάρκειας της διαδικασίας, ένα κελί επίλυσης μετατρέπεται σε κελί δέκτη εάν μπορεί να βρει 
κατάλληλο κελί δότη με υψηλή προτεραιότητα. Είναι προκαθορισμένο τα μικρότερα κελιά να έχουν 
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υψηλότερη προτεραιότητα δότη. Έτσι σε περιοχές αλλοεπικάλυψης, εάν ο χρήστης δεν ορίσει 
διαφορετικά, ο επιλύτης χρησιμοποιεί το τοπικά πυκνότερο πλέγμα για την εύρεση της λύσης. Η 
προκύπτουσα διεπαφή overset μετακινείται σε μία περιοχή όπου τα πλέγματα είναι περισσότερο 
συγκρίσιμα, με αποτέλεσμα καλύτερη ποιότητα της λύσης. 

Πρέπει να σημειωθεί ότι η ελαχιστοποίηση αλληλοεπικάλυψης δεν στοχεύει κυριολεκτικά στην 
ελαχιστοποίηση της αλληλοεπικάλυψης μεταξύ δύο πλεγμάτων. Βασίζεται στο flood filling των κελιών 
δεκτών οπουδήποτε μπορούν να βρεθούν κατάλληλα κελιά επίλυσης υψηλότερης προτεραιότητας. 
Οπότε, η προκύπτουσα αλληλοεπικάλυψη του πλέγματος βασίζεται στην τοπική προτεραιότητα δοτών.  

Στη δικιά μας περίπτωση χρησιμοποιώντας την προκαθορισμένη επιλογή χωρίς ελαχιστοποίηση 
αλληλοεπικάλυψης τα κελιά δότες-δέκτες διαμορφώνονται όπως φαίνεται στο Σχήμα 2.10 για τα δύο 
component πλέγματα. 

 
 

Σχήμα 2.10: Δημιουργία οπών με τις προεπιλεγμένες ρυθμίσεις. 

Βλέποντας τις θέσεις των κελιών δοτών (κόκκινα) και δεκτών (μπλε) αντιλαμβανόμαστε ότι το 
αποτέλεσμα δεν είναι σωστό αφού δεν έχουμε κατανομή των συγκεκριμένων κελιών στα όρια των 
πλεγμάτων. Η δημιουργία των οπών είναι σωστή, όχι όμως και η επιλογή των κελιών δοτών. Στη 
συνέχεια, ενεργοποιώντας την ελαχιστοποίηση αλληλοεπικάλυψης έχοντας ίση προτεραιότητα 
πλέγματος (μηδέν) για όλα τα component πλέγματα γίνονται όπως φαίνεται στο σχήμα Σχήμα 2.11. 

  
Σχήμα 2.11: Δημιουργία οπών με τις προεπιλεγμένες ρυθμίσεις και ελαχιστοποίηση αλληλοεπικάλυψης. 
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Εξετάζοντας το δρομέα είναι φανερό εκ πρώτης όψεως ότι το αποτέλεσμα της ελαχιστοποίησης 
αλληλοεπικάλυψης δεν είναι σωστό. Συγκεκριμένα ο επιλύτης δεν αντιλαμβάνεται πλέον σωστά που 
υπάρχουν στερεά σώματα (νεκρά κελιά) και που όχι, σε κάποιο βαθμό έχει επηρεαστεί και το πλέγμα 
του ψαριού αντικειμένου. Τα παραπάνω μπορούν να αποτυπωθούν καλύτερα στο background πλέγμα, 
όπως φαίνεται στο Σχήμα 2.12. Συγκεκριμένα γίνεται αντιληπτό ότι υπάρχει τεράστια 
αλληλοεπικάλυψη μεταξύ των πλεγμάτων ενώ παράλληλα δεν έχουν διαμορφωθεί σωστά οι οπές. 

  
Σχήμα 2.12: Δημιουργία οπών με τις προεπιλεγμένες ρυθμίσεις και ελαχιστοποίηση αλληλοεπικάλυψης, background πλέγμα. 

Στη συνέχεια διατηρούμε την προτεραιότητα πλέγματος (grid priority) για το πίσω πλέγμα σε μηδέν και 
μεταβάλλουμε την τιμή για το δρομέα και το ψάρι-αντικείμενο σε ένα και δύο αντίστοιχα. Στο Σχήμα 
2.13 φαίνεται το αποτέλεσμα στα component πλέγματα.  

  
Σχήμα 2.13: Δημιουργία οπών με ελαχιστοποίηση αλληλοεπικάλυψης και προτεραιότητες πλέγματος 0 για background,1 για 

δρομέα, 2 για ψάρι-αντικείμενο. 

Πράγματι και στο background πλέγμα, όπως φαίνεται στο Σχήμα 2.14, παρατηρούμε, βάσει και του 
χρωματισμού, πως τα κελιά-δότες στο component πλέγματα του δρομέα και του αντικειμένου 
ταιριάζουν με τα αντίστοιχα κελιά-δέκτες στα component πλέγματα ενώ η αλληλοεπικάλυψη των 
πλεγμάτων είναι μικρή. 
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Σχήμα 2.14: Background πλέγμα. Δημιουργία οπών με ελαχιστοποίηση αλληλοεπικάλυψης και προτεραιότητες πλέγματος 0 για 

background,1 για δρομέα, 2 για ψάρι-αντικείμενο. 

Το ίδιο αποτέλεσμα θα μπορούσε να επιτευχθεί θέτοντας ίση με ένα την προτεραιότητα πλέγματος 
τόσο για το δρομέα όσο και για το αντικείμενο. Ωστόσο, κατά την εξέλιξη της πορείας του αντικειμένου 
και όταν αυτό θα εισαγόταν στο υπολογιστικό χωρίο του δρομέα θα παρουσιαζόντουσαν προβλήματα 
ανάλογα με αυτά που υπήρχαν όταν η προτεραιότητα πλέγματος ήταν μηδέν για όλα τα πλέγματα. 
Τα πλέγματα με υψηλότερο δείκτη προτεραιότητα ευνοούνται κατά τη διαδικασία της  
ελαχιστοποίησης αλληλοεπικάλυψης, ανεξαρτήτως της τοπικής προτεραιότητας δότη. Εάν δύο ζώνες 
έχουν την ίδια προτεραιότητα πλέγματος τότε χρησιμοποιείται η προτεραιότητα δότη για την 
ελαχιστοποίηση αλληλοεπικάλυψης. Χρησιμοποιώντας την προτεραιότητα πλέγματος μπορούμε να 
διορθώσουμε ανώμαλες κατανομές του πλέγματος όπως στην προκειμένη περίπτωση. 

Τέλος, το πρόβλημα μπορεί να διορθωθεί και χωρίς να παρέμβουμε στην προτεραιότητα πλέγματος. 
Αυτό μπορεί αν γίνει αλλάζοντας τη μέθοδο προτεραιότητας δότη (donor priority method). Η 
συγκεκριμένη επιλογή έχει σημασία όταν έχουμε ζώνες κελιών ίδιας προτεραιότητας (ίδιο grid priority). 
Υπάρχουν δύο μέθοδοι: η μέθοδος όγκου των κελιών (αναλογικά με την αντίστροφη τιμή του όγκου 
του εκάστοτε κελιού) και η μέθοδος απόστασης συνόρου (αναλογικά με την αντίστροφη τιμή της 
ελάχιστης απόστασης από το κοντινότερο σύνορο). Η μέθοδος όγκου των κελιών είναι η προεπιλεγμένη 
μέθοδος. 

Η μέθοδος του όγκου των κελιών λειτουργεί καλύτερα εάν η πύκνωση του component πλέγματος είναι 
υψηλή κοντά σε τοιχώματα και αραιώνει βαθμιαία καταλήγοντας ίση ή αραιότερη από την πύκνωση 
του background πλέγματος. 
Η μέθοδος απόσταση συνόρου λειτουργεί καλύτερα όταν τα πλέγματα component και background 
είναι έχουν ίσες ή παραπλήσιες πυκνώσεις και είναι καταλληλότερο όταν το πρόβλημα περιλαμβάνει 
τοιχώματα που είναι ή είναι πιθανό να έρθουν κοντά μεταξύ τους. Η εξεταζόμενη περίπτωση εμπίπτει 
στη συγκεκριμένη κατηγορία εφόσον αναμένουμε το ψάρι-αντικείμενο να έχει συγκρούσεις με τα 
πτερύγια του δρομέα ή το κέλυφος του υδροστροβίλου. Υπενθυμίζεται ότι είναι σημαντικό να υπάρχει 
ικανός αριθμός αλληλεπικαλυπτόμενων κελιών στο κενό μεταξύ δύο τοιχωμάτων (τουλάχιστον 
τέσσερα κελιά και για τα δύο πλέγματα). Για το σκοπό αυτό κάθε τοίχωμα του προβλήματος διαθέτει 
inflation layers. 
Με τις προαναφερθείσες ρυθμίσεις τα component και background πλέγματα προκύπτουν όπως 
φαίνεται στο Σχήμα 2.15. Παρατηρούμε πως τα προκύπτοντα πλέγματα είναι πανομοιότυπα με αυτά 
που προκύπτουν μεταβαλλόντας την προτεραιότητα πλέγματος.  
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Σχήμα 2.15: Δημιουργία οπών με προτεραιότητα δότη βασισμένη στην απόσταση συνόρου και ίσες προτεραιότητες πλέγματος. 

Πάνω τα component πλέγματα και κάτω το background πλέγμα. 

Αναζήτηση δοτών  

Η αναζήτηση δοτών (donor search) είναι το τελικό βήμα στη δημιουργία της συνδεσμολογίας του 
χώρου. Το Fluent για κάθε κελί δέκτη του εκάστοτε πλέγματος αναζητά στα υπόλοιπα πλέγματα 
κατάλληλα κελιά επίλυσης. Το κελί επίλυσης που περιέχει την κεντρική τιμή του κελιού δέκτη μαζί με 
τα εφαπτόμενα σε αυτό κελιά επίλυσης χρησιμοποιούνται σαν υποψήφια κελιά δότες για ένα κελί 
δέκτη. Κάθε κελί δέκτης πρέπει να έχει τουλάχιστον ένα κατάλληλο κελί δότη. 

Για μία επιτυχημένη αναζήτηση δοτών είναι απαραίτητο να υπάρχει μία αλληλοεπικάλυψη 
τουλάχιστον τεσσάρων με έξι κελιών. Τα κελιά δέκτες, τα οποία σχηματίζουν τα περιθώρια μιας ζώνης 
κελιών (όπως φαίνεται με μπλε στις παραπάνω εικόνες), πρέπει να έχουν επαρκή αλληλοεπικάλυψη με 
το «αντίθετο» πλέγμα ώστε να μπορούν να βρουν κατάλληλα κελιά επίλυσης που θα γίνουν κελιά 
δότες. Στο Σχήμα 2.16 αποτυπώνεται ένα παράδειγμα σωστής αλληλοεπικάλυψης πλέγματος. 
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Σχήμα 2.16: Παράδειγμα αλληλοεπικάλυψης πλέγματος (ANSYS, Inc., 2011) 

Ακόμα κατά τη χρήση της τεχνικής overset με ταυτόχρονη εφαρμογή sliding mesh (εδώ η κίνηση του 
δρομέα) ή/και dynamic mesh (εδώ η κίνηση του ψαριού-αντικειμένου) πρέπει να δοθεί προσοχή στα 
παρακάτω: 

• Το ιδανικό μέγεθος χρονικού βήματος θα πρέπει να επιλεχθεί ώστε η σχετική κίνηση του 
πλέγματος να μην ξεπερνάει το μήκος ακμής του μικρότερου κελιού στη διεπαφή overset για 
ένα χρονικό βήμα. Το μήκος ακμής που θα χρησιμοποιηθεί για τον υπολογισμό του χρονικού 
βήματος πρέπει να προσδιοριστεί από την περιοχή αλληλοεπικάλυψης. Το παραπάνω 
εξασφαλίζει μία περισσότερο βαθμιαία εξέλιξη της κίνησης και συνιστάται για μεγαλύτερη 
ακρίβεια και ευστάθεια επίλυσης. 

• Γενικά, η μετακίνηση της διεπαφής overset μπορεί να μεταβάλει την κατάσταση ενός κελιού 
από νεκρό σε δέκτη ή κελί επίλυσης και αντίστροφα. Αυτό εξαρτάται από τη σχετικά μεγέθη 
των πλεγμάτων, τις κινούμενες ζώνες κελιών που συμμετέχουν στη διεπαφή overset, το 
μέγεθος της σχετικής ταχύτητας πλέγματος και το μέγεθος του χρονικού βήματος. 

• Ενώ ο επιλύτης (solver) έχει τη δυνατότητα διαχείρισης των αλλαγών κατάστασης των κελιών 
συνιστάται ο χρήστης να παρακολουθεί ενεργά τις αλλαγές αυτές. Αυτό μπορεί να γίνει 
θέτοντας τον δείκτη verbosity στο 1 μέσα από τη γραμμή εντολών. Η διατήρηση των αλλαγών 
κατάστασης σε χαμηλά νούμερα συνιστάται για την καλύτερη ακρίβεια και ευστάθεια της 
επίλυσης. 

• Τέλος δε θα πρέπει να υπάρχουν μεγάλες διακυμάνσεις της πυκνότητας του πλέγματος στην 
αναμενόμενη περιοχή κίνησης. 
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2.6 H τεχνική Remeshing 
 
Το Fluent επιτρέπει στο χρήστη μέσω της σελίδας εργασίας δυναμικού πλέγματος (dynamic mesh) να 
καθορίσει όλες τις παραμέτρους που θέλει να χαρακτηρίζουν το εκάστοτε μοντέλο. Ο χρήστης αρχικά 
ενεργοποιεί τη λειτουργία dynamic mesh. Στο Ansys Fluent είναι διαθέσιμες τρεις επιλογές κινούμενου 
πλέγματος για την ενημέρωση του υπολογιστικού πλέγματος. Εφαρμόζονται στις περιοχές που 
επιδέχονται παραμορφώσεις εξαιτίας των προσδιοριζόμενων από τη χρήστη κινήσεων στα σύνορα του 
πλέγματος. Αυτές περιλαμβάνουν: 

• Smoothing methods 
• Dynamic Layering 
• Remeshing methods 

Οι διάφορες μέθοδοι μπορούν να χρησιμοποιηθούν και συνδυαστικά με την εξαίρεση της ταυτόχρονος 
χρήσης dynamic layering με οποιαδήποτε τεχνική remeshing. Στη συγκεκριμένη εργασία 
χρησιμοποιήθηκαν οι μέθοδοι smoothing και remeshing, οι οποίες επιλέγονται όπως φαίνεται στο 
Σχήμα 2.17. 

 

Σχήμα 2.17: Το παράθυρο επιλογών του dynamic mesh. 
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2.6.1 Smoothing 
 
Όταν η τεχνική smoothing (εξομάλυνση) εφαρμόζεται σε ένα πλέγμα το οποίο περιλαμβάνει κάποιο 
κινούμενο η παραμορφώσιμο όριο οι εσωτερικοί κόμβοι του πλέγματος μετακινούνται, όμως ο 
αριθμός τους και η συνδεσμολογία τους παραμένουν σταθερά. Με αυτόν τον τρόπο οι εσωτερικοί 
κόμβοι απορροφούν την κίνηση του ορίου. 
Όπως φαίνεται στο Σχήμα 2.18 η τεχνική smoothing διακρίνεται σε τρεις μεθόδους: 

• Spring/Laplace/Boundary Layer 
• Diffusion 
• Linearly Elastic Solid 

 

Σχήμα 2.18: Το παράθυρο επιλογής της μεθόδου smoothing. 

Στη συγκεκριμένη εργασία χρησιμοποιήθηκε diffusion smoothing. Επιλέγοντας advanced μπορούμε να 
δούμε τις παραμέτρους που μπορεί να μεταβάλει ο χρήστης για τη συγκεκριμένη μέθοδο, όπως 
φαίνεται στο Σχήμα 2.19. 

 

Σχήμα 2.19: Οι προχωρημένες επιλογές ρυθμίσεων για diffusion smoothing. 
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Για τις παραμέτρους αυτές θα υπάρξει εκτεταμένη αναφορά στη συνέχεια.  
Στο diffusion smoothing (εξομάλυνση διάχυσης) η κίνηση του πλέγματος διέπεται από την ακόλουθη 
εξίσωση διάχυσης: 

∇ ∙ (𝛾𝛾∇𝑢𝑢�⃗ ) = 0 (𝜎𝜎𝜎𝜎έ𝜎𝜎𝜎𝜎 2.4) 

Όπου 𝛾𝛾 είναι ο παράγοντας διάχυσης και 𝑢𝑢�⃗  η ταχύτητα μετατόπισης του πλέγματος. 

Οι οριακές συνθήκες για την παραπάνω εξίσωση αποκτώνται από την καθορισμένη από τη χρήστη ή 
υπολογιζόμενη από το six-dof solver κίνηση των ορίων. Για παραμορφώσιμες οριακές συνθήκες, οι 
οριακές συνθήκες ορίζονται έτσι ώστε η κίνηση του πλέγματος να είναι εφαπτόμενη στο όριο. Η 
εξίσωση Laplace τότε περιγράφει πως η κίνηση του ορίου διαχέεται στο εσωτερικό του 
παραμορφώσιμου πλέγματος.  

Ο παράγοντας διάχυσης 𝛾𝛾 στην εξίσωση διάχυσης μπορεί να χρησιμοποιηθεί για να ελέγξουμε πώς οι 
κίνηση του εκάστοτε συνόρου επηρεάζει την κίνηση του πλέγματος. Για σταθερό παράγοντα έχουμε 
ομοιόμορφη διάχυση της κίνησης του ορίου στο πλέγμα. Για μη σταθερό παράγοντα , οι κόμβοι σε 
περιοχές του πλέγματος με μεγάλη διαχυσιμότητα έχουν την τάση να κινούνται μαζί (δηλαδή με 
χαμηλή σχετική κίνηση). 

Το diffusion smoothing θεωρείται εναλλακτική μέθοδος έναντι του spring smoothing (εξομάλυνση 
ελατηρίου). Είναι διαθέσιμο για όλους τους τύπους κελιών και μπορεί να χρησιμοποιηθεί για την 
επεξεργασία οποιουδήποτε πλέγματος το οποίο έχει κινούμενα ή παραμορφώσιμα σύνορα. 

Σαν μέθοδος είναι υπολογιστικά περισσότερη ακριβή από το spring smoothing, όμως το προκύπτον 
πλέγμα είναι καλύτερης ποιότητας και επιπλέον επιτρέπει μεγαλύτερες παραμορφώσεις πριν επέλθει 
καταστροφή του πλέγματος (mesh break down). Επιπλέον, όπως και το spring smoothing, μπορεί να 
χειριστεί μεταφορικές κινήσεις καλύτερα από περιστροφικές. 

Στο Fluent είναι διαθέσιμες δύο διαφορετικές διατυπώσεις για τον παράγοντα διάχυσης γ. Η πρώτη 
διατύπωση καθιστά τον παράγοντα διάχυσης συνάρτηση της απόστασης από το σύνορο, σύμφωνα με 
τη σχέση: 

𝛾𝛾 =
1
𝑑𝑑𝛼𝛼

 

όπου 𝑑𝑑 η κανονικοποιημένη απόσταση από το σύνορο. Η δεύτερη διατύπωση ορίζει τον παράγοντα 
διάχυσης συνάρτηση του όγκου κελιού, σύμφωνα με τη σχέση: 

  

𝛾𝛾 =
1
𝑉𝑉𝛼𝛼

 

όπου 𝑉𝑉 ο κανονικοποιημένος όγκος κελιού. 

Και στις δύο παραπάνω σχέσεις το 𝛼𝛼 ≥ 0 είναι η παράμετρος διάχυσης (diffusion parameter) που 
καθορίζει ο χρήστης. 
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Διάχυση βασισμένη στην απόσταση συνόρου 

Χρησιμοποιώντας τη σχέση 2.4, ο χρήστης μπορεί να ελέγξει πως η κίνηση του συνόρου διαχέεται στο 
εσωτερικό του υπολογιστικού χώρου ως συνάρτηση της απόστασης από το σύνορο. Μειώνοντας τη 
διαχυσιμότητα απομακρυνόμενοι από το κινούμενο σύνορο έχει αποτέλεσμα αυτές οι περιοχές να 
απορροφούν περισσότερη από την κίνηση του πλέγματος ενώ παράλληλα διατηρεί την ποιότητα του 
πλέγματος κοντά στο κινούμενο σύνορο. Αυτό αποδεικνύεται ιδιαίτερα χρήσιμο για κινούμενα σύνορα 
με έντονα γεωμετρικά χαρακτηριστικά (όπως αιχμηρές γωνίες) και κίνηση κυρίως περιστροφική. 

Μπορούμε να επηρεάσουμε τον συντελεστή διάχυσης 𝛾𝛾 προσαρμόζοντας την παράμετρο διάχυσης 𝛼𝛼. 
Για την παράμετρο διάχυσης ισχύει 𝛼𝛼 ≥ 0, όμως για πρακτική χρήση παίρνει τιμές από 0 έως 2. Για τιμή 
0 ο συντελεστής διάχυσης γίνεται 𝛾𝛾 = 1 και ορίζει μια ομοιόμορφη διάχυση της κίνησης του συνόρου 
στο πλέγμα. Μεγαλύτερες τιμές του 𝛼𝛼 προκαλούν διατήρηση ποιότητας του πλέγματος για 
μεγαλύτερες περιοχές κοντά στο κινούμενο σύνορο ενώ παράλληλα την απορρόφηση της κίνησης 
αναλαμβάνουν περιοχές μακριά από αυτό. 

Τέλος, για τον υπολογισμό της απόστασης 𝑑𝑑 από το κοντινότερο σύνορο είναι διαθέσιμες δύο 
διαφορετικές μέθοδοι. Από προεπιλογή το Fluent χρησιμοποιεί το μέτρο του κάθετου διανύσματος από 
το κοντινότερο τοίχο (προσοχή, άλλοι τύποι συνόρων όπως είσοδοι, έξοδοι κλπ. δε λαμβάνονται 
υπόψιν), πρόκειται για την ίδια μέθοδο που χρησιμοποιούν τα μοντέλα τύρβης. Η δεύτερη μέθοδος 
ονομάζεται Γενικευμένη Μέθοδος Απόστασης Συνόρου (Generalized Boundary Distance Method), κατά 
την οποία η απόσταση 𝑑𝑑 είναι το μέτρο του κάθετου διανύσματος από τον πλησιέστερο σύνορο 
(περιλαμβάνει όλους τους τύπους συνόρων) το οποίο δεν είναι δηλωμένο ως παραμορφώσιμο σύνορο. 
Στην περίπτωση επιλογής αυτής της μεθόδου επιλύεται μια ακόμα βαθμωτή εξίσωση για την απόσταση 
𝑑𝑑 ως μέρος της εξίσωσης 1. 

Διάχυση βασισμένη στον όγκο κελιού 

Στη διάχυση όγκου ελέγχου η διάχυση της κίνησης στο εσωτερικό του χωρίου είναι συνάρτηση του 
όγκου ελέγχου. Μειώνοντας τη διαχυσιμότητα για μεγαλύτερα κελιά έχει ως αποτέλεσμα αυτά τα 
κελιά να απορροφούν περισσότερη από την κίνηση του πλέγματος με αποτέλεσμα να διατηρείται η 
ποιότητα πλέγματος για τα μικρότερα κελιά. 

Μπορούμε να επηρεάσουμε τον συντελεστή διάχυσης 𝛾𝛾 προσαρμόζοντας την παράμετρο διάχυσης 𝛼𝛼. 
Για την προκαθορισμένη τιμή 0 ο συντελεστής διάχυσης γίνεται 𝛾𝛾 = 1 και ορίζει μια ομοιόμορφη 
διάχυση της κίνησης του συνόρου στο πλέγμα. Μεγαλύτερες τιμές του 𝛼𝛼 προκαλούν την απορρόφηση 
της κίνησης από μεγαλύτερα κελιά σε σχέση με τα μικρότερα κελιά. 

Σημειώνεται πως ο όγκος κελιού που χρησιμοποιείται στην εξίσωση είναι ο τοπικός όγκος κελιού, 
κανονικοποιημένος από το μέσο όγκο κελιού όλων των παραμορφώσιμων ζωνών (deforming mesh 
zones). 

Επίλυση 

Η επίλυση της σχέσης 2.4 γίνεται χρησιμοποιώντας μέθοδο πεπερασμένων στοιχείων και η ταχύτητα 
μετατόπισης 𝑢𝑢�⃗  υπολογίζεται απευθείας σε κάθε κόμβο του πλέγματος. Αυτή η μέθοδος επίλυσης 
ακολουθείται για κάθε είδους πλέγμα εκτός αν το πλέγμα περιέχει πολυεδρικά στοιχεία, στην 
περίπτωση αυτή εφαρμόζεται η μέθοδος των πεπερασμένων όγκων, η οποία όμως είναι λιγότερο 
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ακριβείς. Στην περίπτωση της παρούσας εργασίας το πλέγμα είναι δισδιάστατο τριγωνικών στοιχείων 
οπότε η επίλυση πραγματοποιείται με τη μέθοδο των πεπερασμένων στοιχείων. 

Η μέθοδος των πεπερασμένων στοιχείων δίνει τη δυνατότητα στη χρήστη να ορίσει τη μέθοδο του 
γραμμικού επιλυτή για την περίπτωση diffusion smoothing. Από προεπιλογή η μέθοδος CG (conjugate 
gradient) είναι επιλεγμένη από τη λίστα επιλογών AMG Stabilization όπως φαίνεται στο σχήμα 2.21. Αν 
η μέθοδος CG αποκλίνει, τότε ως εναλλακτική ενεργοποιείται η μέθοδος γενικευμένου ελάχιστου 
υπόλοιπου (Generalized Minimal Residual – GMRES) και ο χρήστης ενημερώνεται με μήνυμα στην 
κονσόλα ότι η επιλυόμενη εξίσωση σταθεροποιείται για να βελτιωθεί η ποιότητα επίλυσης.  

Σε περίπτωση που εμφανίζονται προβλήματα καταστροφής του πλέγματος (λόγω negative volume 
cells) ο χρήστης μπορεί να αυξήσει τον αριθμό μέγιστον επαναλήψεων (Maximum Number of 
Iterations) από την προεπιλογή 50 σε ένα εύρος από 200 έως 500. Ασφαλώς υπάρχει και η επιλογή 
μείωσης του χρονικού βήματος. 

Εάν το πρόβλημα καταστροφής του πλέγματος επιμένει ή εάν η εναλλακτική μέθοδος GMRES 
ενεργοποιείται πολύ συχνά προτείνεται να επιλεχθεί εξ αρχής η μέθοδος GMRES στην επιλογή AMG 
Stabilization. Η μέθοδος αυτή είναι περισσότερο σταθερή από τη CG ειδικά για πλέγματα μεγάλης 
αναλογίας απεικόνισης (aspect ratio), αλλά και παράλληλα περισσότερο απαιτητική σε μνήμη και 
χρόνο επίλυσης. 

Τέλος είναι διαθέσιμη και η μέθοδος bi-conjugate gradient stabilized (BCGSTAB) από τη λίστα επιλογών 
AMG Stabilization. Όπως και στη CG, εάν η BCGSTAB αποκλίνει ενεργοποιείται η μέθοδος GMRES. 
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2.6.2 Remeshing 
 
Όταν η μετατόπιση του συνόρου είναι μεγάλη συγκρινόμενη με το μέγεθος των κελιών, η ποιότητα των 
κελιών μπορεί να μειωθεί ή τα πλέγμα να καταρρεύσει εάν χρησιμοποιηθεί μόνο η μέθοδος 
smoothing. Κάτι τέτοιο προφανώς ισχύει στην περίπτωση μας αφού ο σκοπός είναι η μετακίνηση μιας 
γεωμετρίας (ψάρι-αντικείμενο)  μέσα στο υπολογιστικό χωρίο. 

Για να ξεπεραστεί το προαναφερθέν πρόβλημα το Fluent ομαδοποιεί τα κελιά που δεν πληρούν τo 
κριτήριο skewness ή κριτήρια μεγέθους και τοπικά αναδημιουργεί το πλέγμα (local remeshing). Εάν τα 
νέα κελιά ικανοποιούν το κριτήριο skewness, το πλέγμα ενημερώνεται με τα νέα κελιά με τις 
πληροφορίες να παρεμβάλλονται από τα παλαιότερα κελιά. Σε αντίθετη περίπτωση τα νέα κελιά 
απορρίπτονται και διατηρούνται τα παλιά. 

Το Fluent διαθέτει πολλές μεθόδους αναδημιουργίας πλέγματος: τοπική αναδημιουργία πλέγματος 
(local cell remeshing), αναδημιουργία πλέγματος σε ζώνες (zone remeshing), face region remeshing, 
local face remeshing και 2.5D surface remeshing. Οι μέθοδοι αναδημιουργίας πλέγματος είναι 
διαθέσιμες για συγκεκριμένους τύπους κελιών (ANSYS, Inc., 2011). 

• Η μέθοδος τοπικής αναδημιουργίας πλέγματος (local cell remeshing) εφαρμόζεται μόνο σε 
τριγωνικά και τετραεδρικά στοιχεία του πλέγματος.  

• Το local face remeshing είναι διαθέσιμο μόνο για 3D cases και εφαρμόζεται μόνο σε 
τετραεδρικά κελιά και πρισματικά κελιά (wedge/prism cells) σε πλέγματα οριακού στρώματος . 

• Η μέθοδος αναδημιουργίας πλέγματος σε ζώνες (zone remeshing) αντικαθιστά όλους τους 
τύπους κελιών με τριγωνικά (2D) ή τετραεδρικά (3D) κελιά, ενώ μπορεί να αναδημιουργήσει 
και να παράγει πρισματικά κελιά σε 3D πλέγματα οριακού στρώματος. 

• Η μέθοδος face region remeshing εφαρμόζεται σε τριγωνικά (2D) και τετραεδρικά (3D) κελιά. Σε 
τρισδιάστατα χωρία μπορεί επίσης να αναδημιουργήσει και παράγει πρισματικά κελιά για 
πλέγματα οριακού στρώματος. 

• Η μέθοδος 2.5D remeshing λειτουργεί μόνο με εξάγωνα πλέγματα ή πρισματικά κελιά 
σχηματιζόμενα από τριγωνικά στοιχεία επιφάνειας. 

Στη συγκεκριμένη εργασία επιλέχθηκε η μέθοδος local cell remeshing. Ο χρήστης μπορεί να 
χρησιμοποιεί ταυτόχρονα πολλαπλές μεθόδους (πχ local cell και local face remeshing). Η επιλογή των 
προαναφερθέντων μεθόδων είναι διαθέσιμη πατώντας το πλήκτρο Settings (Σχήμα 2.17) και 
μεταβαίνοντας στην καρτέλα Remeshing όπως φαίνεται στο σχήμα Σχήμα 2.20. 
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Σχήμα 2.20: Το παράθυρο επιλογών ρυθμίσεων για το remeshing. 

Από το ίδιο παράθυρο μπορούν να ενεργοποιηθούν και άλλες επιλογές όμως η εισαγωγή sizing 
function, να καθοριστούν σημαντικές παράμετροι και να προβληθούν πληροφορίες του πλέγματος με 
το Mesh Scale Info.  

Local Remeshing Method 

Χρησιμοποιώντας τη μέθοδο τοπικής αναδημιουργίας (local cell remeshing είτε χωρίς είτε με local face 
remeshing), το Fluent αξιολογεί τα κελιά βάσει του skewness, την ελάχιστη και μέγιστη κλίμακα μήκους 
καθώς και μία προαιρετική sizing function. Εάν πληρούνται κάποια συγκεκριμένα κριτήρια για κάθε 
κελί αυτό μαρκάρετε για remeshing. Τα κριτήρια αυτά είναι: 

• Skewness μεγαλύτερο από το μέγιστο καθορισμένο όριο. 
• Το κελί να είναι μικρότερο από την καθορισμένη ελάχιστη κλίμακα μήκους. 
• Το κελί να είναι μεγαλύτερο από την καθορισμένη μέγιστη κλίμακα μήκους. 
• Το ύψος του κελιού δεν ικανοποιεί την κλίμακα μήκους (σε κινούμενες face zones). 

Εάν η τοπική αναδημιουργία (local remeshing) δεν είναι ικανή να ελαττώσει το μέγιστο skewness 
επαρκώς, τότε αυτομάτως χρησιμοποιείται η μέθοδος cell zone remeshing σε όλα τα κελιά της ζώνης 
καθώς και όλα τα faces των εφαπτόμενων παραμορφώσιμων dynamic face zones. Η μέγιστη επιτρεπτή 
τιμή για το skewness ορίζεται στο 0.98. Η μέθοδος cell zone remeshing δίνει στο λογισμικό περισσότερη 
ελευθερία για τη δημιουργία του νέου πλέγματος από ότι η μέθοδος local cell remeshing. Επιπλέον 
χρησιμοποιώντας το text user interface η μετάβαση στη μέθοδο cell zone remeshing μπορεί να 
απενεργοποιηθεί χρησιμοποιώντας την εντολή: 

define → dynamic-mesh → controls → remeshing-parameter → zone-remeshing 
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Local Cell Remeshing Method 

Όπως αναφέρθηκε προηγουμένως, στο local cell remeshing το Fluent ομαδοποιεί τα κελιά βάσει 
skewness, μεγέθους και ύψους πριν την κίνηση του συνόρου. Τα κριτήρια μεγέθους καθορίζονται από 
τη μέγιστη και ελάχιστη κλίμακα μήκους. Τα κελία με κλίμακα μήκους μικρότερη από το κατώτατο όριο 
ή μεγαλύτερη από το ανώτατο όριο μαρκάρονται για remeshing. Η τιμή του μέγιστου skewness 
υποδεικνύει το επιθυμητό skewness που ιδανικά θα θέλαμε να έχει το πλέγμα. Η προκαθορισμένη τιμή 
είναι 0.9 για τρισδιάστατες προσομοιώσεις και 0.7 για δισδιάστατες προσομοιώσεις. Τα κελιά με 
skewness μεγαλύτερο το μέγιστο όριο μαρκάρονται για remeshing. 

Το μαρκάρισμα των κελιών βάσει skewness πραγματοποιείται σε κάθε χρονικό βήμα όταν είναι 
ενεργοποιημένη η μέθοδος τοπικής αναδημιουργίας (local remeshing). Ωστόσο, το μαρκάρισμα βάσει 
μεγέθους και ύψους πραγματοποιείται ανά το καθορισμένο Size Remeshing Interval (εικόνα) από τη 
στιγμή που η αλλαγή στην κατανομή του μεγέθους των κελιών είναι τυπικά πολύ μικρή από χρονικό 
βήμα σε χρονικό βήμα. 

Πρέπει να σημειωθεί ότι οι τιμές των παραμέτρων θα πρέπει να αλλάξουν από το χρήστη ανάλογα με 
την εκάστοτε προσομοίωση αφού οι προκαθορισμένες τιμές συνήθως δεν οδηγούν στο επιθυμητό 
αποτέλεσμα και παράγουν σφάλματα. Επιλέγοντας Default οι τιμές θα προσαρμοστούν στο 
συγκεκριμένο πλέγμα δίνοντας ένα λογικό σημείο έναρξης από το οποίο ο χρήστης μπορεί να αλλάξει 
τις τιμές. Στην περίπτωση της εργασία αυτής οι παράμετροι που επιλέχθηκαν φαίνονται στο Σχήμα 
2.21. 

 

Σχήμα 2.21: Οι παράμετροι που επιλέχθηκαν για τη μέθοδο remeshing. 

Από προεπιλογή το Fluent αντικαθιστά τα ομαδοποιημένα κελιά μόνο εάν η ποιότητα των 
αναδημιουργημένων κελιών είναι ανώτερη των παλαιότερων κελιών. Επιπλέον επιλέγεται το 
μεσοδιάστημα μεταξύ δύο εφαρμογών remeshing στη μία επανάληψη.  
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3 Αποτελέσματα 
 
Για τις προσομοιώσεις χρησιμοποιήθηκαν δύο τεχνικές, overset και remeshing καθώς και διάφορες 
γεωμετρίες για το ψάρι-αντικείμενο. Συνολικά χρησιμοποιήθηκαν τέσσερα μοντέλα για το ψάρι 
αντικείμενο, με ποικίλα βάρη που ανταποκρίνονταν στο μέγεθος του αντικειμένου. Στον παρακάτω 
Πίνακας 3.1 παρατίθενται για κάθε ψάρι-αντικείμενο το σχήμα, τα γεωμετρικά του χαρακτηριστικά 
(διάμετρο 𝑑𝑑, πλάτος 𝑐𝑐, μήκος 𝑙𝑙 και ο λόγος διαστάσεων 𝐴𝐴𝐴𝐴), η μάζα m, η ροπή αδράνειας 𝐼𝐼𝑧𝑧𝑧𝑧 και η 
πυκνότητα 𝜌𝜌. 

Α/Α Αντικείμενο 𝒅𝒅 (𝒎𝒎𝒎𝒎) 𝒄𝒄 (𝒎𝒎𝒎𝒎) 𝒍𝒍 (𝒎𝒎𝒎𝒎) 𝑨𝑨𝑨𝑨 𝒎𝒎 (𝒈𝒈𝒈𝒈) 𝝆𝝆 (𝒌𝒌𝒌𝒌/𝒎𝒎𝟐𝟐 ) 𝑰𝑰𝒛𝒛𝒛𝒛(𝒈𝒈𝒈𝒈 ∙ 𝒎𝒎𝒎𝒎𝟐𝟐) 

1 

 

6 - - 1 

20 707.46 90 

50 1768.66 225 

100 3537.32 450 

2 

 

- 6 12 2 

50 777.97 1033 

100 1555.93 2166 

150 2333.90 3249 

3 

 

- 6 24 4 

150 1100.75 19090.69 

200 1467.67 25454.26 

250 1834.59 31817.82 

4 

 

- 3 12 4 

50 1467.67 1590.88 

100 2935.34 3181.76 

150 4402.70 6363.52 
Πίνακας 3.1: Ta ψάρια-αντικείμενα που χρησιμοποιήθηκαν στις προσομοιώσεις: διαστάσεις, πυκνότητα και ροπή αδράνειας 

(mass moment of inertia) στον άξονα z’z. 

Στην τεχνική οverset χρησιμοποιήθηκαν οι γεωμετρίες 2 και 3 ενώ στην τεχνική remeshing όλες οι 
γεωμετρίες. Στις σημειωμένες με κόκκινο περιπτώσεις η προσομοίωση δε μπορούσε να 
πραγματοποιηθεί για λόγους που θα αναφερθούν παρακάτω. 
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3.1 Τεχνική Overset 
 
Ο δισδιάστατος υπολογιστικός χώρος που χρησιμοποιήθηκε είναι αυτός που παρουσιάστηκε στην 
ενότητα «Γεωμετρία και πλέγμα» για την τεχνική overset.  Για την επίλυση των εξισώσεων Navies 
Stokes χρησιμοποιήθηκε το λογισμικό Ansys Fluent και ο pressure-based solver. Για την επίλυση της 
τύρβης επιλέχθηκε αρχικά το μοντέλο τύρβης 𝑘𝑘 − 𝜀𝜀 realizable με βαθμωτές συναρτήσεις τοίχου. Σε 
δεύτερη φάση χρησιμοποιήθηκε το μοντέλο τύρβης 𝑘𝑘 − 𝜔𝜔. Για αμφότερα τα μοντέλα οι επιπλέον 
ρυθμίσεις που επιλέχθηκαν ήταν κοινές και παρατίθενται στον παρακάτω Πίνακας 3.2. 

Pressure-Velocity Coupling Scheme Coupled 
Spatial Discretization  

Gradient Least Squares Cell Based 
Pressure Second Order 

Momentum Second Order Upwind 
Turbulent Kinetic Energy First Order Upwind 

Turbulent Dissipation Rate First Order Upwind 
Πίνακας 3.2: Επιλεγμένο σχήμα επίλυσης και ρυθμίσεις χωρικής διακριτοποίησης στο λογισμικό ANSYS Fluent.  

Η επιλογή του συζευγμένου σχήματος πίεσης ταχύτητας ήταν αναγκαστική, λόγω περιορισμών που 
επέβαλε η χρήση της τεχνικής overset. Και οι επιλεγμένες ρυθμίσεις επίλυσης (Solution Controls) 
φαίνονται στον Πίνακας 3.3. 

Flow Courant Number 70 
Explicit Relaxation Factors 

Momentum 0.75 
Pressure 0.75 

Under Relaxation Factors 
Density 1 

Body Forces 1 
Turbulent Kinetic Energy 0.8 

Turbulent Dissipation Rate 0.8 
Turbulent Viscosity 1 

Πίνακας 3.3: Επιλεγμένες ρυθμίσεις επίλυσης στο λογισμικό ANSYS Fluent. 
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3.1.1 Επίλυση με μοντέλο τύρβης 𝑘𝑘 − 𝜀𝜀 realizable 
 

Πρώτα έγινε steady επίλυση του προβλήματος, χωρίς δηλαδή κίνηση του δρομέα. Στη συνέχεια 
ενεργοποιήθηκε η κίνηση του δρομέα η οποία ορίστηκε στα 333 RPM (mesh motion), επομένως η 
επίλυση του προβλήματος μεταβλήθηκε σε transient. Το μέγεθος του χρονικού βήματος ορίστηκε στις 
8°/𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠 ή αλλιώς 0.004004004 𝑠𝑠𝑠𝑠𝑠𝑠. 
Τη στιγμή που έγινε η συγκεκριμένη προσομοίωση, το πλέγμα του κελύφους που χρησιμοποιήθηκε είχε 
180.000 στοιχεία, με επιλεγμένο μέγεθος στοιχείου 1.5 ∙ 10−3𝑚𝑚𝑚𝑚. Το προκύπτον πεδίο ροής με την 
επιλεγμένη μεθοδολογία, δεν ήταν σωστό. Συγκεκριμένα, παρουσιαζόντουσαν προβλήματα 
ανάστροφης ροής (reversed flow) στην πίεση εξόδου αλλά και αυξημένης τιμής του τυρβώδους λόγου 
ιξώδους (turbulent viscosity ratio - TVR), το όριο του οποίου ορίζεται από το Fluent στο 105. Το 
πρόβλημα αναστροφής ροής, εμφανιζόταν και υποχωρούσε περιοδικά. Σχετικά με το αυξημένο TVR, το 
πρόβλημα ξεκινούσε από την περιοχή στην  οποία εφάπτεται το πλέγμα του δρομέα με αυτό του 
κελύφους, και στη συνέχεια επεκτεινόταν στο υπόλοιπο πεδίο ροής, όπως φαίνεται στα Σχήμα 3.1 και 
Σχήμα 3.2. Μετά από κάποιες επαναλήψεις μπορεί να περιοριζόταν, αλλά επανεμφανιζόταν σε μεγάλο 
βαθμό.  

  
Σχήμα 3.1:Διαγράμματα ισοκαμπύλης τυρβώδους λόγου ιξώδους για διαφορετικής χρονικές στιγμές. Στο αριστερό διάγραμμα 

το TVR υπερβαίνει το ορισμένο όριο για 12000 κελιά, στα δεξιά για 26000 κελιά. 
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Σχήμα 3.2: Διαγράμματα ισοκαμπύλης τυρβώδους λόγου ιξώδους για διαφορετικής χρονικές στιγμές. Στο αριστερό διάγραμμα 

το TVR υπερβαίνει το ορισμένο όριο για 50000 κελιά, στα δεξιά για 100000 κελιά. 

Παράλληλα με την εξάπλωση του πολύ υψηλού TVR επηρεαζόταν και το πεδίο ταχυτήτων, όπως 
φαίνεται στα Σχήμα 3.3 και Σχήμα 3.4, με το μέτρο της ταχύτητας γύρω από το δρομέα να μειώνεται. 

  
Σχήμα 3.3: Διαγράμματα ισοκαμπύλης μέτρου ταχύτητας για διαφορετικής χρονικές στιγμές. Στο αριστερό διάγραμμα το TVR 

υπερβαίνει το ορισμένο όριο για 12000 κελιά, στα δεξιά για 26000 κελιά. 
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Σχήμα 3.4: Διαγράμματα ισοκαμπύλης μέτρου ταχύτητας για διαφορετικής χρονικές στιγμές. Στο αριστερό διάγραμμα το TVR 

υπερβαίνει το ορισμένο όριο για 50000 κελιά, στα δεξιά για 100000 κελιά. 

Εξετάζοντας τα διαγράμματα ισοκαμπύλων για τις ταχύτητες 𝑢𝑢 και 𝑣𝑣 στο Σχήμα 3.5 γίνεται αντιληπτό 
πως το πεδίο ροής δεν κατευθύνεται προς το εσωτερικό του υδροστροβίλου όπως θα έπρεπε. Το μέτρο 
της μέγιστης ταχύτητας αυξάνεται στο πεδίο. Η φορά των ταχυτήτων είναι σωστή όμως το μέτρο τους 
δεν αυξάνεται, όπως αναμένεται, πλησιάζοντας το δρομέα. Αντιθέτως, το μέτρο μειώνεται. 

  
Σχήμα 3.5: Στο αριστερό διάγραμμα οι ισοκαμπύλες της u  ταχύτητας  και στο δεξί διάγραμμα οι ισοκαμπύλες της v ταχύτητας. 

Και τα δύο διαγράμματα απεικονίζουν τη χρονική στιγμή που το TVR υπερβαίνει το όριο σε 100000 κελιά. 
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Σχήμα 3.6: Πάνω, τροχιές του πεδίου ροής πριν την εκκίνηση του δρομέα και τη στιγμή που 100000 κελιά υπερβαίνουν το όριο 

του TVR. Κάτω, το ίδιο διάγραμμα με στατικό δρομέα. 
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Επιπλέον παρατηρώντας το Σχήμα 3.6, φαίνεται πως οι τροχιές τη χρονική στιγμή πριν την εκκίνηση του 
δρομέα καταλήγουν πιο αργά στο εσωτερικό του υδροστροβίλου σε σχέση με τις τροχιές τη στιγμή που 
100000 κελιά υπερβαίνουν το όριο του TVR. Η μείωση του χρόνου ήταν σταδιακή και αποδίδεται στην 
αύξηση του μέτρου των ταχυτήτων σε όλο το πεδίο.  

Η μείωση του χρονικού βήματος περιόριζε το πρόβλημα αύξηση του TVR χωρίς όμως να το εξαλείφει. Ο 
περιορισμός γινόταν σε βάρος του υπολογιστικού χρόνου, ο οποίος αυξάνονταν. Αργότερα, και αφού 
είχαν δοκιμαστεί χωρίς επιτυχία άλλοι τρόποι διόρθωσης του προβλήματος, βρέθηκε στη βιβλιογραφία 
πως το μοντέλο k−ε υστερεί στις περιπτώσεις που το υπολογιστικό χωρίο περιέχει ζώνες 
περιστρεφόμενες και ακίνητες παράγοντας αφύσικες τιμές για την τυρβώδη συνεκτικότητα. Η εν λόγω 
παρατήρηση συμφωνούσε με τη μορφή των εξαγόμενων αποτελεσμάτων και έτσι αποφασίστηκε η 
αλλαγή του μοντέλου τύρβης στο k−ω SST, το οποίο τελικά απέφερε αποτελέσματα. Όμως λόγω 
κολλημάτων που παρουσιαζόντουσαν σε αρχικό στάδιο παράλληλα δοκιμάστηκε με επιτυχία και η 
μέθοδος remeshing.   
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3.1.2 Επίλυση με το μοντέλο τύρβης 𝑘𝑘 − 𝜔𝜔 SST 
 
Όμοια με το μοντέλο 𝑘𝑘 − 𝜀𝜀, πρώτα έγινε steady επίλυση του προβλήματος, χωρίς δηλαδή κίνηση του 
δρομέα. Στη συνέχεια, ενεργοποιήθηκε η κίνηση του δρομέα η οποία ορίστηκε στα 333 RPM (mesh 
motion), επομένως η επίλυση του προβλήματος μεταβλήθηκε σε transient. Το μέγεθος του χρονικού 
βήματος ορίστηκε στις 2°/𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠 ή αλλιώς 0.001001001 𝑠𝑠𝑠𝑠𝑠𝑠. Το συγκεκριμένο χρονικό βήμα επιλέχθηκε 
γιατί με μεγαλύτερα χρονικά βήματα εμφανιζόταν σε μικρή έκταση πρόβλημα ανάστροφης ροής 
(reversed flow) στην έξοδο πίεσης. Εξάλλου, το χρονικό βήμα θα πρέπει να μειωθεί στο ίδιο επίπεδο 
όταν θα ενεργοποιηθεί η κίνηση του ψαριού-αντικειμένου.  
Στη συνέχεια, προκειμένου να διαμορφωθεί το πεδίο ροής, έγινε επίλυση για συνολικό χρόνο 2 𝑠𝑠𝑠𝑠𝑠𝑠 με 
το επιλεγμένο βήμα, δηλαδή περίπου 12 περιστροφές του δρομέα. Στα παρακάτω Σχήμα 3.7 και Σχήμα 
3.8 φαίνονται οι ταχύτητες, η ολική πίεση καθώς και οι τροχιές του πεδίου στην ίδια χρονική στιγμή. 

 

  
Σχήμα 3.7: Πάνω, το διάγραμμα  ισοκαμπύλων μέτρου ταχύτητας. Κάτω, στο αριστερό διάγραμμα οι ισοκαμπύλες της v 

ταχύτητας  και στο δεξί διάγραμμα οι ισοκαμπύλες της u ταχύτητας. 
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Σχήμα 3.8: Αριστερά το διάγραμμα ισοκαμπύλων της πίεσης και δεξιά τροχιές σωματιδίων του πεδίου χρωματισμένες με βάση 
τη θέση εκκίνησης. 

Παρατηρώντας το Σχήμα 3.7, βλέπουμε πως η οριζόντια ταχύτητα 𝑢𝑢 στον αγωγό εισόδου του 
υδροστροβίλου είναι σχεδόν μηδενική. Καθώς προχωράμε προς το εσωτερικό του υδροστροβίλου και 
προς τα αρνητικά του άξονα 𝑦𝑦 (γωνιακή θέση 180ο), αυτή αποκτά αρνητική τιμή ώστε να μπορεί να 
στρίψει η ροή. Στη γωνιακή θέση 360ο η ταχύτητα αποκτά θετικές τιμές, καθώς η ροή στρίβει προς το 
εσωτερικό του υδροστροβίλου και απομακρύνεται από το σπειροειδές κέλυφος. 
Η κατακόρυφη ταχύτητα 𝑣𝑣 έχει πιο απλή κατανομή. Στον θετικό ημιάξονα 𝑥𝑥, που η ροή είναι προς τα 
κάτω, αυτή έχει αρνητική τιμή, ενώ στον αρνητικό ημιάξονα 𝑥𝑥, που η ροή κινείται προς τα πάνω, η 
ταχύτητα 𝑣𝑣 έχει θετική τιμή.  
Τα προαναφερθέντα επιβεβαιώνονται από το διάγραμμα των τροχιών του πεδίου ροής, όπως φαίνεται 
στο Σχήμα 3.8. Αξίζει να αναφερθεί, πως επειδή το πεδίο ροής είναι μη μόνιμο οι γραμμές ροής δε 
συμπίπτουν με τις τροχιές. Όμως, σε κάθε χρονικό βήμα το μόνο σημείο στο οποίο οι γραμμές ροής 
μεταβάλλονται ουσιαστικά είναι το εσωτερικό του δρομέα, ενώ ακόμα και αυτή η μεταβολή είναι 
περιοδική αφου επαναλαμβάνεται σε κάθε περιστροφή. Επομένως κοιτώντας τις τροχιές των 
σωματιδίων για μια συγκεκριμένη χρονική στιγμή μπορούμε να έχουμε ολοκληρωμένη εικόνα και για 
τις γραμμές ροής του πεδίου. 
Σε κάθε σημείο, η συνισταμένη των δύο ταχυτήτων δίνει την ταχύτητα του πεδίου ροής και την 
κατεύθυνση του, όπως αποτυπώνεται στο διάγραμμα ισοκαμπύλων μέτρου ταχύτητας του σχήματος 
Σχήμα 3.7. 

Για λόγους σύμπτυξης αλλά και καλύτερης εποπτείας η παρουσίαση των αποτελεσμάτων των τροχιών 
ψαριών-αντικειμένων με την τεχνική overset θα γίνει μαζί με αυτά της τεχνικής remeshing.  
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3.2 Τεχνική remeshing 
 
Ο δισδιάστατος υπολογιστικός χώρος που χρησιμοποιήθηκε είναι αυτός που παρουσιάστηκε στην 
ενότητα «Γεωμετρία και πλέγμα» για την τεχνική remeshing.  Για την επίλυση των εξισώσεων Navies 
Stokes χρησιμοποιήθηκε το λογισμικό Ansys Fluent και ο pressure-based solver. Για την επίλυση της 
τύρβης επιλέχθηκε αρχικά το μοντέλο τύρβης 𝑘𝑘 − 𝜔𝜔 SST. Επιπλέον ρυθμίσεις που επιλέχθηκαν 
παρατίθενται στον Πίνακας 3.4. 

Pressure-Velocity Coupling Scheme Coupled 
Spatial Discretization  

Gradient Least Squares Cell Based 
Pressure Second Order 

Momentum Second Order Upwind 
Turbulent Kinetic Energy First Order Upwind 

Turbulent Dissipation Rate First Order Upwind 
Πίνακας 3.4: Επιλεγμένο σχήμα επίλυσης και ρυθμίσεις χωρικής διακριτοποίησης στο λογισμικό ANSYS Fluent. 

Παρότι με τη μέθοδο remeshing δεν υπήρχε κάποιος περιορισμός στην επιλογή του σχήματος επίλυσης 
πίεσης-ταχύτητας επιλέχθηκαν οι ίδιες ρυθμίσεις με την τεχνική overset. Και οι επιλεγμένες ρυθμίσεις 
επίλυσης (Solution Controls) 

Flow Courant Number 70 
Explicit Relaxation Factors 

Momentum 0.75 
Pressure 0.75 

Under Relaxation Factors 
Density 1 

Body Forces 1 
Turbulent Kinetic Energy 0.5 

Turbulent Dissipation Rate 0.5 
Turbulent Viscosity 1 

Πίνακας 3.5: Επιλεγμένες ρυθμίσεις επίλυσης στο λογισμικό ANSYS Fluent. 

Πρώτα έγινε steady επίλυση του προβλήματος, χωρίς δηλαδή κίνηση του δρομέα. Λόγω περιορισμών 
της τεχνικής remeshing η ταχύτητα περιστροφής του δρομέα δε μπορούσε να οριστεί με τρόπο όμοια 
με αυτόν στη τεχνική overset, ουσιαστικά δηλαδή να επιβληθεί από το χρήστης η περιστροφή του 
συγκεκριμένου χώρους του πλέγματος με συγκεκριμένο αριθμό στροφών. Μόνη επιλογή για την 
περιστροφή θα ήταν να οριστούν και τα πτερύγια του δρομέα ως dynamic mesh με τρόπο παρόμοιο με 
εκείνον που χρησιμοποιείται για το ψάρι-αντικείμενο και ο αριθμός περιστροφών να είναι αποτέλεσμα 
των ασκούμενων δυνάμεων στα πτερύγια. Η επιλογή αυτή δε μπορεί να δώσει σωστό αριθμό 
περιστροφών αφου η σχεδίαση των πτερυγίων είναι τυχαία και απλοποιημένη. Ακολουθούν 
διαγράμματα του πεδίου ροής στα Σχήμα 3.9 και Σχήμα 3.10. 
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Σχήμα 3.9: Πάνω: το διάγραμμα  ισοκαμπύλων μέτρου ταχύτητας. Κάτω: στο αριστερό διάγραμμα οι ισοκαμπύλες της u 

ταχύτητας  και στο δεξί διάγραμμα οι ισοκαμπύλες της v  ταχύτητας. 
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Σχήμα 3.10: Πάνω, αριστερά το διάγραμμα ισοκαμπύλων της πίεσης και δεξιά οι γραμμές ροής του πεδίου. Κάτω,  οι γραμμές 

ροής χρωματισμένες ανάλογα με χρόνο. 
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Παρατηρώντας το Σχήμα 3.9, και συγκρίνοντας τα αποτελέσματα με το αντίστοιχο για την τεχνική 
overset Σχήμα 3.7, βλέπουμε πως δεν υπάρχουν μεγάλες διαφορές στα μέτρα των ταχυτήτων. Η 
μεγαλύτερη διαφορά έγκειται στις φορές των ταχυτήτων γύρω από το δρομέα. Συγκεκριμένα, η 
ταχύτητα 𝑢𝑢 δε διατηρεί σταθερή φορά στις 0ο και 180ο αλλά βλέπουμε πως η φορά αντιστρέφεται 
καθώς κινούμαστε από το εξωτερικό στο εσωτερικό του δρομέα. Το ίδιο ισχύει και για την ταχύτητα 𝑣𝑣 
στις 90ο και 270ο. 

Εξετάζοντας τις τροχιές  στο Σχήμα 3.10, και συγκρίνοντας τες με το αντίστοιχο διάγραμμα για την 
τεχνική overset στο Σχήμα 3.8, παρατηρούμε πως ποιοτικά δεν υπάρχουν διαφορές. Ο μέγιστος χρόνος 
για την τεχνική overset είναι στα 1.52 sec, όμως οι περισσότερες τροχιές να καταλήγουν στο εσωτερικό 
του δρομέα σε περίπου 1 sec ή λιγότερο. Ομοίως και με την τεχνική remeshing ο μέγιστος χρόνος είναι 
στα 1.35 sec, αλλά ξανά σε περίπου 1 sec οι περισσότερες γραμμές ροής έχουν καταλήξει στο 
εσωτερικό του δρομέα. 

Ακόμα, για λειτουργία της μεθόδου remeshing η μετακίνηση dx ενός κινούμενου σημείου σε κάθε 
χρονικό βήμα dt θα έπρεπε να είναι μικρότερη από το μήκος πλευράς των στοιχείων του πλέγματος, 
έτσι ώστε να μην έχουμε κατάρρευση του τελευταίου. Για να επιτευχθεί αυτή η συνθήκη, ακόμα και για 
το σχετικά αραιό πλέγμα, που όμως παρέχει έναν ικανοποιητικό αριθμό κελιών γύρω από το ψάρι 
αντικείμενο, το χρονικό βήμα έπρεπε να είναι 0.0001 sec. 

Στη συνέχεια, παρουσιάζονται περιπτώσεις αποτυχημένης αναδημιουργίας  λόγω μεγάλου χρονικού 
βήματος και απενεργοποιημένης λειτουργίας remeshing. Πριν σχολιάσουμε όμως τα σχήματα, πρέπει 
να γίνει μια εισαγωγή για τον όρο skewness (λοξότητα). 

 

 

Σχήμα 3.11: Σχηματικός ορισμός του όρου skewness. (ANSYS, Inc., 2011) 

Όπως φαίνεται και στο Σχήμα 3.11, ως skewness ορίζεται το ποσοστό της απόκλισης της επιφάνειας 
ενός στοιχείου του μοντέλου μας, από την επιφάνεια του ισόπλευρο τριγώνου που είναι εγγεγραμμένο 
στον ίδιο κύκλο με το στοιχείο. Ουσιαστικά, ο υπολογισμός του skewness γίνεται με τα εξής βήματα: 

• Απομονώνουμε ένα τριγωνικό στοιχείο και σχεδιάζουμε γύρω από αυτό έναν εγγεγραμμένο 
κύκλο.  

• Σχεδιάζουμε στον κύκλο αυτό ένα εγγεγραμμένο ισόπλευρο τρίγωνο. Αντιλαμβανόμαστε 
λοιπόν ότι το ισόπλευρο τρίγωνο θα έχει μεγαλύτερη επιφάνεια (𝛢𝛢𝜊𝜊) από αυτήν του του 
στοιχείου (𝐴𝐴).  

Ο λόγος της απόκλισης της επιφάνειας του τριγωνικού στοιχείου από την επιφάνεια του ισοπλεύρου 
τριγώνου, προς την επιφάνεια του ισόπλευρου μας δίνει την τιμή του skewness. Αξίζει να σημειωθεί ότι 
οι διαστάσεις που θα λάβει ένα τριγωνικό στοιχείο, εξαρτώνται τόσο από τις τιμές που θέτουμε στις 
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διάφορες ρυθμίζεις κατά το σχηματισμό του πλέγματος, όσο και από την περιπλοκότητα της 
γεωμετρίας. Για παράδειγμα στο πλέγμα του προβλήματος μας το μέγιστο skewness είναι περίπου 0.95 
όταν λαμβάνονται υπόψιν και οι ζώνες inflation γύρω από τα τοιχώματα κελύφους, πτερυγίων και 
ψαριού-αντικειμένου. Όταν όμως λαμβάνουμε υπόψιν μόνο το εσωτερικό πλέγμα, δηλαδή εξαιρώντας 
τις άνωθεν περιοχές, το μέγιστο skewness είναι περίπου στο 0.52. Στον Πίνακας 3.6 που ακολουθεί, 
μπορούμε να δούμε την ποιότητα που χαρακτηρίζει ένα κελί ανάλογα με το skewness του: 

Skewness Ποιότητα κελιού Skewness Ποιότητα κελιού 
1.00 κατάρρευση πλέγματος 0.25-0.50 πολύ καλή 

0.90-1.00 πολύ κακή 0.00-0.25 άριστη 
0.75-0.90 κακή 0.00 ισόπλευρο τρίγωνο 
0.50-0.75 καλή 

Πίνακας 3.6: Αντιστοιχία τιμών skewness με ποιότητα κελιού. 

𝑡𝑡 = 0.001 𝑠𝑠,𝑢𝑢𝑥𝑥 = 0 𝑚𝑚/𝑠𝑠,𝑢𝑢𝑦𝑦 = −3 𝑚𝑚/𝑠𝑠 𝑡𝑡 = 0.005 𝑠𝑠,𝑢𝑢𝑥𝑥 = 0.026 𝑚𝑚/𝑠𝑠,𝑢𝑢𝑦𝑦 = −2.544 𝑚𝑚/𝑠𝑠 

  
𝑡𝑡 = 0.010 𝑠𝑠,𝑢𝑢𝑥𝑥 = 0.034 𝑚𝑚/𝑠𝑠,𝑢𝑢𝑦𝑦 = −2.589 𝑚𝑚/𝑠𝑠 𝑡𝑡 = 0.015 𝑠𝑠,𝑢𝑢𝑥𝑥 = 0.093 𝑚𝑚/𝑠𝑠,𝑢𝑢𝑦𝑦 = −2.592 𝑚𝑚/𝑠𝑠 

  
Σχήμα 3.12: Αποτύπωση των αλλαγών στο πλέγμα για διάφορες χρονικές στιγμές για χρονικό βήμα 0.001 s, μέρος Α. 
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𝑡𝑡 = 0.020 𝑠𝑠,𝑢𝑢𝑥𝑥 = 0.169 𝑚𝑚/𝑠𝑠,𝑢𝑢𝑦𝑦 = −2.594 𝑚𝑚/𝑠𝑠 𝑡𝑡 = 0.025 𝑠𝑠,𝑢𝑢_𝑥𝑥 = 0.200 𝑚𝑚/𝑠𝑠,𝑢𝑢_𝑦𝑦 = −2.602 𝑚𝑚/𝑠𝑠 

  
𝑡𝑡 = 0.030 𝑠𝑠,𝑢𝑢𝑥𝑥 = 0.235 𝑚𝑚/𝑠𝑠,𝑢𝑢𝑦𝑦 = −2.627 𝑚𝑚/𝑠𝑠 𝑡𝑡 = 0.034 𝑠𝑠,𝑢𝑢𝑥𝑥 = 0.315 𝑚𝑚/𝑠𝑠,𝑢𝑢𝑦𝑦 = −2.673 𝑚𝑚/𝑠𝑠 

  
Σχήμα 3.13: Αποτύπωση των αλλαγών στο πλέγμα για διάφορες χρονικές στιγμές για χρονικό βήμα 0.001 s, μέρος Β. Στο 

τελευταίο στιγμιότυπο έχουμε κατάρρευση του πλέγματος λόγω επιλογής μεγάλου χρονικού βήματος. 

Στα Σχήμα 3.12 και Σχήμα 3.13 παρατηρούμε πως αρχικά το πλέγμα συμπεριφέρεται ομαλά και μπορεί 
να ανταποκριθεί στην κίνηση του αντικειμένου δημιουργώντας νέα στοιχεία ίδιας ποιότητα με τα 
προηγούμενα. Όσο όμως προχωράει η επίλυση και το μέτρο της ταχύτητα αυξάνεται βλέπουμε πως 
νέα στοιχεία που δημιουργούνται δεν είναι τόσο ποιοτικά όσο τα προηγούμενα έχοντας μεγαλύτερο 
skewness. Η τάση αυτή συνεχίζεται μέχρι την κατάρρευση του πλέγματος που ουσιαστικά πρόκειται για 
την κατάρρευση τουλάχιστον ενός στοιχείου με το skewness να απειρίζεται και να εμφανίζεται σφάλμα 
αρνητικού όγκου κελιού (negative cell volume error). Το κελί που καταρρέει βρίσκεται κατάντι της 
κίνησης του αντικειμένου, ακριβώς δίπλα σε αυτό. 
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𝑡𝑡 = 0.0001 𝑠𝑠, 𝑥𝑥 = 0.170 𝑚𝑚, 𝑦𝑦 = 0.200 𝑚𝑚 𝑡𝑡 = 0.020 𝑠𝑠, 𝑥𝑥 = 0.170 𝑚𝑚, 𝑦𝑦 = 0.195 𝑚𝑚 

  
𝑡𝑡 = 0.040 𝑠𝑠, 𝑥𝑥 = 0.170 𝑚𝑚, 𝑦𝑦 = 0.190 𝑚𝑚 𝑡𝑡 = 0.080 𝑠𝑠, 𝑥𝑥 = 0.170 𝑚𝑚, 𝑦𝑦 = 0.180 𝑚𝑚 

  
𝑡𝑡 = 0.160 𝑠𝑠, 𝑥𝑥 = 0.171, 𝑦𝑦 = 0.159 𝑚𝑚 𝑡𝑡 = 0.240 𝑠𝑠, 𝑥𝑥 = 0.172 𝑚𝑚, 𝑦𝑦 = 0.138 𝑚𝑚 

  
Σχήμα 3.14: Αποτύπωση των αλλαγών στο πλέγμα για διάφορες χρονικές στιγμές για χρονικό βήμα 0.0001 s και 

απενεργοποιημένο remeshing, μέρος Α. 
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𝑡𝑡 = 0.260 𝑠𝑠, 𝑥𝑥 = 0.172 𝑚𝑚, 𝑦𝑦 = 0.133 𝑚𝑚 𝑡𝑡 = 0.262 𝑠𝑠, 𝑥𝑥 = 0.172 𝑚𝑚, 𝑦𝑦 = 0.132 𝑚𝑚 

  
Σχήμα 3.15: Αποτύπωση των αλλαγών στο πλέγμα για διάφορες χρονικές στιγμές για χρονικό βήμα 0.0001 s και 

απενεργοποιημένο remeshing, μέρος Β. Στο τελευταίο στιγμιότυπο έχουμε κατάρρευση του πλέγματος. 

Στα Σχήμα 3.14 και Σχήμα 3.15 η αιτία της κατάρρευσης του πλέγματος είναι όμοια με την περίπτωση 
του υψηλού χρονικού βήματος. Η διαφορά εδώ είναι, πως επειδή ακριβώς δεν υπάρχει remeshing, 
μπορούμε να δούμε με ευκολία το ίδιο φαινόμενο που λαμβάνει χώρα σε μερικά μόνο κελιά της 
προηγούμενης περίπτωσης να γίνεται εδώ για μεγάλο αριθμό κελιών ταυτόχρονα. Έτσι, σε κάθε 
χρονικό βήμα έχουμε αύξηση του skewness των κελιών μέχρι τελικά την κατάρρευση τουλάχιστον ενός 
κελιού. Το κελί που καταρρέει βρίσκεται κατάντι της κίνησης του αντικειμένου, ακριβώς δίπλα σε αυτό. 
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Τέλος στο Σχήμα 3.16 βλέπουμε μερικά στιγμιότυπα από τη διαδικασία της επιτυχημένης 
αναδημιουργίας πλέγματος (remeshing). 

𝑡𝑡 = 0.0001 𝑠𝑠, 𝑥𝑥 = 0.170 𝑚𝑚,𝑦𝑦 = 0.200 𝑚𝑚 𝑡𝑡 = 0.0100 𝑠𝑠, 𝑥𝑥 = 0.170 𝑚𝑚,𝑦𝑦 = 0.175 𝑚𝑚 

  
𝑡𝑡 = 0.2000 𝑠𝑠, 𝑥𝑥 = −0.134 𝑚𝑚,𝑦𝑦 = −0.104 𝑚𝑚 𝑡𝑡 = 0.2097 𝑠𝑠, 𝑥𝑥 = −0.138 𝑚𝑚,𝑦𝑦 = 0.003 𝑚𝑚 

  
Σχήμα 3.16: Αποτύπωση των αλλαγών στο πλέγμα για διάφορες χρονικές στιγμές για χρονικό βήμα 0.0001 s.. Στο τελευταίο 

στιγμιότυπο έχουμε τερματισμό της προσομοίωσης. 

Παρατηρούμε πως με τις σωστές ρυθμίσεις και το κατάλληλο χρονικό βήμα η αναδημιουργία 
πλέγματος είναι πετυχημένη δίνοντας μας πλέγμα σταθερής ποιότητας μέχρι το τέλος της 
προσομοίωσης όπου έχουμε «σύγκρουση»  με το πτερύγιο. Στο σημείο αυτό η προσομοίωση σταματά 
επειδή δε γίνεται να διασταυρωθούν τα δύο στρώματα στοιχείων που περικλείουν το ψάρι-αντικείμενο 
και το πτερύγιο του υδροστροβίλου. Τα στοιχεία του ρευστού που βρίσκονται ανάμεσα στις δύο ζώνες, 
κατάντι της κίνησης του ψαριού-αντικειμένου, συμπιέζονται συνεχώς με το skewness να αυξάνεται 
αντίστοιχα. Τελικώς έχουμε πάλι κατάρρευση του πλέγματος λόγω κατάρρευσης τουλάχιστον ενός 
στοιχείου όμοια με τις προηγούμενες δύο περιπτώσεις. 
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Στη συνέχεια, παρουσιάζονται μέσω διαγραμμάτων τα αποτελέσματα όλων των προσομοιώσεων που 
πραγματοποιήθηκαν. Τα αποτελέσματα έχουν ομαδοποιηθεί σύμφωνα με το σχήμα του αντικειμένου, 
έτσι ώστε κάθε ομάδα αποτελεσμάτων να αφορά διαφορετικό σχήμα αντικειμένου. Μέσα στην ομάδα 
αποτελεσμάτων μεταβάλλονται το βάρος και η θέση εκκίνησης του αντικειμένου. Επιλέχθηκαν τρεις 
θέσεις εκκίνησης, οι συντεταγμένες των οποίων φαίνονται στον Πίνακας 3.7. 

 Θέση 1 Θέση 2 Θέση 3 
𝒙𝒙 (𝒎𝒎𝒎𝒎) 170 250 330 
𝒚𝒚 (𝒎𝒎𝒎𝒎) 200 200 200 

Πίνακας 3.7: Συντεταγμένες σημείων εκκίνησης των αντικειμένων που χρησιμοποιήθηκαν στις προσομοιώσεις. 

Κάθε ομάδα αποτελεσμάτων αποτελείται από τρία σχήματα. Στο πρώτο σχήμα, παρίστανται οι πορείες 
των αντικειμένων στο xy επίπεδο σε συνδυασμό με απεικόνιση της γεωμετρία του υδροστροβίλου. 
Επίσης, στο πρώτο σχήμα, παρίσταται και η γωνιακή θέση του αντικειμένου 𝛼𝛼(°) όπως ορίζεται με 
βάση το παρακάτω Σχήμα 3.17. 

 

Σχήμα 3.17: Γωνιακή θέση αντικειμένου. 

Στο δεύτερο σχήμα μιας ομάδας αποτελεσμάτων, παρουσιάζονται οι ταχύτητες 𝑢𝑢𝑥𝑥 και 𝑢𝑢𝑦𝑦 των 
αντικειμένων σε σχέση με το χρόνο. Τέλος στο τρίτο σχήμα, παρουσιάζονται ο προσανατολισμός του 
αντικειμένου 𝜃𝜃𝑧𝑧 (°) και η γωνιακή ταχύτητα του αντικειμένου 𝜔𝜔𝑧𝑧 (𝑟𝑟𝑟𝑟𝑟𝑟/𝑠𝑠𝑠𝑠𝑠𝑠).  

Στον Πίνακας 3.1 οι σημειωμένες με κόκκινο περιπτώσεις δεν ήταν δυνατόν να προσομοιωθούν 
επιτυχώς ούτε με την τεχνική overset, ούτε και με την τεχνική remeshing. Συγκεκριμένα τα αντικείμενα, 
από τις πρώτες επαναλήψεις εκτελούσαν μια ταλαντωτική κίνηση, κάθετη στην ταχύτητα του πεδίου 
ροής η οποία πολύ γρήγορα αυξανόταν σε πλάτος. Αποτέλεσμα ήταν σε μόλις 10-15 επαναλήψεις, 
ανεξαρτήτου χρονικού βήματος η προσομοίωση να τερματίζεται. Στην περίπτωση του overset, το 
αντικείμενο εκτοξευόταν έξω από τη γεωμετρία του υδροστροβίλου. Στην περίπτωση αναδημιουργίας 
πλέγματος (remeshing), το αντικείμενο κατέληγε σε κάποιο σημείο εντός του υδροστροβίλου αρκετά 
δεξιότερα ή αριστερότερα από τη θέση εκκίνησης. Το πλέγμα κατέρρεε με τρόπο όμοιο με το Σχήμα 
3.15. 
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3.3 Αποτελέσματα για σφαιρικό σωματίδιο διαμέτρου 6 mm 
 
Στην περίπτωση του σωματιδίου διαμέτρου 6 mm πραγματοποιήθηκαν προσομοιώσεις με τρία βάρη: 
20 gr, 50 gr και 100 gr. 

Όπως φαίνεται στο Σχήμα 3.18, το σωματίδιο των 20 gr καταλήγει πάντοτε στο εσωτερικό του δρομέα 
όπου στη συνέχεια προσέκρουε σε κάποια πτερύγιο. Επιπλέον, στην περίπτωση εκκίνησης από τη θέση 
1, λόγω και της ανακυκλοφορίας που υπάρχει, όπως φαίνεται στο Σχήμα 3.9, το σωματίδιο εκτελεί μια 
σπειροειδής κίνηση στο τέλος της τροχιάς του. 

Το σωματίδιο των 50 gr, καταλήγει στο εσωτερικό του δρομέα μόνο από τη θέση εκκίνησης 1, όπως 
φαίνεται στο Σχήμα 3.18. Από τις άλλες δύο θέσεις εκκίνησης, φυγοκεντρίζεται και προσκρούει στο 
κέλυφος του υδροστροβίλου. 

Το σωματίδιο των 100 gr, προσκρούει στο κέλυφος του υδροστροβίλου, λόγω φυγοκέντρισης, ήδη από 
την 1η θέση εκκίνησης, όπως φαίνεται στο Σχήμα 3.18. Δεν προσομοιώθηκε η τροχιά από τις άλλες δύο 
θέσεις εκκίνησης, αφού περιμένουμε πάλι πρόσκρουση, απλά σε νωρίτερο χρονικό σημείο.  

Ακόμα, εξετάζοντας στο Σχήμα 3.18 τα διαγράμματα γωνιακής θέσης-χρόνου τροχιάς παράλληλα με τις 
γραμμές ροής του πεδίου που φαίνονται στο Σχήμα 3.10, μπορούμε να εντοπίσουμε τις διαφορές 
μεταξύ του χρόνου των τροχιών των σωματιδίων και του χρόνου των γραμμών ροής. Παρατηρούμε πως 
τα σωματίδια εκτελούν την τροχιά τους αρκετά πιο αργά από το χρόνο των γραμμών ροής, με την τάση 
αυτή να αυξάνει όσο αυξάνεται το βάρος του σωματιδίου. 

Στο Σχήμα 3.19, μπορούμε να δούμε την εξέλιξη της 𝑢𝑢 και 𝑣𝑣 ταχύτητας για κάθε σωματίδιο ξεχωριστά. 
Σε κάθε περίπτωση η 𝑢𝑢 ταχύτητα ξεκινάει από το 0, όπως αναμένεται, και αρχίζει να λαμβάνει 
σημαντικές τιμές μετά την έξοδο του σωματιδίου από τον αγωγό εισόδου. Για τη θέση εκκίνησης 1, στα 
σωματίδια 20 gr και 50 gr έχει οριστεί η αρχική ταχύτητα 𝑣𝑣 μηδενική, ενώ  για το σωματίδιο 100 gr η 
αρχική ταχύτητα 𝑣𝑣 ορίστηκε στα −3 𝑚𝑚/𝑠𝑠. Παρατηρούμε πως αυτό δεν επηρεάζει τόσο την 
προσομοίωση αφού μετά από 50-60 επαναλήψεις οι ταχύτητες για όλα τα σωματίδια αποκτάνε 
παραπλήσιες τιμές. Ακόμη, εξετάζοντας παράλληλα τα διαγράμματα Σχήμα 3.9, Σχήμα 3.18 και Σχήμα 
3.19, διαπιστώνουμε πως τα σωματίδια κινούνται σύμφωνα με τις ταχύτητες του πεδίου, όπως 
αναμένουμε. 

Τέλος, όπως φαίνεται στο Σχήμα 3.20, το σωματίδιο για όλες τις περιπτώσεις περιστρέφεται ελάχιστα. 
Αυτό είναι αναμενόμενο, λόγω του ακτινικά συμμετρικού σχήματος και των συμμετρικών 
αλληλοαναιρούμενων δυνάμεων που ασκούνται στην επιφάνεια του.  
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Σχήμα 3.18: Τροχιές για κυκλικό αντικείμενο d=6 mm από τρείς θέσεις εκκίνησης και για δύο διαφορετικά βάρη. Αριστερά η 

κίνηση του αντικειμένου στο xy επίπεδο και δεξιά η γωνιακή θέση του αντικειμένου σε σχέση με το χρόνο. 
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Σχήμα 3.19: Ταχύτητες ux και uy για κυκλικό αντικείμενο d=6 mm από τρείς θέσεις εκκίνησης και για δύο διαφορετικά βάρη σε 

σχέση με το χρόνο. 
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Σχήμα 3.20: Προσανατολισμός και γωνιακή ταχύτητα για κυκλικό αντικείμενο d=6 mm από τρείς θέσεις εκκίνησης και για δύο 

διαφορετικά βάρη σε σχέση με το χρόνο. 
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3.4 Αποτελέσματα για κυλινδρικό αντικείμενο πλάτους 6 mm και μήκους 12 mm 
 
Στην περίπτωση αυτή πραγματοποιήθηκαν προσομοιώσεις με δύο βάρη: 100 gr και 150 gr. Επιπλέον, 
εξετάστηκαν τόσο η μέθοδος overset όσο και η μέθοδος remeshing. 

Όπως φαίνεται στο Σχήμα 3.21, τα αποτελέσματα των πορειών με τις δύο μεθόδους είναι πολύ κοντινά 
για τις θέσεις εκκίνησης 2 και 3. Μεγάλη διαφορά έγκειται στην περίπτωση εκκίνησης από τη θέση 1. 
Το ψάρι-αντικείμενο 100 gr εισέρχεται στο δρομέα και με τις δυο τεχνικές, όμως στην περίπτωση του 
overset πραγματοποιεί πολύ διαφορετική πορεία, αφου εκτελεί μια πλήρη περιστροφή γύρω από το 
δρομέα. Επιπλέον, το αντικείμενο των 150 gr με τη μέθοδο overset εισέρχεται στο δρομέα, σε αντίθεση 
με τη μέθοδο remeshing όπου προσκρούει στο κέλυφος. Οι διαφορές στις δύο μεθόδους έγκεινται στο 
διαφορετικό πεδίο ροής που διαμορφώνεται με τη μέθοδο overset, ειδικότερα κοντά στην περιοχή του 
δρομέα. Το διαφορετικό πεδίο ροής οφείλεται στην περιστροφή του δρομέα. Επίσης, αξίζει να 
σημειωθεί, πως με τη μέθοδο overset σε όσες περιπτώσεις το αντικείμενο οδηγήθηκε στο εσωτερικό 
του δρομέα δεν προσέκρουσε σε κάποιο πτερύγιο, αλλά ακολουθούσε την περιστροφή του πεδίου 
μένοντας σταθερά μακριά από τα πτερύγια. 

Στο Σχήμα 3.22, μπορούμε να δούμε την εξέλιξη της 𝑢𝑢 και 𝑣𝑣 ταχύτητας για κάθε αντικείμενο ξεχωριστά. 
Σε κάθε περίπτωση η 𝑢𝑢 ταχύτητα ξεκινάει από το 0, όπως αναμένεται, και αρχίζει να λαμβάνει 
σημαντικές τιμές μετά την έξοδο του σωματιδίου από τον αγωγό εισόδου. Για όλες τις θέσεις 
εκκίνησης, έχει οριστεί η αρχική ταχύτητα 𝑣𝑣 των σωματιδίων στα −3 𝑚𝑚/𝑠𝑠.  

Ακόμα, από το Σχήμα 3.23, φαίνεται πως τα αντικείμενα περιστρέφονται αρκετά περισσότερο στη 
διάρκεια της τροχιάς τους σε σχέση με το σφαιρικό σωματίδιο. Αυτό είναι αναμενόμενο, λόγω της 
μορφής του αντικειμένου. 

Τέλος, αξίζει να σημειωθεί πως δοκιμάστηκε η προσομοίωση του αντικειμένου με βάρος 50 gr. Όπως 
αναφέρθηκε και προηγουμένως, το αντικείμενο εκτελούσε μία ταλαντωτική κίνηση (άξονας x’x) κάθετη 
στην προβλεπόμενη. Σε μόλις μερικά χρονικά βήματα η προσομοίωση αποτύγχανε, ενώ ο αριθμός των 
χρονικών βημάτων ήταν ανεξάρτητος του μεγέθους του βήματος.  
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Σχήμα 3.21: Τροχιές για κυλινδρικό αντικείμενο c=6 mm l= 12 mm από τρείς θέσεις εκκίνησης και για δύο διαφορετικά βάρη 

και τις τεχνικές remeshing και overset. Αριστερά η κίνηση του αντικειμένου στο xy επίπεδο και δεξιά η γωνιακή θέση του 
αντικειμένου σε σχέση με το χρόνο. 
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Σχήμα 3.22: Ταχύτητες ux και uy για κυλινδρικό αντικείμενο c=6 mm l=12 mm από τρείς θέσεις εκκίνησης και για δύο 

διαφορετικά βάρη και για τις δύο τεχνικές remeshing και overset σε σχέση με το χρόνο. 
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c=6 mm l=12 mm 1 x=170 mm y=200 mm ux uy

Time (s)

u x(m
/s

ec
)

u y(m
/s

ec
)

0 0.1 0.2 0.3 0.4 0.5-3
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c=6 mm l=12 mm 3 x=330 mm y=200 mm ux uy
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Σχήμα 3.23: Προσανατολισμός και γωνιακή ταχύτητα για κυλινδρικό αντικείμενο c=6 mm l=12 mm από τρείς θέσεις εκκίνησης 

και για δύο διαφορετικά βάρη και για τις δύο τεχνικές remeshing και overset σε σχέση με το χρόνο. 

Time (s)

z(o )
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3.5 Αποτελέσματα για κυλινδρικό αντικείμενο πλάτους 3 mm και μήκους 12 mm 
 

Στην περίπτωση αυτού του αντικειμένου πραγματοποιήθηκαν προσομοιώσεις με δύο βάρη: 100 gr και 
150 gr. 

Όπως φαίνεται στο Σχήμα 3.24, το σωματίδιο των 100 gr καταλήγει στο εσωτερικό του δρομέα στις 
περιπτώσεις εκκίνησης από τις θέσεις 1 και 2. Από τις ίδιες θέσεις το αντικείμενο 150 gr εκτελεί 
παρόμοιες τροχιές, όμως λόγω της φυγοκέντρισης, στην περίπτωση εκκίνησης από τη θέση 2, τελικά 
συγκρούεται με το κέλυφος. Από την 3η θέση εκκίνησης και τα δύο αντικείμενα συγκρούονται με το 
κέλυφος πριν ξεπεράσουν τις 180ο σε γωνιακή θέση.  

Στο Σχήμα 3.25, μπορούμε να δούμε την εξέλιξη της u και v ταχύτητας για κάθε αντικείμενο ξεχωριστά. 
Σε κάθε περίπτωση η 𝑢𝑢 ταχύτητα ξεκινάει από το 0, όπως αναμένεται, και αρχίζει να λαμβάνει 
σημαντικές τιμές μετά την έξοδο του σωματιδίου από τον αγωγό εισόδου. Για όλες τις θέσεις 
εκκίνησης, έχει οριστεί η αρχική ταχύτητα 𝑣𝑣 των σωματιδίων στα −3 𝑚𝑚/𝑠𝑠. Με ταυτόχρονη εποπτεία 
των διαγραμμάτων στα Σχήμα 3.24, Σχήμα 3.25 και Σχήμα 3.9 μπορούμε να δούμε πως τα αντικείμενα 
αναπτύσσουν ταχύτητες παραπλήσιες με αυτές του πεδίου ροής, όπως αναμένεται. Μία ακόμα ένδειξη 
που επιβεβαιώνει την αρχική παρατήρηση είναι πως τα αντικείμενα αναπτύσσουν παρόμοιες τιμές 
ταχυτήτων όταν ακολουθούν παρόμοιες τροχιές, και επομένως περνάνε από τα ίδια σημεία του 
πεδίου, ανεξαρτήτους του βάρους τους. 

Ακόμα, όπως φαίνεται στο Σχήμα 3.26, το αντικείμενο για όλες τις περιπτώσεις περιστρέφεται αρκετά 
περισσότερο από ότι το κυλινδρικό αντικείμενο. Η περιστροφή του δεν παρουσιάζει πάντως 
σημαντικές διαφορές από ότι του κυλινδρικού αντικειμένου c=6 mm, l=12 mm (Σχήμα 3.23), παρότι το 
aspect ratio διπλασιάζεται. Αυτό εξηγείται από το γεγονός, πως η ροπή αδράνειας και για τα δύο είδη 
αντικειμένου έχει τιμές ίδια τάξης μεγέθους. 

Τέλος, αξίζει να σημειωθεί πως δοκιμάστηκε η προσομοίωση του αντικειμένου με βάρος 50 gr χωρίς 
επιτυχία. Η προσομοίωση αποτύγχανε με το ίδιο τρόπο που αναφέρθηκε στην περίπτωση c=6 mm,  
l=12 mm και βάρος 50 gr.  
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Σχήμα 3.24: Τροχιές για κυλινδρικό αντικείμενο c=3 mm l= 12 mm από τρείς θέσεις εκκίνησης και για δύο διαφορετικά βάρη. 

Αριστερά η κίνηση του αντικειμένου στο xy επίπεδο και δεξιά η γωνιακή θέση του αντικειμένου σε σχέση με το χρόνο. 
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Σχήμα 3.25: Ταχύτητες ux και uy για κυλινδρικό αντικείμενο c=3 mm l=12 mm από τρείς θέσεις εκκίνησης και για δύο 

διαφορετικά βάρη σε σχέση με το χρόνο. 
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Σχήμα 3.26: Προσανατολισμός και γωνιακή ταχύτητα για κυλινδρικό αντικείμενο c=3 mm l=12 mm από τρείς θέσεις εκκίνησης 

και για δύο διαφορετικά βάρη σε σχέση με το χρόνο. 
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3.6 Αποτελέσματα για κυλινδρικό αντικείμενο πλάτους 6 mm και μήκους 24 mm 
 
Στην περίπτωση αυτού του αντικειμένου πραγματοποιήθηκαν προσομοιώσεις με ένα βάρος 250 gr. 
Επίσης χρησιμοποιήθηκαν και οι δύο τεχνικές, overset και remeshing.  

Όπως φαίνεται στο Σχήμα 3.27, οι τροχιές για τις δύο τεχνικές, remeshing και overset, σχεδόν 
ταυτίζονται για τις θέσεις εκκίνησης 1 και 3. Για τη θέση εκκίνησης 2 καταγράφεται παρόμοια πορεία 
μέχρι και τη γωνιακή θέση των -170ο , στη συνέχεις οι δύο μέθοδοι παρουσιάζουν απόκλιση αλλά το 
τελικό αποτέλεσμα είναι το ίδιο, με το αντικείμενο να προσκρούει στο κέλυφος του υδροστροβίλου. 

Στα Σχήμα 3.28 και Σχήμα 3.29, μπορούμε να δούμε την εξέλιξη της u και v ταχύτητας για κάθε 
αντικείμενο και μέθοδο ξεχωριστά. Σε κάθε περίπτωση η u ταχύτητα ξεκινάει από το 0, όπως 
αναμένεται, και αρχίζει να λαμβάνει σημαντικές τιμές μετά την έξοδο του σωματιδίου από τον αγωγό 
εισόδου. Για όλες τις θέσεις εκκίνησης, έχει οριστεί η αρχική ταχύτητα v των σωματιδίων στα -3 m/s. 
Όπως αναμένεται, ούτε εδώ παρατηρούμε σημαντικές διαφορές μεταξύ των μεθόδων, στην ταχύτητα 
που αναπτύσσουν τα αντικείμενα. Αξίζει ωστόσο, να αναφερθεί, η ταλαντωτική συμπεριφορά της 
ταχύτητας, για το αντικείμενο που εκκινεί από τη θέση 3 με την τεχνική overset. Η ταλάντωση 
αποδίδεται στο μέγεθος του χρονικού βήματος. 

Ακόμα, όπως φαίνεται στο Σχήμα 3.30, τα αποτελέσματα των δύο μεθόδων για την περιστροφή του 
αντικειμένου δε διαφέρουν σημαντικά. Επιπλέον, μπορούμε να πούμε πως το αντικείμενο δεν εκτελεί 
μεγάλη περιστροφή στη διάρκεια της κίνησης του, παρά το υψηλό aspect ratio. Αυτό εξηγείται, από τη 
μεγάλη ροπή αδράνειας που χαρακτηρίζει το αντικείμενο.  

Τέλος, αξίζει να σημειωθεί πως δοκιμάστηκε η προσομοίωση του αντικειμένου με βάρος 100 gr και 150 
gr. Οι προσομοιώσεις αυτές απέτυχαν με τον ίδιο τρόπο, όπως των αντικειμένων c=3 mm, l=12 mm με 
βάρος 50 gr και c=6 mm,l=12 mm με βάρος 50 gr.  
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Σχήμα 3.27: Τροχιές για κυλινδρικό αντικείμενο c=12 mm l= 24 mm και βάρους 250 gr από τρείς θέσεις εκκίνησης και τις δύο 

τεχνικές remeshing και overset. Πάνω η κίνηση του αντικειμένου στο xy επίπεδο και κάτω η γωνιακή θέση του αντικειμένου σε 
σχέση με το χρόνο. 
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Σχήμα 3.28: Ταχύτητες ux και uy για κυλινδρικό αντικείμενο c=6 mm l=24 mm και βάρος 250 gr από τρείς θέσεις εκκίνησης και 

τις δύο τεχνικές remeshing και overset σε σχέση με το χρόνο 

Στο παραπάνω διάγραμμα δεν περιλαμβάνεται η περίπτωση της εκκίνησης από τη θέση 3 με την 
τεχνική overset για εποπτικούς λόγους. Ακολουθεί το ίδιο διάγραμμα συμπεριλαμβανομένου και της 
προαναφερθείσας περίπτωσης: 

 

Σχήμα 3.29: Ταχύτητες ux και uy για κυλινδρικό αντικείμενο c=6 mm l=24 mm και βάρος 250 gr από τρείς θέσεις εκκίνησης και 
τις δύο τεχνικές remeshing και overset σε σχέση με το χρόνο 
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3 x=330 mm uy overset

c=6 mm l=12 mm w=250 grams ux uy
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Σχήμα 3.30: Προσανατολισμός και γωνιακή ταχύτητα για κυλινδρικό αντικείμενο c=6 mm l=24 mm και βάρος 250 gr από τρείς 

θέσεις εκκίνησης σε σχέση με το χρόνο. 
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3.7 Σύγκριση αποτελεσμάτων με γραμμές ροής πεδίου 
 

Tέλος, προκειμένου να γίνει καλύτερα αντιληπτή η διαφορά των τροχιών των αντικειμένων, σε σχέση 
με τις τροχιές του πεδίου ροής κατασκευάστηκαν κατάλληλα διαγράμματα. Στα διαγράμματα 
αποτυπώνονται ταυτόχρονα οι ταχύτητες του πεδίου ροής (𝑢𝑢, 𝑣𝑣 και μέτρο ταχύτητας), οι τροχιές των 
αντικειμένων, και οι τροχιές του πεδίου ροής. Να σημειωθεί πως στην περίπτωση της τεχνικής 
αναδημιουργίας πλέγματος (remeshing) οι τροχιές του πεδίου είναι ταυτόχρονα και γραμμές ροής, 
αφου το πεδίο ροής είναι μόνιμο. Στην περίπτωση της τεχνικής overset, όπου ο δρομέας 
περιστρέφεται, το πεδίο δεν είναι μόνιμο και άρα οι τροχιές δεν ταυτίζονται με τις γραμμές ροής. Οι 
δεύτερες αλλάζουν συνεχώς στην περιοχή του δρομέα. 

Στο Σχήμα 3.31, φαίνεται το συγκριτικό των τροχιών του πεδίου ροής (overset) με τις τροχιές των 
αντικειμένων. Χρησιμοποιήθηκαν η τροχιές του κυλινδρικού σωματιδίου c=6 mm, l=12 mm για δύο 
βάρη, 100 gr και 150 gr. Με λευκό χρώμα αποτυπώνονται οι τροχιές του σωματιδίου 100 gr, και με 
κόκκινο χρώμα οι τροχιές του σωματιδίου 150 gr. 

 

  
 

Σχήμα 3.31: Σύγκριση τροχιών αντικειμένων με τις τροχιές του πεδίου ροής, τεχνική overset. Στο αριστερό διάγραμμα οι 
ισοκαμπύλες της ταχύτητας u, και στο δεξί οι ισοκαμπύλες της ταχύτητας v. 
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Στο Σχήμα 3.32, φαίνεται το συγκριτικό των τροχιών του πεδίου ροής (remeshing) με τις τροχιές των 
αντικειμένων. Χρησιμοποιήθηκαν η τροχιές του κυλινδρικού σωματιδίου c=6 mm, l=12 mm για δύο 
βάρη, 100 gr και 150 gr. Με λευκό χρώμα αποτυπώνονται οι τροχιές του σωματιδίου 100 gr, και με 
κόκκινο χρώμα οι τροχιές του σωματιδίου 150 gr. 

  
Σχήμα 3.32: Σύγκριση τροχιών αντικειμένων με τις τροχιές του πεδίου ροής, τεχνική overset. Στο αριστερό διάγραμμα οι 

ισοκαμπύλες της ταχύτητας u, και στο δεξί οι ισοκαμπύλες της ταχύτητας v. 

Γενικότερα, οι τροχιές των αντικειμένων φαίνεται αρχικά να ακολουθούν τις γραμμές ροής τόσο στην 
περίπτωση της τεχνικής remeshing όσο και στην περίπτωση της τεχνικής overset. Μόνο όταν περνάμε 
σε περιοχές διαφορετικού μέτρου ταχύτητας ή φοράς, οι τροχιές των αντικειμένων ξεκινάνε να 
παρουσιάζουν αποκλίσεις από αυτές των τροχιών του πεδίου. Το φαινόμενο αυτό φαίνεται καλύτερα 
στην περίπτωση του βαρύτερου αντικειμένου. Αιτία της συμπεριφοράς αυτής, είναι τα αδρανειακά 
φαινόμενα που λαμβάνουν χώρα. Τα αδρανειακά φαινόμενα είναι εντονότερα για βαρύτερα 
αντικείμενα ίδιας γεωμετρίας, αφού έχουν και μεγαλύτερη αδράνεια.  

velocityX

5.45
4.47
3.49
2.51
1.53
0.55

-0.43
-1.41
-2.39
-3.37
-4.35
-5.33

velocityY

5.35
4.40
3.46
2.51
1.57
0.62

-0.32
-1.27
-2.22
-3.16
-4.11
-5.05
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4 Επίλογος 
 

4.1 Σύνοψη 
 
Στόχος της παρούσας Διπλωματικής Εργασίας ήταν η αριθμητική προσομοίωση  της τροχιάς 
διαφορετικών μοντέλων ψαριού σε έναν απλοποιημένο υδροστρόβιλο Francis δισδιάστατης ροής, με 
εμπορικό λογισμικό υπολογιστικής ρευστοδυναμικής και εφαρμογή δύο εναλλακτικών μεθόδων 
μοντελοποίησης.  Επίσης, στο πλαίσιο της εργασίας, προσδιορίστηκαν οι μηχανισμοί που οδηγούν στον 
τραυματισμό της ιχθυοπανίδας κατά τη διέλευσή της μέσω του υδροστροβίλου, με βάση τη διεθνή 
βιβλιογραφία. 

Αρχικά, έγινε μια εισαγωγή για τους υδροστροβίλους Francis, η οποία συμπεριελάμβανε πληροφορίες 
για τη γεωμετρία, τη λειτουργία, το εύρος και την έκταση της χρήσης τους. Στη συνέχεια, έγινε 
βιβλιογραφική αναφορά για τους μηχανισμούς τραυματισμού της ιχθυοπανίδας. Αναφέρθηκε ο 
διαφορετικός αντίκτυπος των διαφόρων ειδών υδροστροβίλου στην ιχθυοπανίδα. Κατόπιν, 
εξετάστηκαν ξεχωριστά οι μηχανισμοί τραυματισμού της ιχθυοπανίδας, καθώς και ο τρόπος με τον 
οποίο η φυσιολογία ενός ψαριού μπορεί να προσδώσει κάποιο μειονέκτημα ή πλεονέκτημα εναντίον 
ενός μηχανισμού τραυματισμού. Επιπλέον, παρουσιάστηκαν δεδομένα από πειράματα με ζωντανά 
ψάρια αλλά και ψάρια αισθητήρες. 

Η γεωμετρία του υδροστροβίλου κατασκευάστηκε σε περιβάλλον Solidworks. Για την μοντελοποίηση 
της κίνησης του μοντέλου ψαριού χρησιμοποιήθηκε αρχικά η μέθοδος overset (υπέρθεση πλέγματος 
ψαριού τετραεδρικών στοιχείων), και στη συνέχεια η μέθοδος αναδημιουργίας πλέγματος ή remeshing 
(πλέγμα τριγωνικών στοιχείων). Κατασκευάστηκαν δύο διαφορετικά, μη δομημένα υπολογιστικά 
πλέγματα, ένα για κάθε μέθοδο που χρησιμοποιήθηκε.  Και για τις δύο περιπτώσεις, αρχικά έγινε 
αριθμητική επίλυση του μόνιμου πεδίου ροής (steady) με το λογισμικό Ansys Fluent. Το μοντέλο 
τύρβης k-ω SST επιλέχθηκε ως το καταλληλότερο για την παρούσα εφαρμογή. Επιπλέον, επιλέχθηκε ο 
βασισμένος στην πίεση επιλύτης (pressure based solver), σε συνδυασμό με συζευγμένο σχήμα 
επίλυσης (coupled scheme). Κατόπιν, για την περίπτωση της τεχνικής overset, έγινε επίλυση του πεδίου 
ροής με περιστρεφόμενο δρομέα, και χρονικό βήμα 10-3 sec.  

Για τον υπολογισμού των τροχιών των ψαριών-αντικειμένων χρησιμοποιήθηκαν τέσσερα διαφορετικά 
μοντέλα. Αρχικά, σφαιρικά σωματίδια (κυκλικά στο δισδιάστατο πεδίο), και κατόπιν τρία διαφορετικά 
κυλινδρικά (ορθογώνια) αντικείμενα με λόγο μήκος-πλάτους από 2 έως 4. Στα αντικείμενα δόθηκε 
βάρος ανάλογο του μεγέθους τους. , Η μάζα των αντικειμένων, καθώς και η ροπή αδρανείας τους 
προσδιορίστηκαν με την εισαγωγή ενός αρχείου γλώσσας C στο Ansys Fluent. Κάθε αντικείμενο 
εισάγεται στο πεδίο ροής από τρείς διαφορετικές θέσεις εκκίνησης. Για την τεχνική overset 
χρησιμοποιήθηκε χρονικό βήμα 10^(-3) sec, ενώ για την τεχνική remeshing 10^(-4) sec. 

Αφού υπολογίστηκαν οι τροχιές όλων των αντικειμένων, δημιουργήθηκαν και παρουσιάστηκαν 
συγκριτικά διαγράμματα, ως προς τη θέση εκκίνησης, το βάρος και τη χρησιμοποιούμενη μέθοδος 
προσομοίωσης της κίνησής τους. Στα διαγράμματα αυτά εξετάζεται η χρονική μεταβολή της θέσης, της 
ταχύτητας και του προσανατολισμού των αντικειμένων κατα μήκος της τροχιάς τους. Τέλος,  έγιναν 
συγκριτικά διαγράμματα των τροχιών των αντικειμένων με τις γραμμές ροής του πεδίου ροής. 
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Η διαδικασία υπολογιστικής μοντελοποίησης που αναπτύχθηκε και εφαρμόστηκε στην εργασία, τα 
διάφορα τεχνικά και υπολογιστικά προβλήματα που αντιμετωπίστηκαν και η εμπειρία που 
αποκτήθηκε, περιγράφονται αναλυτικά στο Παράρτημα της Εργασίας. 
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4.2 Συμπεράσματα 
 

Από τα αποτελέσματα των προσομοιώσεων λήφθηκαν τα εξής συμπεράσματα: 

• Όσο ελαφρύτερο είναι κάποιο αντικείμενο τόσο πιο πιθανό είναι να ακολουθήσει μια γραμμή 
ροής στο σπειροειδές κέλυφος, καταλήγοντας στο εσωτερικό του δρομέα. 

• Το κυλινδρικό σχήμα ευνοεί την πορεία του αντικειμένου προς το εσωτερικό του δρομέα και 
για μεγαλύτερη μάζα αντικειμένου, ιδιαίτερα για λόγο διαστάσεων 1:2 

• Τα κυλινδρικά αντικείμενα περιστρέφονται περισσότερο από ότι τα σφαιρικά. 
• Τα μεγαλύτερα σε μέγεθος αντικείμενα απαιτούσαν μεγαλύτερες επιφανειακές πυκνότητες για 

την εκκίνηση της προσομοίωσης, διαφορετικά το αντικείμενο εκτελούσε μια ταλάντωση 
κάθετης στο διάνυσμα της ταχύτητας του πεδίου ροής και η προσομοίωση αποτύγχανε. 

• Η τεχνική overset με την τεχνική remeshing δεν παρουσιάζουν σημαντικές διαφορές ως προς τα 
αποτελέσματα τους. Αυτό γίνεται καλύτερα αντιληπτό για τροχιές αντικειμένων σε σημεία του 
πεδίου ροής που επηρεάζονται λιγότερο από την περιστροφική κίνηση του δρομέα, αφού, για 
τη μία μέθοδο ο δρομέας περιστρέφεται ενώ για την άλλη όχι. 

• Η μέθοδος remeshing μπορεί να δώσει αποτελέσματα μόνο χρησιμοποιώντας μικρό χρονικό 
βήμα της τάξης του 10-4 sec. Χρήση μεγαλύτερου βήματος προκαλεί  κατάρρευση του 
πλέγματος. Η μέθοδος overset, ενώ για πλέγμα ίδιας πυκνότητας με την τεχνική remeshing 
απαιτεί όμοιο χρονικό βήμα ώστε να εξαχθούν αποτελέσματα ίδιας ακρίβειας, μπορεί να 
λειτουργήσει ικανοποιητικά και με μεγαλύτερα χρονικά βήματα. 

• Οι τροχιές των αντικειμένων αρχικά συμπίπτουν με τις γραμμές ροής του πεδίου, αλλά 
αρχίζουν να αποκλίνουν κατά την σπειροειδή κίνηση,  λόγω της αδράνειάς τους.  

• Όλα τα αντικείμενα που εισήχθησαν στο δρομέα με την τεχνική remeshing (ακίνητος δρομέας) 
φαίνεται να προσκρούουν σε κάποιο πτερύγιο. Προκειμένου να αποφύγει τη σύγκρουση ένα 
ψάρι έπρεπε να ακολουθήσει σημαντικούς ελιγμούς της γραμμής ροής σε ελάχιστο χώρο. Η 
μέθοδος remeshing δε μπορεί να εφαρμοστεί με στρεφόμενο δρομέα στις δύο διαστάσεις, 
διότι ο σχεδιασμός των πτερυγίων είναι τυχαίος, και η μόνη επιλογή ενεργοποίησης 
περιστροφής είναι με τον υπολογισμό των ασκούμενων δυνάμεων στις ακμές των πτερυγίων. 
Αυτό μπορεί να επιτευχθεί όπως υπολογίζονται οι δυνάμεις στις ακμές του ψαριού-
αντικειμένου. Ο υπολογισμός των δυνάμεων λοιπόν, θα είχε νόημα μόνο σε έναν κατάλληλα 
σχεδιασμένο τρισδιάστατο δρομέα. 

• Όλα τα αντικείμενα που εισήχθησαν στο εσωτερικό του δρομέα με την τεχνική οverset 
(περιστρεφόμενος δρομέας) δεν προσέκρουσαν σε κάποιο πτερύγιο. Ακόμα και τα βαρύτερα 
αντικείμενα, είχαν το χώρο και το χρόνο να ελιχθούν στο πεδίο ροής ακολουθώντας τις 
γραμμές ροής του πεδίου, αποφεύγοντας έτσι τον κινούμενο δρομέα. Θεωρείται πως η μόνη 
περίπτωση που θα μπορούσε κάποιο αντικείμενο να συγκρουσθεί με το δρομέα είναι τη στιγμή 
της εισόδου του σε αυτόν. 

• Τελικά, η μέθοδος overset αποδεικνύεται ανώτερη της τεχνικής remeshing όταν 
χρησιμοποιούμε δισδιάστατο πεδίο. Η ανωτερότητα της μεθόδους, πιστώνεται τόσο στο 
υπολογιστικό κομμάτι (είναι λιγότερη ακριβή μέθοδος) όσο και στο κομμάτι πιστότητας της 
προσομοίωσης, αφού επιτρέπεται η ρεαλιστικότερη προσομοίωση της κίνησης του δρομέα σε 
σχέση με την τεχνική remeshing. Όμως για τη μετάβαση σε ένα τρισδιάστατο πρόβλημα μόνο η 
τεχνική remeshing μπορεί να χρησιμοποιηθεί.  
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4.3 Προτάσεις για περεταίρω έρευνα  
 
Κατά τη διάρκειας συγγραφής της παρούσας διπλωματικής εργασίες προέκυψαν διάφορες ιδέες, που 
όμως δε μπόρεσαν να εφαρμοστούν λόγω περιορισμού χρόνου. 

Καταρχάς, θα μπορούσε να δημιουργηθεί ένα απλό, τρισδιάστατο μοντέλο του υδροστροβίλου, απλά 
προβάλλοντας την υπάρχουσα δισδιάστατη γεωμετρία στην κατεύθυνση, z, για κάποιο συγκεκριμένο 
μήκος.  Στο πεδίο αυτό θα μπορεί να προσομοιωθεί η τροχιά τρισδιάστατων αντικειμένων, με 
πραγματικές διαστάσεις.   

Για την προσομοίωση αυτών τον τροχιών θα χρειαστεί η εισαγωγή αρχείων UDF στο Ansys Fluent, τα 
οποία θα προσδιορίζουν τη μάζα των αντικειμένων, αλλά και τα αδρανειακά του χαρακτηριστικά. Από 
το ίδιο αρχείο, είναι δυνατόν να ορισθεί η καταγραφή των αντίστοιχων δεδομένων που συλλέχθηκαν 
στην παρούσα εργασία.  

Αξίζει να εξεταστεί αρχικά, αν παρατηρούνται τα ίδια φαινόμενα αστάθειας με την περίπτωση του 
δισδιάστατου μοντέλου.  Στη συνέχεια, τα αποτελέσματα μπορούν να συγκριθούν με αυτά των 
τεχνικών 2D overset, και 2D remeshing.  

Επίσης, επιλέγοντας την εξωτερική επιφάνεια του αντικειμένου, είναι δυνατόν ο χρήστης να ορίσει την 
καταγραφή της τιμής όποιου μεγέθους επιθυμεί σε αυτή την επιφάνεια. Μπορούν έτσι να 
καταγραφούν οι πιέσεις και οι δυνάμεις που δέχεται το σώμα του ψαριού-αντικειμένου κατά τη 
διάρκειας της κίνησης του. 

Σε επόμενη φάση, θα πρέπει να ενσωματωθούν όλα τα παραπάνω σε ένα πραγματικό τρισδιάστατο 
μοντέλο υδροστροβίλου και στο αντίστοιχο πεδίο ροής σε αυτό. Η σύγκριση των αποτελεσμάτων με τα 
πραγματικά δεδομένα που έχουν συλλέξει ψάρια-αισθητήρες, θα μπορούσε να οδηγήσει σε ασφαλή 
συμπεράσματα σχετικά με την πιστότητα της προσομοίωσης. 

Ενδιαφέρον έχει επίσης η ανάπτυξη ενός κώδικα για τη μοντελοποίηση και ανάλυση της σύγκρουσης 
του αντικειμένου με κάποιο εσωτερικό στερεό όριο του υδροστροβίλου (κέλυφος ή πτερύγιο). Έτσι, η 
προσομοίωση δε θα σταματά στην περίπτωση σύγκρουσης, ενώ θα καταγράφονται και οι ασκούμενες 
δυνάμεις στο αντικείμενο. 

Τέλος, θα μπορούσε να μοντελοποιηθεί και η δυνατότητα παραμόρφωσης του σχήματος του 
αντικειμένου (π.χ. καμπύλωση), με κατάλληλο λογισμικό πεπερασμένων στοιχείων, ώστε να 
προσομοιωθεί ακόμη πιο ρεαλιστικά η κίνηση ενός πραγματικού ψαριού εντός του υδροστροβίλου. 
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5 Παράρτημα A 
 

Τυπογραφικές συμβάσεις: 

Για λόγους σύμπτυξης αλλά και διευκόλυνσης του αναγνώστη έχουν χρησιμοποιηθεί μερικές 
τυπογραφικές συμβάσεις με τη μορφή συμβόλων. Ο ακόλουθος πίνακα περιέχει τα σύμβολα που θα 
χρησιμοποιηθούν και τη σημασία του. 

Σύμβολο Σημασία 
 Κοιτάχτε στο δεντρικό μενού 
 Παρατεταμένο αριστερό κλικ στο αντικείμενο που ακολουθεί 

 Κάντε δεξί κλικ στο αντικείμενο που ακολουθεί 
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5.1 Τεχνική remeshing 
 

5.1.1 Κατασκευή γεωμετρίας 
 

Το πρόβλημα μας περιλάμβανε ένα δισδιάστατο αρχείο γεωμετρίας το οποίο αποτελούνταν από: 

• Το κέλυφος του υδροστροβίλου (volute ή casing) 
• Το δρομέα (runner) 
• Το ψάρι-αντικείμενο 
• Σχεδιασμό offset των προαναφερθέντων, απαιτούμενος για την εφαρμογή της μεθόδου. 

Η κατασκευή της γεωμετρίας έγινε εξ ολοκλήρου στο σχεδιαστικό πρόγραμμα Dassault Systemes 
SolidWorks 2016. Ακολουθούν τα βήματα αναλυτικά: 

 

Αρχικά ανοίγουμε το πρόγραμμα Solidworks. Από την πάνω γραμμή εργαλείων επιλέγουμε 
File→New→Part 
Πλέον αντικρίζουμε ένα περιβάλλον σαν αυτό στο Σχήμα Π.1. 
 

 

Σχήμα 5.1: Το περιβάλλον εργασία του σχεδιαστικού προγράμματος Solidworks. 

Με τον δείκτη του ποντικιού μας επιλέγουμε τον άξονα z στο μοντέλο των τριών αξόνων που βρίσκεται 
κάτω αριστερά στην οθόνη μας, έτσι ώστε να κοιτάμε πλέον το επίπεδο ΧΥ. 

Έπειτα στο Design Tree που βρίσκεται στο αριστερό μέλος του UI (User Interface) κάνουμε δεξί κλικ  
στο Front Plane και επιλέγουμε Sketch. 
Design Tree→Front Plane→Right Click→Sketch 
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Κεντράρουμε το οπτικό μας πεδία στην αρχή των αξόνων.  
Tab Sketch→Circle 

Κατόπιν, στην αρχή των αξόνων σχεδιάζουμε μια δύο κύκλους διαμέτρου 160 mm και 266 mm 
ενεργοποιώντας και για τους δύο την επιλογή For Construction που βρίσκεται στην αριστερή μεριά της 
οθόνης. Έτσι έχουμε το Σχήμα Π.2: 

 

Σχήμα 5.2: Λεπτομέρεια σχεδίασης δρομέα. 

Στη συνέχεια χρησιμοποιώντας το εργαλεία line από: 

Tab Sketch→Line και Smart Dimension από: Tab Sketch→Smart Dimension 

Σχεδιάζουμε ένα ευθύγραμμο τμήμα 5 mm συμπίπτων εξ ολοκλήρου με την κεντρική αξονική γραμμή, 
και το ένα άκρο συμπίπτον με τον εσωτερικό αξονικό κύκλο. Ακόμα, σχεδιάζουμε ένα δεύτερο 
ευθύγραμμο τμήμα 5 mm με τα δύο του άκρα συμπίπτοντα με τον εξωτερικό αξονικό κύκλο. Η 
απόσταση των δύο τμημάτων ορίζεται στα 45 mm. Όπως φαίνεται στο Σχήμα Π.3. 

 

Σχήμα 5.3: Λεπτομέρεια σχεδίασης δρομέα. 



116 
 

Ακολούθως επιλέγουμε το εργαλείο Spline: 

Tab Sketch→Spline→Style Spline→B-Spline: Degree 3 

Κατόπιν ενώνουμε ανά δύο τα άκρα των ευθύγραμμων τμημάτων που σχεδιάσαμε. Η σχεδίαση αυτή δε 
χρειάζεται να γίνει με ακρίβεια και είναι τυχαία. Το τελικό σχέδιο πρέπει να μοιάζει με το Σχήμα Π.4. 

 

 

Σχήμα 5.4: Λεπτομέρεια σχεδίασης δρομέα. 

Στη συνέχεια επιλέγουμε: Tab Sketch→Circular Sketch Pattern  

Στο πεδίο «Number of Instances» συμπληρώνουμε 7 και στο πεδίο «Entities to Pattern» επιλέγουμε τις 
4 ακμές που σχηματίζουν το πτερύγιο, όπως φαίνεται στο Σχήμα Π.5. 

 

Σχήμα 5.5: Δημιουργία Circular Pattern. 
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Εν τέλει έχουμε το σχέδιο του δρομέα, όπως φαίνεται στο Σχήμα Π.6. 

 

Σχήμα 5.6:Τελικό σχέδιο δρομέα. 

Στο επόμενο βήμα χρησιμοποιώντας τα εργαλεία line, circle και Smart Dimension από το tab Sketch 
σχεδιάζουμε το κέλυφος του υδροστροβίλου γύρω από το δρομέα, όπως φαίνεται στο Σχήμα Π.7. 

 

Σχήμα 5.7:Σχεδίαση κελύφους υδροστροβίλου. 

Το σπειροειδές κέλυφος αποτελείται από 3 κυκλικά τόξα:  

• κυκλικό τόξα 45ο με κέντρο το (0,0) και ακτίνα 350 mm  
• κυκλικό τόξο 45ο με κέντρο το (-75,0) και ακτίνα 275 mm  
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• και ένα κυκλικό τόξο που κλείνει τη γεωμετρία και η σχεδίαση του στόχευε απλά στη σταδιακή 
μείωση της ακτίνας και ήταν τυχαία. 

Ακολουθεί η σχεδίαση του ψαριού-αντικειμένου η οποία επιλέχθηκε να είναι ένας απλός κύκλος ή ένα 
slot. Στην συνέχεια παρατίθενται οι 4 σχεδιασμοί που χρησιμοποιήθηκαν, στο Σχήμα Π.8. 

     
Σχήμα 5.8: Χρησιμοποιούμενες γεωμετρίες ψαριού-αντικειμένου 

 

Στη συνέχεια από τη γραμμή εργαλείων επιλέγουμε: 

Insert→Surface→Planar Surface και επιλέγουμε το Sketch που έχουμε δημιουργήσει. Το τελικό 
αποτέλεσμα φαίνεται παρακάτω: 

 

Σχήμα 5.9: Γεωμετρία για μέθοδο remeshing. 
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Κατόπιν, έχει σειρά η δημιουργία των offset γραμμών γύρω από στερεά σύνορα (τοιχώματα) του 
μοντέλου μας. Αυτό σημαίνει πως θα δημιουργηθεί offset γύρω από τα πτερύγια, το τοίχωμα του 
υδροστροβίλου και το τοίχωμα του ψαριού αντικειμένου. 

Επιλέγουμε: 

Tab features→Wrap→Επιλέγουμε το planar surface που δημιουργήσαμε πριν→Δημιουργείται ένα νέο 
Sketch→Επιλέγουμε το εργαλείο offset→Κρατώντας το πλήκτρο ctrl πατημένο επιλέγουμε το 
περίγραμμα του ψαριού-αντικειμένου και του δρομέα→Επιλέγουμε διάσταση offset 2 mm→Εκτελούμε 
την ίδια διαδικασία για το περίγραμμα του υδροστροβίλου με reverse offset 2 mm→ Exit Sketch 

Βρισκόμαστε τώρα σε ένα περιβάλλον όπως αυτό: 

 

Σχήμα 5.10: Παράθυρο εργασία για το εργαλείο Wrap. 

Στο scribe επιλέγουμε το Planar Surface που δημιουργήσαμε προηγουμένως. Στο source sketch, 
υπάρχει ήδη το sketch που επεξεργαζόμασταν μόλις. Επιλέγοντας ok έχουμε ολοκληρώσει το 
σχεδιασμό της γεωμετρίας ο οποίο φαίνεται παρακάτω: 
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Σχήμα 5.11: Τελική γεωμετρία για μέθοδο remeshing. 

 

 

Για να γίνει η κατασκευή του πλέγματος σωστά απαιτείται η αποθήκευση ως .step αρχείο (STEP AP03). 
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5.1.2 Κατασκευή πλέγματος 
 
Πρώτα δημιουργούμε ένα νέο αρχείο Ansys Workbench. Από το Toolbox, στο αριστερό μας χέρι, 
επιλέγουμε από την κατηγορία component systems το εργαλείο Mesh. Με drag and drop εισάγουμε 
ένα εργαλείο Mesh, στην περιοχή του Project Schematic. 

 

Σχήμα 5.12: Εργάλειο Mesh στην επιφάνειας εργασίας του Workbench. 

Στη συνέχεια: 

Geometry→Import Geometry→Browse→Εισαγωγή του επιθυμητού αρχείου 

Mesh→Edit… 

Κατόπιν ανοίγει το περιβάλλον του Ansys Meshing, το οποίο είναι το παρακάτω: 

 

Σχήμα 5.13: Απεικόνιση γεωμετρίας στο περιβάλλον του ANSYS Meshing. 
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Παρατηρούμε πως κάτω από το branch Geometry στο Project Tree υπάρχει ένα sub-branch που 
συμβολίζει μια επιφάνεια. Κάνουμε δεξί κλικ και επιλέγουμε Insert Named Selection. Συνολικά 
εισαγάγουμε δέκα Named Selections τα οποίο ονοματίζουμε όπως φαίνεται παρακάτω: 

 

 

Σχήμα 5.14: Χρησιμοποιούμενα Named Selections. 

Για κάθε Named Selection που δημιουργήσαμε, πρέπει τώρα να επιλεχθούν οι αντίστοιχες ακμές ή 
επιφάνειες που προσδιορίζει. Όπως φαίνεται, τέσσερα Named Selections προσδιορίζουν επιφάνειες, 
και τα υπόλοιπα έξι ακμές. Στον παρακάτω πίνακα παρουσιάζονται οι αντιστοιχίες αυτές. 

Velocity Inlet Pressure Outlet Wall Volute Wall fish 

 
   

Wall Rotating Prism Layer Volute Prism Layer Fish Prism Layer Runner 

    
Interior Fish Fluid Zone 

 
 

Σχήμα 5.15: Αντιστοιχίες names selections με γεωμετρία. 
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Πηγαίνουμε το branch Mesh, του Project Tree. 
Mesh→Insert→Method 
 Mesh→Insert→Sizing 
 Mesh→Insert→Inflation Συνολικά εισαγάγουμε τρία Inflation. 

Πηγαίνουμε στις λεπτομέρειες του sub-branch method. Στο κελί Geometry, επιλέγουμε όλη τη 
γεωμετρία μας, ενώ στο κελί Method, επιλέγουμε Triangles. 

  
Σχήμα 5.16: Εισαγωγή μεθόδου δημιουργίας του πλέγματος. 

 
Στα inflations επιλέγουμε τις ρυθμίσεις που φαίνονται στον παρακάτω πίνακα: 

Inflation 1 Inflation 2 Inflation 3 

   
Σχήμα 5.17: Εισαγωγή ρυθμίσεων για τη δημιουργία inflations. 

 
Τέλος για το Sizing επιλέγουμε τις εξής ρυθμίσεις: 

 

Σχήμα 5.18: Εισαγωγή ρυθμίσεων για τη δημιουργία του Sizing. 
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Στη συνέχεια, επανερχόμαστε στο branch Mesh του Project Tree: 

Mesh→Update/Generate Mesh 

To παραγόμενο πλέγμα φαίνεται παρακάτω: 

 

Σχήμα 5.19: Το παραγόμενο πλέγμα για τη μέθοδο remeshing. 
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5.1.3 1.3 Προσομοίωση στο ANSYS Fluent 
 
Αρχικά εκκινούμε το πρόγραμμα ANSYS Fluent Launcher επιλέγοντας: 

• Κατάλληλη διάσταση για το είδος της χρησιμοποιούμενης γεωμετρίας (2D) 
• Διπλή ακρίβεια υπολογισμών (Double Precision) 
• Στις επιλογές επεξεργασίας επιλέγουμε παράλληλη επεξεργασία (Parallel) 
• Επιλέγουμε το κατάλογο εργασίας (Working Directory) που βρίσκονται τα αρχεία που πρόκειται 

να χρησιμοποιήσουμε. 

 

Σχήμα 5.20: Παράθυρο εκκίνησης του ANSYS Fluent. 

Στην επιλογή παράλληλης επεξεργασίας, μπορούμε να επιλέγουμε όσους πυρήνες θέλουμε, εφ’ όσον 
το σύστημα μας τους διαθέτει. Το νούμερο αυτό ωστόσο, συστήνεται να είναι ζυγό και κατά προτίμηση 
ακέραια δύναμη του 2 (π.χ. 2, 4, 8, 16), έτσι ώστε να υπάρχει πραγματική αξιοποίηση των επιπλέον 
πυρήνων. Ο λόγος είναι, ο τρόπος με τον οποίο παραλληλοποιεί την επίλυση του προβλήματος το 
ANSYS Fluent. 
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Κατόπιν, επιλέγουμε ΟΚ και αντικρίζουμε το ακόλουθο παράθυρο στο ANSYS Fluent. 

 

Σχήμα 5.21: Περιβάλλον εργασίας στο ANSYS Fluent. 
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Επιλέγουμε: File→Read→Mesh… και διαβάζουμε το πλέγμα. 

Στο Tab Mesh, επιλέγουμε Display… και προβάλουμε όλα τα αντικείμενα που έχουν διαβαστεί. 

 

Σχήμα 5.22: Προβολή του πλέγματος στο περιβάλλον του ANSYS Fluent.  

Στη συνέχεια: 

 → Materials→ Fluid→New…→Fluent Database→water-liquid (h2o l)→Copy→Close 

Πλέον κάτω από branch “Fluid”, υπάρχει το sub-branch “water-liquid”. 

 → Cell Zone Conditions→  Σε όλα τα Cell Zones→Edit… και επιλέγουμε ως Material Name σε όλα το 
“water-liquid” 

 → Boundary Conditions→  Group by…→Zony Type 

Πλέον αντικρίζουμε το ακόλουθο σχήμα. 
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Σχήμα 5.23: Δέντρο συνοριακών συνθηκών, όπως διαβάζεται μετά την εισαγωγή του πλέγματος. 

Κατόπιν, ορίζουμε όλα τα shadow components στην καρτέλα Wall, ως Interior. 
 → Boundary Conditions→Wall→  “…….-shadow” → Type→Interior 

Πλέον, αντικρίζουμε το ακόλουθο σχήμα. 

 

Σχήμα 5.24: Δέντρο συνοριακών συνθηκών μετά από διορθωτικές παρεμβάσεις του χρήστη. 

 velocity_inlet→Στο κελί Velocity Magnitude (m/sec) συμπληρώνουμε 3→ ΟΚ 

Στη συνέχεια: 

Setting Up Physics→Solver→Time: Steady, Type: Pressure-Based, Models→Viscous…→k-omega, SST→OK 

Solving→Solution→ Methods→Ορίζουμε τις επιλογές όπως στο παρακάτω σχήμα. 
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Σχήμα 5.25: Επιλεγμένες ρυθμίσεις για το σχήμα επίλυσης. 

Solving→Controls→Controls…→Ορίζουμε τις επιλογές όπως στο παρακάτω σχήμα. 

 

Σχήμα 5.26: Επιλεγμένες ρυθμίσεις επίλυσης. 

Μετά: Solving→Initialization→Method: Hybrid→Initialize 

Θα πρέπει στο console να έχει εμφανιστεί μήνυμα επιτυχής αρχικοποίησης, όπως φαίνεται στο σχήμα: 
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Σχήμα 5.27: Παράδειγμα επιτυχημένης υβριδικής αρχικοποίησης. 

 
Solving→Reports→Residuals→ Θέτουμε όλα τα κριτήρια στο 10−6 →ΟΚ 

Solving→Run Calculation→Advanced… →Number of Iterations: 2000 →Calculate 

Οι υπολογισμοί ολοκληρώνονται γύρω στις 1700 επαναλήψεις, όπου όλα τα υπόλοιπα συγκλίνουν για 
την τιμή που ορίσαμε. Μετά την ολοκλήρωση των υπολογισμών, προχωράμε στο κομμάτι 
προσομοίωσης της κίνησης του αντικειμένου.  

Στη συνέχεια: 

Setting Up Physics→Solver→Time: Transient 

 → Parameters & Customization→  User Defined Functions →Compiled…→Source Files: Add… → 
Προσθέτουμε το αρχείο UDF όπως φαίνεται στο σχήμα. 

 

Σχήμα 5.28: Διαδικασία εισαγωγής UDF στον ANSYS Fluent. 

Κατόπιν, επιλέγουμε Build→Load και κλείνουμε το παράθυρο. Το περιεχόμενο της χρησιμοποιούμενης 
συνάρτησης UDF παρατίθεται στο Παράρτημα Β της παρούσας εργασίας. 

Στη συνέχεια: 

Setting Up Domain→Mesh Models →Dynamic Mesh… →Ενεργοποιούμε Dynamic Mesh, Smoothing, 
Remeshing και Six DOF 
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Για Smoothing, Remeshing ορίζουμε τις παραμέτρους, όπως φαίνεται στο σχήμα. 

  
Σχήμα 5.29: Επιλεγμένες ρυθμίσεις για Smoothing και Remeshing. 

Dynamic Mesh Zones → Create/Edit → Δημιουργούμε συνολικά πέντε ζώνες όπως φαίνεται στα 
παρακάτω σχήματα. 
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Αρχικά ορίζουμε δύο ζώνες ως Stationary, όπως φαίνεται στο σχήμα. 

 

 
 

Σχήμα 5.30: Δημιουργία των δύο stationary zone στην καρτέλα Dynamic Mesh Zones. 

Απαραίτητη, είναι και η πίεση του πλήκτρου Create, στο κάτω μέρος του παραθύρου .  
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Συνεχίζοντας, ορίζουμε το τοίχωμα του ψαριού αντικειμένου ως Rigid Body, όπως φαίνεται στο σχήμα. 

 

Σχήμα 5.31: Δημιουργία Rigid Body Zone στην καρτέλa Dynamic Mesh Zones. 

Προσέχουμε να ορίσουμε σωστά της συντεταγμένες του κέντρου του αντικειμένου στα πεδία του 
Center of Gravity Location. Επίσης, προσέχουμε να ορίσουμε ως ταχύτητα εκκίνησης την 
προσημασμένη ταχύτητα του πεδίου ροής, εδώ −3 𝑚𝑚/𝑠𝑠𝑠𝑠𝑠𝑠. Ακόμα, στο πεδίο Six DOF UDF, επιλέγουμε 
το αρχείο που κάναμε compile προηγουμένως. Στην επιλογή Six DOF, επιλέγουμε On. 

Κατόπιν, ορίζουμε κάθε άλλη ακμή ή επιφάνεια του αντικειμένου μας (εδώ interior_prism_layer_fish) 
ως Rigid Body. Χρησιμοποιούμε τις ίδιες ρυθμίσεις, εκτός από το πεδίο Six DOF στο οποίο μαρκάρουμε 
και τις δύο επιλογές, On και Passive. 
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Στη συνέχεια, ορίζουμε τη ζώνη fluid_zone, ως “Deforming”, όπως φαίνεται στο σχήμα. 

 

Σχήμα 5.32: Δημιουργία Deforming στην καρτέλα Dynamic Mesh Zones. 

Τις παραμέτρους τις ορίζουμε με τη βοήθεια του Zone Scale Info, αντιγράφοντας τις τιμές που 
βλέπουμε πατώντας το. Έπειτα κλείνουμε το παράθυρο Dynamic Mesh Zones. 

Είμαστε έτοιμοι να ξεκινήσουμε την προσομοίωση για τον υπολογισμό της τροχιάς του αντικειμένου. 

Solving→Run Calculation→Advanced… →Time Step Size: 0.0001 sec, Number of Time Steps: 5000, Max 
Iterations/Time Step: 20 → Calculate 

Μπορούμε ταυτόχρονα να παρακολουθούμε την πορεία του αντικειμένου, δημιουργώντας ένα 
Solution Animation από το branch Calculation Activities του δεντρικού μενού επιλογών. Η δημιουργία 
ενός αρχείου στο οποίο είναι ορισμένη η εγγραφή πληροφοριών χρόνου, θέσης, ταχύτητας, εσωτερικής 
γωνιακής ταχύτητας και προσανατολισμού του αντικειμένου έχει οριστεί στον κώδικα της συνάρτησης 
UDF που έγινε compile νωρίτερα. Το αρχείο αυτό θα γραφτεί στον φάκελο που ορίστηκε κατά την 
εκκίνηση του προγράμματος μέσω του ANSYS Fluent Launcher. 
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5.2 2. Τεχνική overset 
5.2.1 Κατασκευή γεωμετρίας 
 
Το πρόβλημα μας περιλάμβανε τρία δισδιάστατα αρχεία γεωμετρίας: 

• Το κέλυφος του υδροστροβίλου (volute ή casing) 
• Το δρομέα (runner) 
• Το ψάρι-αντικείμενο 

Τα αρχεία γεωμετρίας για την τεχνική overset κατασκευάστηκαν με επεξεργασία των αρχείων 
γεωμετρίας για την τεχνική remeshing. Ανοίγουμε το αρχείο γεωμετρίας της προηγούμενης μεθόδου. 

Αρχικά διαγράφουμε το χαρακτηριστικό Wrap. 
Wrap 1→Delete 

Στη συνέχεια, διαγράφουμε και το αρχείο sketch που χρησιμοποιήθηκε για την κατασκευή του Wrap1. 

Ακολούθως, επιλέγουμε edit sketch, στο μοναδικό sketch που υπάρχει πλέον στο Design Tree. 
Επιλέγοντας με το ποντίκι, διαγράφουμε όλες τις γεωμετρίες πλην αυτής του κελύφους. Βγαίνουμε από 
το sketch και πλέον έχουμε την εξής γεωμετρία: 

 

Σχήμα 5.33: Χρησιμοποιούμενη γεωμετρία κελύφους για την τεχνική overset. 

Αποθηκεύουμε το αρχείο του κελύφους σε μορφή .step (STEP AP03), και με ένα κατάλληλο όνομα, πχ 
«volute». 

Ανοίγουμε ξανά το αρχείο γεωμετρίας της προηγούμενης μεθόδου, διαγράφοντας το χαρακτηριστικό 
Wrap1 και το sketch από το οποίο κατασκευάστηκε. Στη συνέχεια, επιλέγοντας με το ποντίκι μας, 
διαγράφουμε όλες τις γεωμετρίες πλην αυτής του δρομέα. Σχεδιάζουμε έναν εξωτερικό κύκλο 160 mm 
και βγαίνουμε από το sketch. Πλέον έχουμε την εξής γεωμετρία: 
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Σχήμα 5.34: Χρησιμοποιούμενη γεωμετρία δρομέα για την τεχνική overset. 

Αποθηκεύουμε το αρχείο του δρομέα σε μορφή .step (STEP AP03), και με ένα κατάλληλο όνομα, πχ 
«runner» 

Για την κατασκευή των γεωμετριών του ψαριού-αντικειμένου, από την πάνω γραμμή εργαλείων 
επιλέγουμε File→New→Part 
 
Πλέον αντικρίζουμε ένα περιβάλλον σαν το παρακάτω: 
 

 

Σχήμα 5.35: Το περιβάλλον εργασίας του σχεδιαστικού προγράμματος Solidworks. 

Με τον δείκτη του ποντικιού μας επιλέγουμε τον άξονα z στο μοντέλο των τριών αξόνων που βρίσκεται 
κάτω αριστερά στην οθόνη μας, έτσι ώστε να κοιτάμε πλέον το επίπεδο ΧΥ. 
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Έπειτα στο Design Tree που βρίσκεται στο αριστερό μέλος του UI (User Interface) κάνουμε δεξί κλικ  
στο Front Plane και επιλέγουμε Sketch. 
Design Tree→Front Plane→Right Click→Sketch 

 

 

Σχήμα 5.36: Δημιουργία νέου sketch σε κάποιο plane. 

 
Το ψάρι αντικείμενο θα επιλέχθηκε να έχει τη μορφή θυρίδας (slot). Από την πάνω γραμμή εργαλείων, 
επιλέγουμε το tab Sketch και την εντολή Straight Slot. 
Command Manager→Tab Sketch→ Straight Slot 

 

Σχήμα 5.37: Επιλογή του εργαλείου straight slot. 

Στη συνέχεια σχεδιάζουμε ένα slot με την αξονική του γραμμή (centerline) κάθετη στον άξονα x όπως 
φαίνεται στην παρακάτω εικόνα: 

 

Σχήμα 5.38: Σχέδιο slot. 
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Επιστρέφουμε στη γραμμή εργαλείων, επιλέγουμε το tab Sketch και την εντολή Center Rectangle. 
Command Manager→Tab Sketch→ Center Rectangle 

 

Σχήμα 5.39: Επιλογή του εργαλείου Center Rectangle. 

 
Κατόπιν σχεδιάζουμε, όπως φαίνεται στο παρακάτω σχήμα. 
 

 

Σχήμα 5.40: Τελικό σχέδιο ψαριού-αντικειμένου. 

Το εσωτερικό slot πρόκειται για την πραγματική μορφή του ψαριού αντικειμένου, ενώ το εξωτερικό 
παραλληλόγραμμα θα χρησιμοποιηθεί ως overset επιφάνεια όπως θα αναλυθεί αργότερα. Οι 
διαστάσεις αυτές είναι ενδεικτικές, για την παραμετρική μελέτη θα χρησιμοποιηθούν και άλλες μορφές 
ψαριών-αντικειμένων. 

Το σχέδιο μας δεν έχει μαύρο χρώμα γιατί ακόμα δεν ορισθεί πλήρως διαστατικά, για να γίνει αυτό θα 
πρέπει να ορισθεί η σχετική θέση του αντικειμένου με την αρχή των αξόνων. Πρακτικά η θέση αυτή 
πρόκειται για το σημείο εκκίνησης του ψαριού-αντικειμένου το οποίο είναι επίσης αντικείμενο της 
παραμετρικής μελέτης και επομένων θα χρησιμοποιηθούν διάφορα σημεία εκκίνησης. Για παράδειγμα 
ορίζοντας την απόσταση από το άξονα Υ στα 200 𝑚𝑚𝑚𝑚 και από τον άξονα X στα 250 𝑚𝑚𝑚𝑚 το αντικείμενο 
θα βρίσκεται στο κέντρο του αγωγού εισόδου του υδροστροβίλου. Έτσι: 
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Σχήμα 5.41: Τελική θέση ψαριού-αντικειμένου στο χώρο. 

 

Το σχέδιο είναι έτοιμο και τώρα πρέπει να μετατραπεί σε δισδιάστατη γεωμετρία. 
Από την πάνω γραμμή εργαλείων επιλέγουμε Insert→Surface→Planar, το σχέδιο έχει επιλεχτεί 
αυτόματα και πατάμε το ΟΚ που εμφανίζεται στο αριστερό μέρος της οθόνης. Πλέον στο UI 
αντικρίζουμε το παρακάτω: 

 

Σχήμα 5.42: Τελική γεωμετρία ψαριού-αντικειμένου. 

Από την πάνω γραμμή εργαλείων επιλέγουμε File→Save as→STEP AP203 και αποθηκεύουμε το αρχείο 
αφού το ονοματίσουμε κατάλληλα. 
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5.2.2 Κατασκευή πλέγματος 
 
Στο βήμα αυτό θα προχωρήσουμε στην κατασκευή του πλέγματος για κάθε ένα από τα στοιχεία 
γεωμετρίας. Στη συγκεκριμένη εργασία το πλέγμα που κατασκευάστηκε είναι ένα μη δομημένο 
πλέγμα. Το μη δομημένο πλέγμα αποτελείται από μια συλλογή στοιχείων, τα οποία δεν διατάσσονται 
με συγκεκριμένη δομή στο χώρο. 

Αρχικά εκκινούμε το πρόγραμμα Ansys Workbench, αντικρίζουμε ένα περιβάλλον όπως το παρακάτω: 

 

Σχήμα 5.43: Το περιβάλλον εργασίας του λογισμικού ANSYS Workbench 

 Από την ενότητα Toolbox που βρίσκεται στην αριστερή μεριά της οθόνης μας μεταβαίνουμε στην 
υποενότητα Component Systems και επιλέγουμε το εργαλείο Mesh.  
Toolbox→ Component Systems→ Mesh  
Με το αριστερό κλικ πατημένο σύρουμε το εργαλείο στην περιοχή του Project Schematic: 

 

Σχήμα 5.44: Εισαγωγή εργαλείου Mesh στην επιφάνεια εργασίας του ANSYS Workbench. 
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Το όνομα Mesh έχει δοθεί αυτόματα στο στοιχείο, μπορούμε όμως με διπλό κλικ να το μετονομάσουμε 
όπως θέλουμε, για παράδειγμα “Volute”. 
Συνεχίζοντας, Geometry→Import Geometry→Browse… και επιλέγουμε το αρχείο γεωμετρίας για το 
κέλυφος. 

Για την επεξεργασία των αρχείων γεωμετρίας ως προεπιλογή χρησιμοποιείται το λογισμικό SpaceClaim. 
Εδώ θα χρησιμοποιηθεί το λογισμικό Design Modeler επομένως για την πρώτη φορά που θα ανοίξουμε 
το αρχείο: 

Geometry→Edit Geometry in Design Modeler 
Εμφανίζεται το ακόλουθο παράθυρο: 

 

Σχήμα 5.45: Το περιβάλλον εργασίας του λογισμικού ANSYS Design Modeler. 

Μεταβαίνουμε στην 3η γραμμή εργαλείων και κάνουμε κλικ στο εργαλείο Generate. 

 

Σχήμα 5.46: Επιλογή εντολής Generate απο την τρίτη γραμμή εργαλειών του ANSYS Design Modeler.. 
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Η γεωμετρία του κελύφους φορτώνει και πλέον αντικρίζουμε το ακόλουθο παράθυρο: 

 

Σχήμα 5.47: Απεικόνιση γεωμετρίας κελύφους  στο περιβάλλον Design Modeler. 

Από την πρώτη γραμμή εργαλείων επιλέγουμε Save και κλείνουμε το Design Modeler. 
Συνεχίζοντας Mesh→Edit… εμφανίζεται το παρακάτω περιβάλλον: 

 

Σχήμα 5.48: Απεικόνιση γεωμετρίας κελύφους στο περιβάλλον εργασίας του λογισμικού ANSYS Meshing. 
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Αρχικά θα δημιουργήσουμε ορισμένα Named Selections, θα δώσουμε δηλαδή κατάλληλα ονόματα σε 
συγκεκριμένα κομμάτια της γεωμετρίας έτσι ώστε το Ansys Fluent να δώσει αργότερα αυτόματα τους 
κατάλληλους τύπους οριακών συνθηκών. 
Μεταβαίνουμε στο project tree στην αριστερή μεριά της οθόνης: 

 

Σχήμα 5.49: Δεντρικό διάγραμμα στο περιβάλλον του λογισμικού ANSYS Meshing. 

Geometry→ Volute→ Create Named Selection 

Δίνουμε, για παράδειγμα, το όνομα “velocity_inlet” και πατάμε ΟΚ. Στο project tree έχουμε αυτή την 
εικόνα: 

 

Σχήμα 5.50: Δεντρικό διάγραμμα μετά τη δημιουργία ενός Named Selection. 

Κάνουμε αριστερό κλικ στο “velocity_inlet” και ακριβώς κάτω από το project tree εμφανίζεται το 
παράθυρο “Details of velocity_inlet”: 
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Σχήμα 5.51: Λεπτομέρειες του Named Selection velocity_inlet. 

Στην ενότητα Scope, στην υποενότητα Geometry κάνουμε αριστερό κλικ στο δεξί κελί. Ύστερα 
μεταβαίνουμε στη 2η γραμμή εργαλείων και επιλέγουμε το εργαλείο Edge. 

 

Σχήμα 5.52: Επιλογή εργαλείου edge από την δεύτερη γραμμή εργαλειών. 

Επιλέγουμε την ακμή όπως φαίνεται στην εικόνα και πατάμε Apply στο κελί Geometry του “Detail of 
velocity_inlet”  

 

Σχήμα 5.53: Σύνδεση named selection με την αντίστοιχη ακμή της γεωμετρίας. 

Ακολουθώντας την ίδια διαδικασία δημιουργούμε άλλο ένα Named Selection με το όνομα 
“wall_volute” επιλέγοντας όλες τις υπόλοιπες ακμές της γεωμετρίας. 
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Τέλος χρησιμοποιώντας το εργαλείο Face: 
 

 

Σχήμα 5.54: Επιλογή εργαλείου face από τη δεύτερη γραμμή εργαλειών. 

δημιουργούμε ακόμα ένα Named Selection με το όνομα “stationary_fluid_zone”, επιλέγοντας την 
εσωτερική επιφάνειας της γεωμετρίας. Πλέον το project tree έχει αυτή τη μορφή: 

 

Σχήμα 5.55: Μορφή δεντρικού μενού. 

Συνεχίζοντας,  → Mesh→Insert→Sizing 
Στο παράθυρο “Details of Sizing” επιλέγουμε με το εργαλείο Body ολόκληρη την γεωμετρίαa. Στη 
συνέχεια, στην ενότητα Definition, στο κελί Element Size εισάγουμε ένα κατάλληλο μέγεθος στοιχείου. 
Εδώ χρησιμοποιήθηκε μέγεθος στοιχείου 3.5 ∙ 10−3𝑚𝑚𝑚𝑚. 

 

Σχήμα 5.56: Επιλεγμένες ρυθμίσεις για το Body Sizing. 
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Ακολουθώντας την ίδια διαδικασία εισάγουμε ακόμα ένα Sizing για την ακμή (edge) εισόδου της 
γεωμετρίας (velocity inlet) με ίδιο μέγεθος στοιχείου. 

 

Σχήμα 5.57: Επιλεγμένες ρυθμίσεις για το edge sizing. 

Συνεχίζοντας,  → Mesh→Insert→Inflation  
Εμφανίζεται το παράθυρο “Details of Inflation”, χρησιμοποιώντας το εργαλείο Body από τη 2η γραμμή 
εργαλείων. 

 

Σχήμα 5.58: Επιλογή εργαλείου Body από τη δεύτερη γραμμή εργαλειών. 

Επιλέγουμε όλη τη γεωμετρία στο κελί Geometry του παραθύρου “Details of Inflation”. Έπειτα, 
μεταβαίνουμε στο κελί Scoping Method όπου επιλέγουμε Named Selection. Εκεί επιλέγουμε το Named 
Selection “stationary_fluid_zone” που δημιουργήσαμε προηγουμένως. Στο Boundary Scoping Method 
του ίδιου παραθύρου επιλέγουμε ξανά Named Selection. Ως, Boundary, στο από κάτω κελί ορίζουμε το 
Named Selection “wall_volute”. 

 

Σχήμα 5.59: Επιλεγμένες ρυθμίσεις για τη δημιουργία inflation. 
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Οι λεπτομέρειες του πλέγματος έχουν πλέον οριστεί. Στην 5η γραμμή εργαλείων επιλέγουμε την εντολή 
Update και περιμένουμε την ολοκλήρωση της κατασκευής του πλέγματος. 

 

Σχήμα 5.60: Εντολή update στη γραμμή εργαλειών. 

Ο χρόνος κατασκευής του πλέγματος εξαρτάται από τις επεξεργαστικές δυνατότητες του υπολογιστικού 
μας συστήματος και κυρίως το μέγεθος του στοιχείου (element size) που επιλέχθηκε. Μικρότερο 
μέγεθος στοιχείου συνεπάγεται πυκνότερο πλέγμα και μεγαλύτερος χρόνος κατασκευής του 
πλέγματος. Το προκύπτον πλέγμα αποτελείται από περίπου 36000 στοιχεία και παρουσιάζεται 
παρακάτω. 

 

 

Σχήμα 5.61: Το τελικό πλέγμα κελύφους που χρησιμοποιήθηκε στην τεχνική overset. 

Αποθηκεύομαι το αρχείο mesh, ονοματίζοντας το κατάλληλα. 
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Επανερχόμαστε την επιφάνεια εργασίας Project Schematic του Ansys Workbench 
 → Mesh→Drop στο Project Schematic και ονοματίζουμε το στοιχείο ως “Runner” 

 

Σχήμα 5.62: Εργαλείο Mesh στην επιφάνεια εργασίας του ANSYS Workbench. 

Με την ίδια διαδικασία που ακολουθήθηκε προηγουμένως ανοίγουμε τη γεωμετρία του δρομέα και 
μεταβαίνουμε στην εφαρμογή Meshing. 

 

Σχήμα 5.63: Απεικόνιση γεωμετρίας δρομέα στο περιβάλλον ANSYS Meshing. 

Σειρά έχει η δημιουργία των Named Selections όπως και με τη γεωμετρία του κελύφους. 
 → Geometry→ Runner→ Create Named Selection 

Ονομάζουμε το 1ο Named Selection “overset_runner” και γεωμετρικά το ορίζουμε ως τον εξωτερικό 
κύκλο της γεωμετρίας. 
Ονομάζουμε το 2ο Named Selection “pressure_outlet” και γεωμετρικά το ορίζουμε ως τον εσωτερικό 
κύκλο της γεωμετρίας. 
Ονομάζουμε το 3ο Named Selection “wall_rotating_runner” και γεωμετρικά το ορίζουμε ως τις 4 ακμές 
που σχηματίζουνε το καθένα από τα 7 πτερύγια του δρομέα, σύνολο 28 ακμές. 
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Ονομάζουμε το 4ο Named Selection “rotating_fluid_zone” και γεωμετρικά το ορίζουμε ως την 
εσωτερική επιφάνεια της γεωμετρίας. 

Overset Runner Pressure Outlet 

  
Wall Rotating Runner Rotating Fluid Zone 

  
Σχήμα 5.64: Σύνδεση named selections με τις αντίστοιχες ακμές ή επιφάνειες της γεωμετρίας. 

 

Κατόπιν, προχωράμε στη δημιουργία του πλέγματος. 
 → Mesh→ Insert → Sizing 

 
Στο παράθυρο “Details of Sizing”, στην ενότητα Scope, στο κελί Geometry επιλέγουμε με το εργαλείο 
Body ολόκληρη την γεωμετρία. Στην ενότητα Definition, και το κελί Element Size, ορίζουμε το μέγεθος 
του στοιχείου στα 3. 5 ∙ 10−3𝑚𝑚. 

 

Σχήμα 5.65: Επιλεγμένες ρυθμίσεις για το Body Sizing. 

 → Mesh→ Insert → Inflation 

Στο παράθυρο “Details of Inflation”, στην ενότητα Scope, στο κελί Scoping Method επιλέγουμε Named 
Selection, στον από κάτω κελί επιλέγουμε “rotating_fluid_zone”. Στην ενότητα Definition, στο κελί 
Boundary Scoping Method επιλέγουμε Named Selection, και στο αμέσως από κάτω κελί 
“wall_rotating_runner”. Στον Inflation Option ορίζουμε Smooth Transition, ενώ στο κελί Maximum 
Layers βάζουμε 7. 
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Σχήμα 5.66: Επιλεγμένες ρυθμίσεις inflation. 

 → Mesh→ Update/Generate Mesh 

Το τελικό πλέγμα αποτελείται από περίπου 7500 στοιχεία. 

 

Σχήμα 5.67: Το τελικό πλέγμα του δρομέα που χρησιμοποιήθηκε στην τεχνική overset. 

 

Συνεχίζουμε με File→Save Project αποθηκεύοντας το αρχείο, ονοματίζοντας το κατάλληλα, και έπειτα 
File→Close Meshing. 
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Επανερχόμαστε την επιφάνεια εργασίας Project Schematic του Ansys Workbench 
 → Mesh→Drag and Drop στο Project Schematic και ονοματίζουμε το στοιχείο ως “Fish” 

Geometry→ Insert → Εισάγουμε την κατάλληλη γεωμετρία. 
Συνεχίζοντας, Mesh→Edit… εμφανίζεται το παρακάτω περιβάλλον: 

 

Σχήμα 5.68: Απεικόνιση της γεωμετρίας του ψαριού-αντικειμένου στο περιβάλλον ANSYS Meshing. 

Με τον τρόπου που αναλύθηκε προηγουμένως, δημιουργούμε τρία Named Selections όπως φαίνεται 
στο παρακάτω σχήμα: 

 

Σχήμα 5.69: Δημιουργία named selections. 

Ακολούθως, συνδέουμε κάθε Named Selection με την αντίστοιχη ακμή η επιφάνεια όπως γεωμετρίας 
όπως όπως φαίνεται στο παρακάτω σχήμα: 

Wall Fish Overset Fish Fluid Fish 

   
Σχήμα 5.70: Σύνδεση named selections με τις αντίστοιχες ακμές ή επιφάνειες της γεωμετρίας. 
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Κατόπιν, προχωράμε στη δημιουργία του πλέγματος. 
 → Mesh→ Insert → Sizing 

 
Στο παράθυρο “Details of Sizing”, στην ενότητα Scope, στο κελί Geometry επιλέγουμε με το εργαλείο 
Body ολόκληρη την γεωμετρία. Στην ενότητα Definition, και το κελί Element Size, ορίζουμε το μέγεθος 
του στοιχείου στα 1.5 ∙ 10−3𝑚𝑚. 

 

 

Σχήμα 5.71: Επιλεγμένες ρυθμίσεις Body Sizing. 

 → Mesh→ Insert → Inflation 

Στο παράθυρο “Details of Inflation”, στην ενότητα Scope, στο κελί Scoping Method επιλέγουμε Named 
Selection, στον από κάτω κελί επιλέγουμε “fluid_fish”. Στην ενότητα Definition, στο κελί Boundary 
Scoping Method επιλέγουμε Named Selection, και στο αμέσως από κάτω κελί “wall_fish”. Στον Inflation 
Option ορίζουμε Smooth Transition, ενώ στο κελί Maximum Layers βάζουμε 7. 

 

Σχήμα 5.72: Επιλεγμένες ρυθμίσεις inflation. 
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 → Mesh→ Update/Generate Mesh 

Το τελικό πλέγμα αποτελείται από περίπου 650 στοιχεία. 

 

Σχήμα 5.73: Το τελικό πλέγμα ψαριού-αντικειμένου που χρησιμοποιήθηκε για την τεχνική overset. 

 

Συνεχίζουμε με File→Save Project αποθηκεύοντας το αρχείο, ονοματίζοντας το κατάλληλα, και έπειτα 
File→Close Meshing. 
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5.2.3 2.3 Προσομοίωση στο ANSYS Fluent 
 

Αρχικά εκκινούμε το πρόγραμμα ANSYS Fluent Launcher επιλέγοντας: 

• Κατάλληλη διάσταση για το είδος της χρησιμοποιούμενης γεωμετρίας (2D) 
• Διπλή ακρίβεια υπολογισμών (Double Precision) 
• Στις επιλογές επεξεργασίας επιλέγουμε παράλληλη επεξεργασία (Parallel) 
• Επιλέγουμε το κατάλογο εργασίας (Working Directory) που βρίσκονται τα αρχεία που πρόκειται 

να χρησιμοποιήσουμε. 

 

Σχήμα 5.74: Παράθυρο εκκίνησης του ANSYS Fluent. 

Στην επιλογή παράλληλης επεξεργασίας, μπορούμε να επιλέγουμε όσους πυρήνες θέλουμε, εφ’ όσον 
το σύστημα μας τους διαθέτει. Το νούμερο αυτό ωστόσο, συστήνεται να είναι ζυγό και κατά προτίμηση 
ακέραια δύναμη του 2 (π.χ. 2, 4, 8, 16), έτσι ώστε να υπάρχει πραγματική αξιοποίηση των επιπλέον 
πυρήνων. Ο λόγος είναι, ο τρόπος με τον οποίο παραλληλοποιεί την επίλυση του προβλήματος το 
ANSYS Fluent. 
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Κατόπιν, επιλέγουμε ΟΚ και αντικρίζουμε το ακόλουθο παράθυρο στο ANSYS Fluent. 

 

Σχήμα 5.75: Το περιβάλλον εργασίας στο ANSYS Fluent. 

Επιλέγουμε: File→Read→Mesh… και διαβάζουμε το πλέγμα του κελύφους (volute). 

Στη συνέχεια, πηγαίνουμε στο Tab “Zones”: Zones→Append→Append Case File… και διαβάζουμε το 
πλέγμα του δρομέα. Επαναλαμβάνουμε την ίδια διαδικασία, διαβάζοντας το πλέγμα του αντικειμένου. 
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Στο Tab Mesh, επιλέγουμε Display… και προβάλουμε όλα τα αντικείμενα που έχουν διαβαστεί. 

 

Σχήμα 5.76: Προβολή του πλέγματος στο περιβάλλον του ANSYS Fluent. 

 

Στη συνέχεια, πηγαίνουμε στο Interfaces. Interfaces →Overset… και ανοίγει το παράθυρο δημιουργίας 
ενός overset interface. Συμπληρώνουμε όπως στο παρακάτω σχήμα. 

 

Σχήμα 5.77: Παράθυρο δημιουργίας διεπαφής overset. 

Κατόπιν, επιλέγουμε Create και κλείνουμε το παράθυρο. Το overset έχει πλέον δημιουργηθεί, όμως όχι 
ακόμα με το σωστό τρόπο. Θα ασχοληθούμε ξανά με αυτό στη συνέχεια. 

 → Materials→ Fluid→New…→Fluent Database→water-liquid (h2o l)→Copy→Close 

Πλέον κάτω από branch “Fluid”, υπάρχει το sub-branch “water-liquid”. 
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 → Cell Zone Conditions→  Σε όλα τα Cell Zones→Edit… και επιλέγουμε ως Material Name σε όλα το 
“water-liquid” 

 → Boundary Conditions→  Group by…→Zony Type 

Πλέον αντικρίζουμε το ακόλουθο σχήμα. 

 

Σχήμα 5.78: Δέντρο συνοριακών συνθηκών. 

 velocity_inlet→Στο κελί Velocity Magnitude (m/sec) συμπληρώνουμε 3→ ΟΚ 

Στη συνέχεια, μεταβαίνουμε στη γραμμή εντολών του Console. Και πληκτρολογούμε τις ακόλουθες 
εντολές: 

• define/overset-interfaces/options/expert/yes 
• define/overset-interfaces/options/verbosity/2 
• define/overset-interfaces/options/donor-priority-method/1 
• define/overset-interfaces/options/minimize-overlap/yes 

Μετά: Solving→Initialization→Method: Hybrid→Initialize 

Θα πρέπει στο console να έχει εμφανιστεί μήνυμα επιτυχής αρχικοποίησης, όπως φαίνεται στο σχήμα: 

 

Σχήμα 5.79: Παράθυρο επιτυχημένης υβριδικής αρχικοποίησης. 
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Στη συνέχεια: 

Setting Up Physics→Solver→Time: Steady, Type: Pressure-Based, Models→Viscous…→k-omega, SST→OK 

Solving→Solution→ Methods→Ορίζουμε τις επιλογές όπως στο παρακάτω σχήμα. 

 

Σχήμα 5.80: Επιλεγμένες ρυθμίσεις για το σχήμα επίλύσης. 

Solving→Controls→Controls…→Ορίζουμε τις επιλογές όπως στο παρακάτω σχήμα. 

 

Σχήμα 5.81: Επιλεγμένες ρυθμίσεις επίλυσης. 

Solving→Reports→Residuals→ Θέτουμε όλα τα κριτήρια στο 10−6 →ΟΚ 

Solving→Run Calculation→Advanced… →Number of Iterations: 2000 →Calculate 

Οι υπολογισμοί ολοκληρώνονται γύρω στις 1200 επαναλήψεις, όπου όλα τα υπόλοιπα συγκλίνουν για 
την τιμή που ορίσαμε. 
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Στη συνέχεια: 

Setting Up Physics→Solver→Time: Transient 

Setting Up Domain→Units…→angular-velocity→RPM→Close 

 → Cell Zone Conditions→  rotating_fluid_zone →Enable Mesh Motion→Speed (rpm): -333→ OK 

 → Cell Zone Conditions→Boundary Conditions→Wall→  wall_rotating_runner→ Edit… → Wall 
Motion: Moving Wall: Rotational, Rotation-Axis Origin: x=0, y=0→OK 

Solving→Run Calculation→Advanced… →Time Step Size: 0.001001001 sec, Number of Time Steps: 1800, 
Max Iterations/Time Step: 20 → Calculate 

Μετά την ολοκλήρωση των υπολογισμών, προχωράμε στο κομμάτι προσομοίωσης της κίνησης του 
αντικειμένου.  

 → Parameters & Customization→  User Defined Functions →Compiled…→Source Files: Add… → 
Προσθέτουμε το αρχείο UDF όπως φαίνεται στο σχήμα. 

 

Σχήμα 5.82: Διαδικασία εισαγωγής UDF στο ANSYS Fluent. 

Κατόπιν, επιλέγουμε Build→Load και κλείνουμε το παράθυρο. Το περιεχόμενο της χρησιμοποιούμενης 
συνάρτησης UDF παρατίθεται στο Παράρτημα Β της παρούσας εργασίας. 

Στη συνέχεια: 

Setting Up Domain→Mesh Models →Dynamic Mesh… →Ενεργοποιούμε Dynamic Mesh και Six DOF 

Dynamic Mesh Zones → Create/Edit → Δημιουργούμε συνολικά πέντε ζώνες όπως φαίνεται στα 
παρακάτω σχήματα. 
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Αρχικά ορίζουμε δύο ζώνες ως Stationary, όπως φαίνεται στο σχήμα. 

 

 
Σχήμα 5.83: Δημιουργία δύο stationary zone στην καρτέλα Dynamic Mesh Zones. 

Απαραίτητη, είναι και η πίεση του πλήκτρου Create, στο κάτω μέρος του παραθύρου. 
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Συνεχίζοντας, ορίζουμε το τοίχωμα του ψαριού αντικειμένου ως Rigid Body, όπως φαίνεται στο σχήμα. 

 

Σχήμα 5.84: Δημιουργία Rigid Body στην καρτέλα Dynamic Mesh Zones. 

Προσέχουμε να ορίσουμε σωστά της συντεταγμένες του κέντρου του αντικειμένου στα πεδία του 
Center of Gravity Location. Επίσης, προσέχουμε να ορίσουμε ως ταχύτητα εκκίνησης την 
προσημασμένη ταχύτητα του πεδίου ροής, εδώ −3 𝑚𝑚/𝑠𝑠𝑠𝑠𝑠𝑠. Ακόμα, στο πεδίο Six DOF UDF, επιλέγουμε 
το αρχείο που κάναμε compile προηγουμένως. Στην επιλογή Six DOF, επιλέγουμε On.  

Κατόπιν, ορίζουμε κάθε άλλη ακμή ή επιφάνεια του αντικειμένου μας (εδώ overset_fish, και interior-
fluid_fish) ως Rigid Body. Χρησιμοποιούμε τις ίδιες ρυθμίσεις, εκτός από το πεδίο Six DOF στο οποίο 
μαρκάρουμε και τις δύο επιλογές, On και Passive. Έπειτα κλείνουμε το παράθυρο Dynamic Mesh Zones. 

Είμαστε έτοιμοι να ξεκινήσουμε την προσομοίωση για τον υπολογισμό της τροχιάς του αντικειμένου. 
Solving→Run Calculation→Advanced… →Time Step Size: 0.001 sec, Number of Time Steps: 500, Max 
Iterations/Time Step: 20 → Calculate 

Μπορούμε ταυτόχρονα να παρακολουθούμε την πορεία του αντικειμένου, δημιουργώντας ένα 
Solution Animation από το branch Calculation Activities του δεντρικού μενού επιλογών. Η δημιουργία 
ενός αρχείου στο οποίο είναι ορισμένη η εγγραφή πληροφοριών χρόνου, θέσης, ταχύτητας, εσωτερικής 
γωνιακής ταχύτητας και προσανατολισμού του αντικειμένου έχει οριστεί στον κώδικα της συνάρτησης 
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UDF που έγινε compile νωρίτερα. Το αρχείο αυτό θα γραφτεί στον φάκελο που ορίστηκε κατά την 
εκκίνηση του προγράμματος μέσω του ANSYS Fluent Launcher. 
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6 Παράρτημα Β 
 

Η συνάρτηση UDF που χρησιμοποιήθηκε στις προσομοιώσεις. H συγκεκριμένη UDF αποτελεί 
τροποποιημένη εκδοχή συνάρτησης UDF από τρίτη εργασία (Algadi, 2017). 

#include "udf.h" 

 

/************************************************************ 

User Inputs - Cylindrical Capsule1 

**************************************************************/ 

#define MASS 0.10 /*Mass*/ 

#define IXX 0.0000 /*moment of inertia*/ 

#define IYY 0.0000 

#define IZZ 0.000002166 

#define IXY 0.0 

#define IXZ 0.0 

#define IYZ 0.0 

#define ID_capsule1 8 

real f_glob1[ND_ND]; 

real m_glob1[ND_ND]; 

real cg1[ND_ND], theta_y; 

int flag1; 

/************************************************************ 

SDOF property UDF for a moving body 

**************************************************************/ 

DEFINE_SDOF_PROPERTIES(moving_fish, prop, dt, time, dtime) 

{ 

 int i; 

 real x_cg[ND_ND]; 

 Domain *domain; 
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 Thread *t1; 

# if !RP_NODE 

 FILE *fp = NULL; 

 char filename[] = "udf_motion_history_capsule1.txt"; 

 if ((fp = fopen(filename, "a+")) == NULL) 

  Message("\n Warning: Unable to open %s for writing\n", filename); 

 else 

 { 

  Message("\n Writing motion history to %s...", filename); 

 } 

# endif 

 domain = Get_Domain(1); 

 t1 = Lookup_Thread(domain, ID_capsule1); 

 

 prop[SDOF_MASS] = MASS; 

 prop[SDOF_IXX] = IXX; 

 prop[SDOF_IYY] = IYY; 

 prop[SDOF_IZZ] = IZZ; 

 prop[SDOF_IXY] = IXY; 

 prop[SDOF_IXZ] = IXZ; 

 prop[SDOF_IYZ] = IYZ; 

 prop[SDOF_ZERO_ROT_X] = TRUE; 

 prop[SDOF_ZERO_ROT_Y] = TRUE; 

    prop[SDOF_ZERO_TRANS_Z] = TRUE; 

    prop[SDOF_ZERO_ROT_Z] = FALSE; 

    prop[SDOF_ZERO_TRANS_X] = FALSE; 

    prop[SDOF_ZERO_TRANS_Y] = FALSE; 

 

 for (i = 0; i < ND_ND; i++) 
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 { 

  x_cg[i] = DT_CG(dt)[i]; 

 } 

 

# if !RP_NODE 

 if (flag1 != 1) 

 { 

  flag1 = 1; 

  fprintf(fp, "Time cg_x cg_y theta_z vel_x vel_y omega_z \n"); 

 } 

 fprintf(fp, "%g %g %g %g %g %g %g \n", time,x_cg[0],x_cg[1], DT_THETA(dt)[2] * 180 / 3.14, 
              DT_VEL_CG(dt)[0],DT_VEL_CG(dt)[1], DT_OMEGA_CG(dt)[2],); 

 fclose(fp); 

# endif 

} 
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